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LIMITED WARRANTY AND LIMITATION OF LIABILITY

Horner APG, LLC. ("HE-APG") warrants to the original purchaser that the XLE/XLT OCS module manufactured by HE-
APG is free from defects in material and workmanship under normal use and service. The obligation of HE-APG under
this warranty shall be limited to the repair or exchange of any part or parts which may prove defective under normal use
and service within two (2) years from the date of manufacture or eighteen (18) months from the date of installation by the
original purchaser whichever occurs first, such defect to be disclosed to the satisfaction of HE-APG after examination by
HE-APG of the allegedly defective part or parts. THIS WARRANTY IS EXPRESSLY IN LIEU OF ALL OTHER
WARRANTIES EXPRESSED OR IMPLIED INCLUDING THE WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR USE AND OF ALL OTHER OBLIGATIONS OR LIABILITIES AND HE-APG NEITHER ASSUMES, NOR
AUTHORIZES ANY OTHER PERSON TO ASSUME FOR HE-APG, ANY OTHER LIABILITY IN CONNECTION WITH
THE SALE OF THIS XLE/XLT OCS MODULE. THIS WARRANTY SHALL NOT APPLY TO THIS XLE/XLT OCS module
OR ANY PART THEREOF WHICH HAS BEEN SUBJECT TO ACCIDENT, NEGLIGENCE, ALTERATION, ABUSE, OR
MISUSE. HE-APG MAKES NO WARRANTY WHATSOEVER IN RESPECT TO ACCESSORIES OR PARTS NOT
SUPPLIED BY HE-APG. THE TERM "ORIGINAL PURCHASER", AS USED IN THIS WARRANTY, SHALL BE DEEMED
TO MEAN THAT PERSON FOR WHOM THE XLE/XLT OCS MODULE IS ORIGINALLY INSTALLED. THIS
WARRANTY SHALL APPLY ONLY WITHIN THE BOUNDARIES OF THE CONTINENTAL UNITED STATES.

In no event, whether as a result of breach of contract, warranty, tort (including negligence) or otherwise, shall HE-APG or
its suppliers be liable of any special, consequential, incidental or penal damages including, but not limited to, loss of profit
or revenues, loss of use of the products or any associated equipment, damage to associated equipment, cost of capital,
cost of substitute products, facilities, services or replacement power, down time costs, or claims of original purchaser's
customers for such damages.

To obtain warranty service, return the product to your distributor with a description of the problem, proof of purchase, post
paid, insured and in a suitable package.

ABOUT PROGRAMMING EXAMPLES

Any example programs and program segments in this manual or provided on accompanying diskettes are included solely
for illustrative purposes. Due to the many variables and requirements associated with any particular installation, Horner
APG cannot assume responsibility or liability for actual use based on the examples and diagrams. It is the sole respons-
ibility of the system designer utilizing the XLE/XLT OCS module to appropriately design the end system, to appropriately
integrate the XLE/XLT OCS module and to make safety provisions for the end equipment as is usual and customary in
industrial applications as defined in any codes or standards which apply.

NOTE: The programming examples shown in this manual are for illustrative purposes only. Proper machine operation is
the sole responsibility of the system integrator.
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Preface
This manual explains how to use the XLE/XLT OCS Modules.

Copyright (C) 2008 Horner APG, LLC., 59 South State Avenue, Indianapolis, Indiana 46201. All rights reserved. No part
of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any lan-
guage or computer language, in any form by any means, electronic, mechanical, magnetic, optical, chemical, manual or
otherwise, without the prior agreement and written permission of Horner APG, Inc.

All software described in this document or media is also copyrighted material subject to the terms and conditions of the
Horner Software License Agreement.

Information in this document is subject to change without notice and does not represent a commitment on the part of
Horner APG.

Cscape, SmartStack, SmartStix, SmartRail, and CsCAN are trademarks of Horner APG. Ethernet is a trademark of Xerox
Corporation®.

microSD® and CompactFlash are registered trademarks of SanDisk Corporation®.

Published with Madcap Flare®.

North America

Tel: (+) (317) 916-4274

Fax: (+) (317) 639-4279

Website: https://hornerautomation.com
Email: techsppt@heapg.com

Europe

Tel: (+) 353-21-4321-266

Fax: (+) 353-21-4321-826

Website: https://www.hornerautomation.eu
Email: technical.support@horner-apg.com
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Safety and Compliance

Warnings

When found on the product, the following symbols specify:

A Warning: Consult user documentation. A Warning: Electrical Shock Hazard.

WARNING: EXPLOSION HAZARD - Substitution of components may impair suitability for Class I, Division 2.
WARNING: EXPLOSION HAZARD - Do not disconnect equipment unless power has been switched off or the
area is known to be non-hazardous.

1. To avoid the risk of electric shock or burns, always connect the safety (or earth) ground before making any
other connections.

2. Toreduce the risk of fire, electrical shock, or physical injury it is strongly recommended to fuse the voltage
measurement inputs. Be sure to locate fuses as close to the source as possible.

3. Replace fuse with the same type and rating to provide protection against risk of fire and shock hazards.

4. Inthe event of repeated failure, do not replace the fuse again as a repeated failure indicates a defective con-
dition that will not clear by replacing the fuse.

5. Only qualified electrical personnel familiar with the construction and operation of this equipment and the haz-
ards involved should install, adjust, operate, or service this equipment. Read and understand this manual
and other applicable manuals in their entirety before proceeding. Failure to observe this precaution could res-
ult in severe bodily injury or loss of life.

NOTE: All applicable codes and standards need to be followed in the installation of this product.
NOTE: For I/0O wiring (discrete), use the following wire type or equivalent: Belden 9918, 18 AWG or larger.
NOTE: See the "Electrical Installation" on page 21 for more details.

FCC Compliance

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
1. This device may not cause harmful interference.
2. This device must accept any interference received, including interference that may cause undesired oper-
ation.

Page 8 of 178
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Safety Precautions

Adhere to the following safety precautions whenever any type of connection is made to the module:
Il applicable codes and standards need to be followed in the installation of this product. Adhere
to the following safety precautions whenever any type of connection is made to the module:

oakwn=

—
CooxN

11.
12.

Connect the safety (earth) ground on the power connector first before making any other connections.

When connecting to the electric circuits or pulse-initiating equipment, open their related breakers.

Do NOT make connection to live power lines.

Make connections to the module first; then connect to the circuit to be monitored.

Route power wires in a safe manner in accordance with good practice and local codes.

Wear proper personal protective equipment including safety glasses and insulated gloves when making con-
nections to power circuits.

Ensure hands, shoes, and floor are dry before making any connection to a power line.

Make sure the unit is turned OFF before making connection to terminals.

Make sure all circuits are de-energized before making connections.

Before each use, inspect all cables for breaks or cracks in the insulation. Replace immediately if defective.
Use copper conductors in Field Wiring only, 60/75°C.

Use caution when connecting controllers to PCs via serial or USB. PCs, especially laptops may use “floating
power supplies” that are ungrounded. This could cause a damaging voltage potential between the laptop and
controller. Ensure the controller and laptop are grounded for maximum protection. Consider using a USB isol-
ator due to voltage potential differences as a preventative measure.

Page 9 of 178
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Introduction to the XLE/XLT

VISUAl OV O VI OW 1
Where to find more information for the XLE/ XLT ... .. 12
Connectivity to the XLE/ XL . 12
Features of the XLE XL T . 13

Visual Overview

Function Keys
. Softkeys
. Navigation Keys
. Touchscreen
. Wide Range DC Power
. CAN Port
Mounting Clip Locations
. R5232/RS485 Serial
Paorts (2)
9, USB Mini-B Port
- 10.Ethernet LAN Port (optional)
® Running 11. Optional Built-In 1/O
el 12.High Capacity microSD Slot
13. Configuration Switches
14. DIN Rail Clip

(ol Ho W H Qo ALY LN ey
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Where to find more information for the XLE/XLT

Datasheets - The datasheets are the first documents to refer to for key information related to specific XLE/XLT mod-
els. (A basic datasheet is provided in the box with the unit.) Find the documents via the Documentation Search page
on the Horner website.

Datasheet Manual Numbers
Model O MAN1112
Model 2 MAN1113
Model 3 MAN1114
Model 4 MAN1115
Model 5 MAN1116
Model 6 MAN1117

Connectivity to the XLE/XLT

Connectivity to the XLE/XLT
CAN Serial 110 UsSB Ethernet Options
Other.OCS OtherIOCS Sensors USB Slave Other OCS Devices
Devices Devices
SmartStix I/O Drivers Indicators Programming / Monitoring Port Drives
SmartBlock PLCs Alarms PLCs
/10
SmartRail I/O0 Bar Code Encoders SCADA
Readers
Printers Pumps OPC Server
SCADA Relays Portal
OPC Servers| Solenoids I/0 Devices
Serial /0 SmartRail Devices

Page 120f 178
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Features of the XLE/XLT

The XLE/XLT is an all-in-one industrial control device. It combines control, user interface, I/0 and networking into a
single, integrated package. Unique features of the XLE/XLT include:

Bright, graphical LCD display (in XLE) (with touch sensing in XLT)

Display of complex graphical objects including trends, gauges, meters and animations

Advanced control capabilities including floating point, multiple auto-tuning PID loops and string handling cap-
abilities

Removable media for up to two terabytes of storage of programs, data logging or screen captures

CsCAN networking port (optional) for communication with remote I/O, other controllers or PCs.

Ethernet version (XLEe/XLTe) with native Ethernet for communication with other controllers, drives, PCs,
etc.

Configurable serial protocols for communication to drives, PLCs, or other serial peripherals.

USB 2.0 full speed port for programming and monitoring.

Full featured, built-in I/O including high resolution analog, thermocouple, RTD, high-speed counters, PWM
outputs, and relays (depending upon the XLE/XLT model used).

Cscape programming software that allows all aspects of the XLE/XLT, XLEe/XLTe to be programmed and
configured from one integrated application.

Optional communication add-on modules that allow additional capabilities such as Ethernet (pre-Rev TA
only) or modems.

Fail — Safe System which allows an application to continue running in the event of “Soft” failures such as (Bat-
tery power loss or Battery Backed register RAM / Application Flash corruption)

Clone Unit allows the user to “clone” the OCS of the exact same model. This feature “clones” application pro-
gram and unit settings stored in Battery backed RAM of an OCS. It can then be used to clone a different OCS
(exact same model).

Page 13 0f 178
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Mechanical Installation

Mounting Procedures .. . . 15
Mounting Orientation . . . 16
Panel CUtOUL . 17
Installation ... 18
Factors Affecting Panel Layout Design and Clearances ................ ... ... ... ... 18

NOTE: The datasheet is the first document to refer to for model-specific information related to XLE/XLT models
such as pin-outs, jumper settings, and other key installation information. See the Documentation Search for data-
sheets.

Mounting Procedures

The mechanical installation greatly affects the operation, safety, and appearance of the system. Information is
provided to mechanically install the unit such as cut-out sizes, mounting procedures, and other recommendations
for the proper mechanical installation of the unit. XLE/XLT products can be mounted through a panel or on DIN rail.

A

Once the panel design has been completed using the criteria and suggestions in the following sections, use the fol-
lowing steps to panel mount the XLE/XLT.
1. Remove all connectors from the XLE/XLT unit.
2. Press the DIN rail clip up to make passing the unit through the cutout easier.
3. Make sure the gasket is installe’d on the XLE/XLT and is free from dust and debris. Check that the corners of
the gasket are secure.
4. Pass the unit through the panel.
5. Insert the each of the four (4) mounting clips into the slots in the XLE/XLT case. One clip should be installed
on each corner. Lightly tighten each screw so the clip is held in place.
6. Tighten the screws on the clips such that the gasket is compressed against the panel. Recommended torque
is 7-10 in-lbs [0.8-1.13 Nm]).

Page 150f 178
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Mounting Procedures (Installed on DIN Rail)

Top
Clip

NOTE: Mount the XLE/XLT with
the DIN Rail in the horizontal
position to avoid slippage.

DIN
Rail Clip

The XLE/XLT is designed to clip onto standard 35mm DIN rail. If your installation requires liquid or dust protection,
make sure the XLE/XLT is placed in an appropriate sealed panel when mounting on DIN rail. Use the following
steps to mount the XLE/XLT on DIN rail.
1. Move the DIN rail clip to the lower position.
2. Clip the “Top Clips” on the top of the DIN rail.
3. Press the unitinto place and press the DIN rail clip up. A small flat-head screwdriver can be used in the slot
of the DIN rail clip if clearance is an issue.

NOTE: The DIN rail connection does not provide an earth ground. Refer to the "Electrical Installation" on page 21
for proper grounding information.

Mounting Orientation

NOTE: For panel or DIN rail mounting — The orientation shown above provides optimum legibility of the screen
and ease of use of the keypad.

CAUTION: For DIN rail mounting — To prevent the unit from slipping off the DIN rail, do NOT install the unit on its
side as shown. Be sure the DIN rail is in the horizontal position.

Page 16 of 178
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Panel Cutout

For installations requiring NEMA4X liquid and dust protection the panel cutout should be cut with a tolerance of +/- 1
mm. The XLE/XLT is designed to fit 1/4 DIN panel openings. There are a number of punches and enclosures
designed to accommodate opening of this size.

378"
{9amm)

Fﬁ__{aﬂ ® Eunning

D Cleann g

slalclala

378" 2.26"
{(9&mm) (57.5mm)

362"
{92mm)

Panel Cut-Out

3.62"

(92rmm)
+ /- 1mm cutout tolerance

NOTE: When the communication add-on modules are installed such communication and 1/O, the depth of the
product increases from 2.264” (57.5mm) to 2.68” (68mm).
NOTE: The keypad overlay appearance may differ.

Page 17 of 178
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Installation

The XLE/XLT utilizes a clip installation method to ensure a robust and watertight seal to the enclosure.
Please follow the steps below for the proper installation and operation of the unit.

This equipment is suitable for Class I, Division 2, Groups A, B, C and D or non-hazardous locations only.
Digital outputs shall be supplied from the same source as the

operator control station.

Jumpers on connector JP1 shall not be removed or replaced while the circuit is live unless the area is known
to be free of ignitable concentrations of flammable gases or vapors.

. Carefully locate an appropriate place to mount the XLE/XLT. Be sure to leave enough room at the top of the

unit for insertion and removal of the microSD™ card.

Carefully cut the host panel per the diagram, creating a 92mm x 92mm +/-0.1mm opening into which the
XLE/XLT may be installed. If the opening is too large, water may leak into the enclosure, potentially dam-
aging the unit. If the opening is too small, the OCS may not fit through the hole without damage.

Remove any burrs and or sharp edges and ensure the panel is not warped in the cutting process.

Remove all Removable Terminals from the XLE/XLT. Insert the XLE/XLT through the panel cutout (from the
front). The gasket must be between the host panel and the XLE/XLT.

Install and tighten the four mounting clips (provided in the box) until the gasket forms a tight seal (NOTE: Max
torque 0.8 to 1.13 Nm, 7-10 in-Ibs).

Reinstall the XLE/XLT I/0O Removable Terminal Blocks. Connect communications cables to the serial port,
USB ports, Ethernet.

Factors Affecting Panel Layout Design and Clearances

WARNING: It is important to follow the requirements of the panel manufacture and to follow all applicable electrical
codes and standards.

The designer of a panel layout must assess the requirements of a particular system and to consider the following
design factors.

Clearance / Adequate Space
Install devices to allow sufficient clearance to open and close the panel door.

Minimum Clearance Requirements for Panel Box and Door

Minimum Distance between base of device and sides

of cabinet 2" (50.80mm)

Minimum Distance between base of device and wiring 1.5 (38.10mm)

ducts

If more than one device installed in panel box

(or on door): 4” (101.60mm) between bases of each device

Minimum Distance between bases of each device

When door is closed:
Minimum distance between device and closed door 2”(50.80mm)
(Be sure to allow enough depth for the OCS.)

Page 18 of 178
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Grounding

WARNING: Be sure meet the ground requirements of the panel manufactuer and also meet applicable electrical
codes and standards.

= Panel Box: The panel box must be properly connected to earth ground to provide a good common ground
reference.

= Panel Door: Tie a low impedance ground strap between the panel box and the panel door to ensure that
they have the same ground reference.

Temperature / Ventilation

Ensure that the panel layout design allows for adequate ventilation and maintains the specified ambient tem-
perature range. Consider the impact on the design of the panel layout if operating at the extreme ends of the ambi-
ent temperature range. For example, if it is determined that a cooling device is required, allow adequate space and
clearances for the device in the panel box or on the panel door.

Noise

Consider the impact on the panel layout design and clearance requirements if noise suppression devices are
needed. Be sure to maintain an adequate distance between the XLE/XLT and noisy devices such as relays, motor
starters, etc.

Shock and Vibration

The XLE/XLT has been designed to operate in typical industrial environments that may inflict some shock and vibra-
tion on the unit. For applications that may inflict excessive shock and vibration please use proper dampening tech-
niques or relocate the XLE/XLT to a location that minimizes shock and/or vibration.

Panel Layout Design and Clearance Checklist
The following list provides highlights of panel layout design factors:
= Meets the electrical code and applicable standards for proper grounding, etc.?
= Meets the panel manufacturer’s requirements for grounding, etc.?
= [s the panel box properly connected to earth ground? Is the panel door properly grounded? Has the appro-
priate procedure been followed to properly ground the devices in the panel box and on the panel door?
= Are minimum clearance requirements met? Can the panel door be easily opened and closed? Is there
adequate space between device bases as well as the sides of the panel and wiring ducts?
= |s the panel box deep enough to accommodate the XLE/XLT?
® [s there adequate ventilation? Is the ambient temperature range maintained? Are cooling or heating devices
required?
= Are noise suppression devices or isolation transformers required? Is there adequate distance between the
base of the XLE/XLT and noisy devices such as relays or motor starters? Ensure that power and signal wires
are not routed in the same conduit.
= Are there other requirements that impact the particular system, which need to be considered?

Page 190f 178
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Electrical Installation

Ground Specifications .. ... . . 21
How to Test for Good Ground .. ... .. . 21
Primary Power Port . . 22

NOTE: The datasheet is the first document to refer to for model-specific information. Refer to the Documentation
Search on the Horner website.

Ground Specifications

Ideally, a ground resistance measurement from equipment to earth ground is 0Q. In reality it typically is higher. The
US National Electrical Code (NEC) states the resistance to ground shall not exceed 25Q. Horner Automation recom-
mends less than 15Q resistance from the equipment to ground. Resistance greater than 25Q can cause undesir-
able or harmful interference to the device.

Grounding Definition - The term Ground is defined as a conductive connection between a circuit or piece of equip-
ment and the earth. Grounds are fundamentally used to protect an application from harmful interference causing
either physical damage such as by lightning or voltage transients or from circuit disruption often caused by radio fre-
quency interference (RFI).

How to Test for Good Ground

In order to test ground resistance, a Ground Resistance Tester must be used. A typical Ground Resistance Meter
Kit contains a meter, two or three wire leads, and two ground rods. Instructions are supplied for either a two-point or
a three-point ground test. The figure shows a two-point ground connection test.

GROUND RESISTANCE METER
] Vo

GROUND - / t S G S

DISCONNECTED o
FROM SERVICE

GROUND ROD

METAL WATER PIPE OR
OTHER GOOD GROUMND
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Primary Power Port
NOTE: The Primary Power Range is 10VDC to 30VDC.

Primary Power Port Pins
PIN Signal Description
Ground | Frame Ground
DC- | Input Power Supply Ground
DC+ | Input Power Supply Voltage

WIN|—

DC Input / Frame
¢ Solid/Stranded Wire: 12-24 awg (2.5-0.2mm)
e Strip length: 0.28” (7mm)
¢ Torque, Terminal Hold-Down Screws: 4.5 —7 in-Ibs (0.50 — 0.78 N-m)
¢ DC-isinternally connected to I/0O V-, but is isolated from CAN V-. A Class 2 power supply must be used.

Power Up
1. OPTION: Attach ferrite core with a minimum of two turns of the DC+ and DC- signals from the DC supply that
is powering the controllers.

2. Connect to earth ground.
3. Apply recommended power.

Page 22 of 178
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System Settings
System Settings
System M eNU . 24
Set Network and Contrast ... . 28
View Status, Diags, I/O Slots and Protocols ... ... ... ... . . 29
Set Keys, Serial Ports, Ethernet, Time/Date and Beeper ... ... . . . ... 33
Removable Media ... 35
Fail-Safe System . . . 39
Clone UNit .. 41
Touch Screen Calibration for XLT/XLTe ... 43

System Menu

The XLE/XLT controller has a built-in System Menu, which lets the user view System Settings and make adjust-
ments. To start the System Menu, press the 1 and | keys at the same time (or set %SR3 to 1), which will display the
Main Menu. Then use the 1 and | keys to select a Main Menu item and press Enter to display the item’s Sub-Menu.

XLE Only: The XLE display shows up to six (6) lines of text at a time. For System Menu screens that contain more
than 6 lines of text, use the 1 and | keys to scroll the display.

XLT Only: The XLT display shows up to 12 lines of text at a time. For System Menu screens that contain more than
12 lines of text, scroll the display. RUN/OK LED lights indicate the following:

RUN/OK LED Lights
® OFF indicates OCS is in IDLE/STOP mode.

RUN ® Flashing indicates DO / IO mode or RUN with no ladder
program.
= ON indicates ladder code running.
= OFF indicates one or more self-tests failed.
OK = ON indicates all self-tests passed.
u

Flashing at 1 Hz indicates forcing is active.

Page 24 of 178
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System Menu — Navigation and Editing

As mentioned above, the System Menu is started by pressing the 1 and | keys at the same time for the XLE, or the
System key on the XLT. Then, either press ESC to exit the System Menu, or use the 1 and | keys to select an item
and press Enter to display the item’s Sub-Menu.

A Sub-Menu generally shows a list of System Settings and their values. After opening a Sub-Menu, if any of its Sys-
tem Settings are editable, the first System Setting that can be edited is highlighted. If desired, the 1 and | keys can
be used to select a different System Setting to be edited.

At this point, either press ESC to exit the Sub-Menu (returning to the Main Menu) or press Enter to edit the high-
lighted System Setting. If Enter is pressed, the System Setting’s value will be highlighted, indicating that it is ready
to be modified.

When modifying a System Setting’s value, use either the arrow keys (« — 1 | ) or the numeric keys, or the appro-
priate touch screen icons to select a new value.

The arrow keys are used to edit System Settings that have just a few possible values. Each time the arrow key is
pressed, a new possible value is displayed. When the desired value appears, press the Enter key to save it; oth-
erwise press the ESC key to cancel the edit.

The numeric keys are normally used to enter numeric System Settings. In addition, to edit a single numeric digit,
use the «— or — key to select the digit and then either press a numeric key or use 1 or | to modify the digit. In any
case, after entering the new desired value, press the Enter key to save it; otherwise press the ESC key to cancel the
edit.
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XLE/XLEe System Menu Map
Sub-Menus Sub-Menus
Hetwork 0k? Yax Port 1:
Hetwork ID: 253 xLE {Hone Loaded)
System M >
vs Em E'I"Il..l “| Part 2:
H Loaded)
Hetwask Baud: 125 KB Hone Loads
-
e,
(g wl-T ta adjust
Fheys: Momentarcy
Contrast: EEER o Sys-Fn enable: b4 1]
h "
(Use &= — to adjust) { D= 4T te adjust §
Medel : KELDJE Eet Metwark ID Dflt Pgm Port MJ1-232
Mode - Idle Zet Hetwork Baud - M.J1 RS4B5 Bias Ko
Zean Rate(=mS): 0.0 Set Contrast #| MJ2 RE4BS Bias Ha
Lel Met Use{%y: 0.0 - View Status S=t Etharnet (Ene=t)
All Het Us={%): 0.0 = View Diags
Ladder Size: 2 View I/0 Slots { Use +T te adjust §
Config Size: 8 View Protocols
Graphics Sz: 8 Set Fkeys Mode
Etring Size: g Set Serial Ports
Bitmap Size: g St Time,/Date Addr: 192.169.234.128
Teaxt Size: a Set Screen Mask: 253.255.255.0
Font Size: a8 Resovable M=dia Ghwy: 0.0.0.0
Frotocal Sz: g Fail - Safe | =
EMS Msg Szx: g System { RBeset reguired ta )
Firmware HRew: 11.59% Clone Unit | { enable changes ]
CPLD BRe=vw: .5 {ESC to Exit)
Eelf-Test: Ok
Time: 10:21:38
w | Date: 22-Jun-200&
- Dy : Thursday
Eystem RAM: Ok N
System BIOS: Ok { Use T to adjust )
Firmwars: Ok " { marh fis=ld ]
Logic Error: Ok ™
User Program: Ok
User G hics: Ok
= £=? o Saver enable: Yes
W-Dog Troips: a : - )
Het Errarcs: i} —} T"m':'u: [min}: 15
Hetwork State: Ok _P‘:"F."”F abatias: QEE
Hetwork ID: Ok Update Time ':'_'3:" ) 3
Dup Het TO: Ok Max. graphics time
Clock Error: Ok In the log scan.
I/0 System: Ok
—
Ma Card
. B &
ZElat 1:4170: XEx04 "\. ==
Elot 2:+I/0: XEC
. - Clone py create
Backup,/Restore Data Dir Empty F2 Losd
Enable AutaRun F32
Enable AutoLload F4
Esc Cancel
{ESC to e=xit)
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XLT/XLTe System Menu

System Settings

Sub-Menus Sub-Menus
:»icl:wn:.-: ok? fcs Pork i:
Hetwork ID: 233 (Hone Loaded)
LN
-
Fort 2:
(None Loaded)
Network Bawd: 125 EE
.
{ Use +T to adjust ) KLT
Y Fkays: HOmanLary
= Eys-Fn enable: Yas
Coptrast: EEEN
- { O=za It to adjust )
(Use + —» to adjust] o
Sat Metwock L Dflt Fgm Port MI1-2312
Modal: ATHHRK Sat Network Baud MIl RE445 Eias Mo
Mode @ Idle Sat Contrast MI2 RS485 Bias Mo
Scan Rate{mS]: 4.0 - Vs 5?—"‘“5 Set Etharnet [Enat)
Lol Het Used&): 0.0 View Dlags
all Het Usa{%): 4.0 View I/0 Slots { vse 4T to adjust )
Ladder Size: 3 view Protocols
Config Size: B Sat Fheys Mode
Graphics Sz: B Sat Serial Ports
_-'.:-:-:.r.g Siza: B Sat Tima/Date
Bitmap Siza: i Zat Esopar — : -
Text Siza: g Sat Screaen hodr:= .92.16:’:!..{5!’..1;3
Font Size: B Bemovable Media Mask: 288 255 _285.0
Frotocol Sz B Fail - Safe Systam Gowy: 0.4.0.a
SME Msg 3= g Clome Onit —7 ) -
Firmuare Fewv: 11.9& (EEC to Exit) { Feset required to )
CF‘:-I:I Raw: o 1 5 ( =nable changes |
Self-Test: Ck
Time: 10:21:38
| Date: 22-Jun-2007
Day: Thursday
— { Use +T o adjust )
Srerem o ; ok i each field 1
System BIOS: ok
Firmuara: ok
Logic Error: ok 1‘:_
User Program: ok -
User Graphics: ok Saver anabla: Yas
W-Dog Trips: 1 & Timecutmin):
et Errors: I Popuap Statos: off
Hetwork State: ok Opdate Tima IIIT-%] !_. 3
Network ID: Ok Hax. :J-'-_!FZ'II_S ¥
Cup Het ID: ol In tha log scan.
Clock Error: ok
I/0 Systam: ok
Battary: ok
-
| Mo Card
Elok Clore Unit
2ot Backup/Restore Data = Pir Eupty
Enahle AutoFun
Ec\npc: Enable: Yes “ Enable Autoload

{ Use 4T to adjusc )

[ESC to exit)
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Set Network and Contrast

Set Network ID
The Network ID Sub-Menu only appears for XLE/XLT models that have CAN ports (XE1xx). This Sub-Menu dis-
plays two System Settings of which only Network ID is editable.

Set Network ID

Network Ok? Yes_= NET1 connected to a CAN network and functioning properly
No = Not ready to communicate on CAN network
Network ID 110 253 = This node’s CsCAN Network ID; must be unique on network

Set Network Baud Rate
The Network Baud Sub-Menu only appears for XLE/XLT models that have CAN ports (XE1xx). This Sub-Menu dis-
plays just one System Setting and it is editable.

Set Network Baud Rate

125kB = 125kBd CAN network
250kB = 250kBd CAN network
500kB = 500kBd CAN network
1 MB = 1MBd CAN network

Network Baud?

Set Contrast
The Set Contrast Sub-Menu displays just one System Setting and it is editable.

Set Contast

Contrast: H H B B = Current display contrast setting
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View Status, Diags, /O Slots and Protocols

View Status

The View Status Sub-Menu displays up to 17 System Settings. The Lcl Net Use % and All Net Use % System Set-
tings only appear for XLE/XLT models that have CAN ports (XE1xx). Only the Mode System Setting is editable.

View Status

XExyyz = 5 or 6 character Model number of this XLE/XLT unit
x = 1 for models that have a CAN port
0 =no CAN port yy = the installed I/O module

LA 00 =no I/O module

z = the installed COM module

N =no COM module

Idle = XLE/XLT is in Idle mode
Mode: DolO = XLE/XLT is in Do I/O mode

Run = XLE/XLT is in Run mode

Scan Rate(mS)

0.0 = XLE/XLT is not in Run mode
0.1 t0 999.9 = Average number of mS for each ladder scan

Lcl Net Use %:

0.0 to 100.0 = CAN network bandwidth % used by this XLE/XLT node

All Net Use %:

0.0 to 100.0 = CAN network bandwidth % used by all nodes

Ladder Size: x = Number of bytes in application ladder program

Config Size: x = Number of bytes in application 1/O configuration

Graphic Sz: x = Number of bytes in application graphic screens

String Size: x = Number of bytes in application string table

Bitmap Size: x = Number of bytes in application bitmaps

Text Size: x = Number of bytes in application text tables

Font Size: x = Number of bytes in application font tables

Protocol Sz: x = Number of bytes in application downloaded protocols
SMS Msg. Sz: x = Number of bytes in application SMS protocol configuration
Firmware Rev: Current firmware version

CPLD Rev: Current CPLD (Complex Programmable Logic Device) version
Self-Test: Ok = All power-on self-tests passed

Fault = One or more power-on self-tests failed
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View Diags

The View Diags Sub-Menu displays up to 14 System Diagnostics, all of which are not editable. The Net Errors, Net-
work State, Network ID and Dup Net ID System Diagnostics only appear for XLE/XLT models that have CAN

ports (XE1xx).

The first five System Diagnostics are critical. If any of them indicate a Fault condition, the XLE/XLT will not enter or

System Settings

remain in Run mode, and the problem must be investigated and corrected.

System Diagnostics - Critical
) Ok = System RAM power-up self-test passed
SR (R Fault = System RAM power-up self-test failed
; Ok = System BIOS power-up self-test passed
e B0 Fault = System BIOS power-up self-test failed
Firmware: Ok = Firmware power-up self-test passed
: Fault = Firmware power-up self-test failed
Logic Error- Ok = All executed ladder instructions are legal for loaded firmware
9 ’ Fault = A ladder instruction not supported by firmware was found
User Proaram: Ok = Ladder program and I/O configuration loaded successfully
gram. Fault = Ladder program or I/O configuration not loaded or load failed

The last nine System Diagnostics are informational. If any of them indicate a Warning condition, the XLE/XLT can

still enter and remain in Run mode, but the problem should be investigated and corrected.

System Diagnostics - Informational

User Graphics

Ok = Application graphics objects loaded successfully
Fault = Application graphics objects not loaded or load failed

0 = Watchdog timer has not tripped since the last power-up

HiRDEE st x = Number of times watchdog timer has tripped
Net Errors: 0 = No CAN network bus-off errors have occurred
x = Number of CAN network bus-off errors that have occurred
Network State- Ok = At least one other node was found on the CAN network
Warning = No other nodes were found on the CAN network
Network ID: Ok = This noqe’s CAN Network ID is in the range 1 to 253
Warning = This node’s CAN Network ID was out of range at power-up
Dup Net ID: Ok = '_I'his nodg’s Netyvork IDis unigue on_the CAN network
Warning = This node’s Network ID is duplicated in another node
Clock Error: Ok = '_I'ime a_nd date have been set
Warning = Time and date need to be set
. Ok = 1/0O configuration matches the installed I/O and COM modules
I/O System:

Warning = I/O configuration needs updating to match installed modules
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View 1/O Slots
The View I/O Slots Sub-Menu displays two System Settings, both of which are not editable.

System Settings

Internal to the XLE/XLT, there is a CPU board, and up to two installed modules. Models XEO00 and XE100 have no
installed I/O or COM modules. All other models have an I/O module in Slot 1 and can have a user-installed COM
module in Slot 2.

Depending on which I/O module is installed and which /O module has been configured by Cscape, one of the fol-
lowing six System Settings should appear for Slot 1:

1/0 Slot 1 - System Settings
Slot 1: I/O: Empty = No I/0 module installed or configured
Slot 1: *Unsupported = Unsupported I/0 module installed
Slot 1: -1/0O Missing = No I/O module installed but an I/O module is configured
Slot 1: +1/O: XExyy =yy I/0O module installed but no I1/O module configured
Slot 1: ?1/0: XExyy =yy I/0O module installed but another I/O module configured
Slot 1: 1/0: XExyy =yy /0 module installed and configured properly

Depending on the COM module that is installed and the COM module that has been configured by Cscape, one of
the following six System Settings appears for Slot 2:

1/0 Slot 2 - System Settings
Slot 2: 1/0: Empty = No COM module installed or configured
Slot 2: *Unsupported = Unsupported COM module installed
Slot 2: -1/0 Missing = No COM module installed but an COM module is configured
Slot 2: +1/0: XzC =yy COM module installed but no COM module configured
Slot 2: ?1/0: XzC =yy COM module installed but another COM module configured
Slot 2: 1/0: XzC =yy COM module installed and configured properly
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View Protocols
The View Protocols Sub-Menu displays two System Settings, both of which are not editable.

Both the MJ1 (Port 1) and MJ2 (Port 2) serial ports support downloadable protocols. To assign a downloadable pro-
tocol to an XLE/XLT serial port, select the Protocol Config item in Cscape’s Program menu and then setup a pro-
tocol for Port 1 or Port 2 (or both). Refer to " Serial Communications" on page 105 for more details.

In the View Protocols Sub-Menu, the currently downloaded protocol, if any, and its version number are displayed for
both Port 1 and Port 2.

Port 1 - Protocol
Protocol Name = (None Loaded) or name of the protocol assigned to MJ1
Protocol Version = Blank or version of the protocol assigned to MJ1

Port 2 - Protocol
Protocol Name = (None Loaded) or name of the protocol assigned to MJ2
Protocol Version = Blank or version of the protocol assigned to MJ2
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Set Keys, Serial Ports, Ethernet, Time/Date and Beeper

Set Keys
The Set Fkeys Sub-Menu displays two System Settings, both of which are editable.
Fkeys:
Momentary = %K1-10 bits go On & Off as F1-F10 are pressed & released
Toggle = %K1-10 bits toggle each time F1-F10 are pressed
SYS_Fn enable
Yes = Reset and all clear system functions enabled
No = Reset and all clear system functions disabled

Set Serial Ports

The Set Serial Ports Sub-Menu displays three System Settings; all of which are editable, and one optional item. For
the Dflt Pgm Port System Setting, only MJ1-232 can be selected, unless either an Ethernet (XEC) or a Modem
(XMC) COM module is installed. Also, the Set Ethernet (Enet) item only appears if an Ethernet COM module is
installed.

Dfit Pgm Port

MJ1-232 =MJ1 RS232 port is the default programming port
Enet = Ethernet COM module is the default programming port
Modem = Modem COM module is the default programming port

MJ1 RS485 Bias
No = MJ1 RS485 bias resistors are not switched in
Yes =MJ1 RS485 bias resistors are switched in

MJ2 RS485 Bias
No = MJ2 RS485 bias resistors are not switched in
Yes = MJ2 RS485 bias resistors are switched in

Set Ethernet (Enet)

= Select and press Enter to setup the Ethernet COM module

Set Ethernet (Enet) (for units older than Rev TA)

The Set Ethernet (Enet) Sub-Menu displays three System Settings, all of which are editable. The values shown
below are the default values. NOTE: If Gtwy is set to 0.0.0.0, Ethernet communication will be confined to the local
network.

Set Ethernet (XLEe & XLTe only)

Addr: 192.168.254.128 = |P Address for installed Ethernet COM module
Mask: 255.255.255.0 = Net Mask for installed Ethernet COM module
Gtwy: 0.0.0.0 = Gateway device IP Address for installed Ethernet COM module
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Set Time/Date

The Set Time/Date Sub-Menu displays three System Settings. Time and Date are editable, and Day is auto-

matically calculated from the Date setting. NOTE: Time and Date are split into three editable fields each. Use < or
— to select a field and then use | or 1 to edit the field.

Set Time/Date
Time: 10:21:36 = Current time (hours:minutes:seconds in 24-hour format)
Date: 22-Jun-2022 = Current date (day-month-year)
Day: Thursday = Current day of week calculated from the Date setting

Set Beeper (XLT or XLTe only)
NOTE: Does not apply to XLE or XLEe. The Set Beeper Sub-Menu displays one System Setting, which is editable

Beeper Enable

Yes (default) = Enables beeper
No = Disables beeper (does NOT affect ladder access)
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Removable Media

See also: "Removable Media" on page 136

Format a microSD Card
1. Select Removable Media in the System Menu of the controller.
2. Place card in the “Memory” slot.
3. Final Step:
a. For XLE, press the bottom right soft key to get the submenu that includes “format”, select format.
b. For XLT, press the bottom left and right keys to get the sub menu that includes “format”, select format.

XLE/XLEe Removable Media Sub-Menu

The Removable Media Sub-Menu displays the Removable Media. Refer to"Removable Media" on page 136 for
more details. After selecting Removable Media from the Main Menu, one of four Sub-Menu screens will appear:

- IEd“ Direstory = No microsD card has been installed in the Memory slot
O LBr

Media Directory = micro5D card is installed, but it is still initializing
Inmitielizing

- l'i Lirectory = microSD card is installed and initialized, but contains no files
ir Empty

Media Directory
FILENEM] _EXT 11 _7TE

FILEMREMZ EMT 10-20 \
-05 \ Showes size of highlighted file or shows <DIR=if directory is highlight=d

= micro5SD card is installed and initialized, and it contains files

FILENEMI EXT
FILEMEME EXT 1:05p Showsthe date file ordirectory was crested or |ast modified

FILEWNEME EXT (V| Freel> Showsthe time file or directory was crezted or last modified

¥ Zerallbar only sppesrsif displayed directory contsins more than five files andfor

directories.

Shows up to five files or directory names at 3 time

Page 350f 178



I.I HORNER

AUTOMATION GROUP .
System Settings

If the Removable Media Manager displays files or directories, as in the last example above, there are several
options available:

a. If —is pressed, the number of total and free bytes is displayed. Then, pressing < returns to the normal file
and directory display.

b. If a soft key (on either side of the display) is pressed, a pop-up window appears on the right side of the dis-
play, showing the function key options as follows:

RM Function Keys
F1 Delete = Delete the highlighted file or directory
F2 DelAll = Delete all files and directories
F3 Format = Format the microSD card
F4 SavPgm = Save XLE/XLT application to DEFAULT.PGM
Esc Cancel = Cancel current operation (back up one screen)

Pressing the soft key again or pressing ESC returns to the normal file and directory display.

c. Ifadirectory name is highlighted, pressing Enter will switch to that directory showing its files and sub-dir-
ectories. In a sub-directory, highlighting .. (dot dot) and pressing Enter will move up one directory.
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XLT/XLTe Removable Media Sub-Menu

The Removable Media Sub-Menu displays the Removable Media Manager. Refer to "Removable Media" on
page 136 for more details. After selecting Removable Media from the Main Menu, one of four Sub-Menu screens
will appear:

Media Directory
No Card

= No microSD card has been installed in the Memory slot

Media Directory

Initializing = microSD card is installed, but it is still initializing

Media Directory . - v e g . .
Dir Empty = microSD card is installed and initialized, but contains no files

Media Directory

TLOoT = microSD card is installed and initialized, and it contains files
DLOGZ

COPY(2+1.BMF
COPY(3+1.BMF
COPY(4+1.BMF
COPYOF-1. BMF
DEFAULT .PGI
0CSGFX  .ZIF

Shows size of highlighted file or shows <DIR> if directory is highlighted
Shows date the file or directory was created or last modified
Shows time the file or directory was created or last modified

Del |

ﬂ| |.r411

Scrollbar only appears if displayed directory contains more than five files and/or
directaries.

Shows up to five file or directory names at a time
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If the Removable Media Manager displays files or directories, there are several options available:

Delete = Delete the highlighted file or directory
DelAll = Delete all files and directories
Format = Format the microSD card

SavPgm | = Save XLT application to DEFAULT.PGM

| -« | = Enter Key

= Shows number of total and free bytes in removable memory

DSK
E = Up Arrow

= Down Arrow

Esc = Cancel current operation (back up one screen)

Pressing Esc returns to the normal file and directory display.

If a directory name is highlighted, pressing Enter will switch to that directory showing its files and sub-directories. In
a sub-directory, highlighting .. (dot dot) and pressing Enter will move up one directory.
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Fail-Safe System
See also: "Fail-Safe System" on page 149

The Fail-Safe System is a set of features that allow an application to continue running in the event of certain types of
"soft" failures. These "soft" failures include:
e Battery power loss
« Battery-Backed Register RAM or Application Flash corruption due to, for example, an excessive EMI, Elec-
tromagnetic Interference, event.

Selecting “Fail-Safe System” menu will open the following menu screen:

XLT: XLE:

E le . AutoRun

Enable AutolLoad @ R :
: Enable FIutoRun
(ESC to exit) Enable AutolLoad

(ESC to exit)

Selecting Backup/Restore Data displays the following screen:

XLT: XLE:

Backup /Restore Data

Backup Restore Backup/Restore Data
Backup | Restore|
Clear Backup
Exit

Exit

Fail-Safe Functions
Backup = Copies Battery Backed RAM contents on to the onboard flash memory of the OCS.
Restore = Copies the backed-up data from onboard flash to the battery backed RAM.
Clear Backup = The backup data will be erased from the onboard flash.
Exit = Goes back to previous menu.
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AutoRun

System Settings

Selecting AutoRun displays the following screen.

XLT: XLE:

Enable AutoRun Ho@

CRERFRRCAUT IONS R 8E) _
( Auto Enters RUN ) Enable AutoRurn No
( after AutolLoad
( or Battery Fail ) CEERREECAUT IONS R %R
E] { Auto Enters RUM 3

( after AutolLoad h]

({ or Battery Fail b

AutoRun
No = OCS will be in IDLE mode after AutoLoad or Automatic Restore.
Yes = OCS will be automatically placed into RUN mode after AutoLoad or Automatic
Restore.
AutolLoad

Selecting AutoLoad displays the following screen.

XLT: XLE:
Enable Autoloa Ho@
( ButoLoad from ) E—
{ Removable Media’s ) Enable Hutoloa Na
¢ AUTOLOAD.PGM file )
: ( AutolLoad from ]
( when triggered )@ ( Removable Media®s )
( AUTOLOAD.PGM file )
( when triggered 3

AutolLoad
No = Does not load AUTOLOAD.PGM automatically when application program is absent or
corrupted.
Yes = Loads AUTOLOAD.PGM file automatically from RM when application program is

absent or corrupted.
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Clone Unit

See also: "Clone Unit" on page 143

‘Clone Unit’ feature allows the user to “clone” the OCS of the exact same model. This feature “clones” application
program and unit settings stored in Battery backed RAM of an OCS into the RM. Refer to "Clone Unit" on page 143
for more details. It can then be used to clone a different OCS (exact same model).

This feature can be used for:
¢ Replacing an OCS by another unit of the same model.
¢ Duplicating or “clone” units without a PC.

Selecting Clone Unit displays the following screen:

XLT: XLE:
Clone Unit
Dir Empty
i Clone(FyToomere
Dir Empty [[@ALoad

EE=Cancel

((Make |
|L.Clone |

NOTE:
a. Inthe above Figure, F3 and F4 (XLE menu) are inactive in Clone Unit.
b. DSK-when selected shows number of total and free bytes in Removable Media.
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Selecting Make Clonedisplays the following screen.

System Settings

XLT: XLE:
Clone Unit
CLONE LDAT
2123
CLONE LDAT | 05-21
-09
6:125p
Free[>
Make Clone

AUTOLOAD.PGM Application file

CLONE.DAT

File having all unit settings and register values from Battery Backed RAM

Load Clone

Selecting Load Clonedisplays the following screen.

XLT:

AUTOLOAD . PGM
CLONE «DAT

Make Load

Clone Clone

XLE:

Cloning Status

SUCCESS: MAKE CLONE
Ok

NOTE: For security enabled files, Load Clone asks for password validation before loading the application.
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Touch Screen Calibration for XLT/XLTe
NOTE: This does not apply for the XLE/XLEe

The touch screen is calibrated at the factory and rarely needs modification. However, if actual touch locations do not
appear to correspond with responding objects on the display, field adjustment is available. Ensure SYS_fn Enable
is setto YES in System Menu. To access the field adjustable touch screen calibration dialog, press and hold both
the SYS and F1 key for longer than 2 seconds and a dialog similar to the figure below should appear. Thereafter,
use a plastic tip stylus and follow the dialog instructions.

For best results in screen calibration, use a stylus with a plastic tip. When the crosshair appears, touch the center of
the crossbar as exactly as possible and release. A small “+” should appear and will move closer to the center of the
crosshair. Once it has done so and disappeared again, repeat the process until “+” appears in the center of the
cross hair. Then move on to the next step.

Touch Calibration Screen 1. é Touch Calibration Screen

Touch crosshair with stylus,
calculated towch point will appear
and will awto align with crasshair.
_4 Repeat until touch point and crosshairs
no Longer need alignnent to match.

Please touch exbrens,
Top-Right corner point

Hext

Touch Calibration Screen Touch Calibration Screen

Touch crosshair with stylus,
caleulated touch point will appear
and will awto aligm with crasshair. } Save new calibration?

Repeat until touch point and crosshairs
no longer need alignment to match.

= M
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System Register Tables

System Register Tables

Register DefinitioNs . . 45
oS RIS OIS . 46
S R RIS OIS .. 47
110 Register Map for XLE XL . 54
XLE/XLT Resource Limits .. .. . 55

For 1/0 Register Maps for individual controllers, refer to the Horner website Document Search page.

There are two types of System Registers that may be used during programming. %S registers indicate the status of
several system operations. %SR egisters indicate the state of many system operations and can be used to control
them in several cases. Some of the system registers have predefined I/O names, though they may still be changed
if desired.

Register Definitions

When programming the an OCS, data is stored in memory that is segmented into different types. This memory in
the controller is referred to as registers. Different groups of registers are defined as either bits or words (16 bits).
Multiple registers can usually be used to handle larger storage requirements. For example, 16 single-bit registers
can be used to store a word, or two 16-bit registers can be used to store a 32-bit value.

Types of Registers
16-bit input registers used to gather analog input data such as voltages,
temperatures, and speed settings coming from an attached device.
16-bit output registers used to send analog information such a voltages,
levels or speed settings to an attached device.
These are digital flags used to control the displaying of screens on a unit
which has the ability to display a screen. If the bitis SET, the screen is dis-
played.
Single-bit input registers. Typically, an external switch is connected to the
registers.
Single-bit flags used to give the programmer direct access
to any front panel keys appearing on a unit.

%Al = Analog Input

%AQ = Analog Output

%D = Display Bit

%I = Digital Input

%K = Key Bit

%M = Retentive Bit

Retentive single-bit registers.

%Q = Digital Output

Single-bit output registers. Typically, these bits are connected to an actu-
ator,
indicator light or other physical outputs.

%R = General Purpose Register

Retentive 16-bit registers.

%S = System Bit

Single-bit bit coils predefined for system use.

%SR = System Register

16-bit registers predefined for system use.

%T = Temporary Bit

Non-retentive single-bit registers.

Page 450f 178



https://hornerautomation.com/documentation-search/

.I HORNER

AUTOMATION GROUP

%S Registers

%S registers indicate system status as follows:

System Register Tables

%S Registers

S# Name Predefined Notes
1/0 Name

%S1 First Scan FST_SCN On for 1 scan only each time the program is first run
%S2 Network OK NET_OK If on, the Network is OK
%S3 10ms pulse T_10MS Cycling pulse that is high for 5ms and low for 5ms
%S4 100ms pulse T_100MS Cycling pulse that is high for 50ms and low for 50ms
%S5 1secondpulse | T_1SEC Cycling pulse that is high for 500ms and low for 500ms
%S6 I/0 OK I0_OK If on, the I/O system is OK
%S7 Always On ALW_ON This bit is always on
%S8 Always OFF ALW_OFF This bit is always off
%S9 Pause Scan PAUSING_SCN On for at least 1 scan prior to Pause 'n Load
%S10 Resume Scan RESUMED_SCN | Onfor 1 scan only after Pause 'n Load is done
%S11 Forcing Present| FORCE If on, I/O is presently being forced
%S12 Forcing Enabled] FORCE_EN If on, 1/O forcing is been enabled
%S13 Net 1/0 OK NET_IO_OK If on, Network I/O is OK
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%SR Registers

%SR registers are special word-length registers that display and/or control system operations in the controller. Not
all controllers support all defined system registers.

XLE & XLT %SR Registers

SR # Name and Description Default I/0 Min - Program Display
Name Max Val{ (Read/Write) | (Read/Write)
ues
%SR1 User Screen Number (0=none) USER_SCR Oto Read/Write Read/Write
1023
%SR2 Alarm Screen Number ALRM_SCR | 0to1-23| Read Only Read Only
%SR3 System Screen Number SYS_SCR O0to24 | Read/Write Read/Write

1 =Main System Menu
2= Set Network ID, Network Status,
(%SR29)
3= Set Network Baud (%SR30)
4= Set Contrast (%SR32)
5= View OCS Status
6= View OCS Diagnostics
7= View I/O Slots
8= Set Function Key Mode (%SR33)
9= Set Serial Ports (%SR34)
10= Set Time/Date (%SR44-%SR50)
11=Set Beeper (%SR183)
12= Set Screen (%SR185)
13= Removable Media
14= View Protocols
= IP Address IP Address (ETN I/O
Board)
16= Fail Safe System
17=Backup / Restore Data
18= Enable AutoRun
19= Enable AutolLoad
20= Clone Unit -
21=Touch Calibration
24= License Details

%SR4 Self Test Results SELF_TEST Read Only Read Only
%SR4.1 Self Test Results - BIOS Error Read Only Read Only
%SR4.2 Self Test Results - Engine Error Read Only Read Only
%SR4.3 Self Test Results - Ladder Error Read Only Read Only
%SR4.4 Self Test Results - RAM Error Read Only Read Only
%SR4.5 Self Test Results - Duplicate ID Error Read Only Read Only
%SR4.6 Self Test Results - Bad ID Error Read Only Read Only
%SR4.7 Self Test Results - /O Configuration Read Only Read Only
Error
%SR4.8 Self Test Results - Bad Network Error Read Only Read Only
%SR4.9 Self Test Results - Bad Logic Error Read Only Read Only
%SR4.10 Self Test Results - Bad Clock Error Read Only Read Only
%SR4.11 Self Test Results - DeviceNet Error Read Only Read Only
%SR4.12 - 16 Reserved
%SR5 Control Station Mode CS_Mode 0to3 Read Only Read/Write
0= Idle
1=Do I/O

Page 47 of 178



AUTOMATION GROUP

I.I HORNER

System Register Tables

XLE & XLT %SR Registers

2=Run
3= Online Change

%SR6 Average Scan Rate ms (/10) Read Only Read Only
%SR7 Minimum Scan Rate ms (/10) Read Only Read Only
%SR8 Maximum Scan Rate ms (/ 10) Read Only Read Only
%SR9 Current Touch Pressure TCH_ Oto Read Only Read Only
PRESSURE | 3000
%SR10 Threshold Touch Pressure TCH_ 0 to| Read/Write Read/Write
PRESSURE_ | 3000
TSH

%SR11-12 Ladder Size (32-Bit DINT) Read Only Read Only
%SR13-14 User Text Screen Size (32-Bit DINT) Read Only Read Only
%SR15-16 System Text Screen Size (32-Bit DINT) Read Only Read Only
%SR17-18 I/0 Configuration Table Size (32-Bit Read Only Read Only

DINT)
%SR19-20 Network Config Table Size (32-Bit Read Only Read Only

DINT)
%SR21-22 Security Data Table Size (32-Bit DINT) Read Only Read Only
%SR23 Ladder Code CRC Read Only Read Only
%SR24 User Text CRC Read Only Read Only
%SR25 System Text CRC Read Only Read Only
%SR26 I/0O Configuration Table CRC Read Only Read Only
%SR27 Network Configuration Table CRC Read Only Read Only
%SR28 Security Data Table CRC Read Only Read Only
%SR29 Network ID Read Only Read/Write

CsCAN Mode NET_ID 1to

253
DeviceNet Mode 0to 63
CANopen Mode 1to
127

%SR30 Network Baud Rate Oto4 Read Only Read/Write

0=125KB

1=250kB

2=5000KB

3=1MB

4=50K
%SR31 Network Required Oto3 Read Only Read Only

0= Network not required

1= Network required;

2= Network optimized;

3= Network required and optimized
%SR32 LCD Display Contrast setting 0to255| Read Only Read/Write
%SR33 Function Key Toggle Mode Oto1 Read/Write Read/Write

0= Momentary

1=Toggle
%SR34 RS232 Serial Protocol Mode Read Only Read Only

0= Firmware Update (RISM)
1=CsCAN

2= Generic (Ladder- Controlled)
3= Modbus RTU

4= Modbus ASCII
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XLE & XLT %SR Registers

%SR35-36 Unique Serial Number / Hexadecimal Read Only Read Only
ILAN1 MAC ID
%SR37 Model Number Read Only Read Only
%SR38 Engine Version (/100) Read Only Read Only
%SR39 BIOS Rev Number (/ 100) Read Only Read Only
%SR40 FPGA Image Rev Number (/ 10) Read Only Read Only
%SR41 Vertical Pixel Count Read Only Read Only
%SR42 Horizontal Pixel Count Read Only Read Only
%SR43 Keypad Type Read Only Read Only
%SR44 Real-Time-Clock Second RTC_SEC 0to 59 Read Only Read Only
%SR45 Real-Time-Clock Minute RTC_MIN 0to59 Read Only Read Only
%SR46 Real-Time-Clock Hour RTC_HOUR 0to 23 Read Only Read Only
%SR47 Real-Time-Clock Date RTC_DATE 1to 31 Read Only Read Only
%SR48 Real-Time-Clock Month RTC_MONTH | 1t012 Read Only Read Only
%SR49 Real-Time-Clock Year RTC_YEAR 1996 to Read Only Read Only
2095

%SR50 Real-Time-Clock Day (1=Sunday) RTC_DAY 1to7 Read Only Read Only
%SR51 Network Error Count Read Only Read Only
%SR52 Watchdog-Tripped Error Count Read Only Read Only
%SR53-54 Reserved

%SR55.13 Self-Test: Battery Low or Missing Read Only Read Only
%SR56 Key Currently Pressed LAST_KEY | 0to255| Read Only Read Only

No key = 0 (No key pressed since
power-up) F1 =1
F2=2

F3=3
F4=4
F5=5

F6=6

F7=7

F8=8

F9=9
F10=10
F11=11
F12=12
Enter=13
+/-=14
.(dot)=15
0=16
1=17
2=18
3=19
4=20
5=21
6=22
7=23
8=24
9=25
System =26
Escape =27
Left=28
Right =29
Up=30
Down = 31
Shift =32
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XLE & XLT %SR Registers

Soft Key 1 =34
Soft Key 2 =35

Soft Key 3 =36

Soft Key 4 =37

Soft Key 5 =38

Soft Key 6 =39

Soft Key 7 =40

Soft Key 8 =41
Release = 255 (Keys pressed since
power-

up but not currently)

%SR57 LCD Backlight Dimmer Register 0to255| Read Only Read Only
0-100 = 0% to 100% On
100-255=100% On

%SR57.16 Temporarily disable Screen Saver Read/Write Read/Write
%SR58 User LEDs USER_LEDS Read/Write Read/Write
%SR59 Engine Build Number Read Only Read Only
(Only last three numbers displayed)
%SR60 Build Option Oto2 Read Only Read Only
Build Test=0
Build Beta = 1
Build Product = 2
%SR61 Number of CsCAN Network IDs NUM_IDS Read Only Read Only
%SR62-100 Reserved
%SR101.3 WebM License Details — WebMI server Read Only Read Only
status
XLEe & XLTe only
%SR101.4 WebMI License Details — WebMI user Read Only Read Only

logged in status
XLEe & XLTe only

%SR101.8 - 101.16 WebMI License Details — Number of Read Only Read Only
users
XLEe & XLTe only
%SR102 - 107 Reserved
%SR108 WebMI License Details — Number of Read Only Read Only
webpages
XLEe & XLTe only
%SR109 WebMI License Details — Number of Read Only Read Only
datapoints
XLEe & XLTe only
%SR110-112 WebMI License Details — Expiry date of Read Only Read Only
WebMI license
XLEe & XLTe only
%SR113-130 Reserved
%SR131-135 OCS Model: ASCII, 10 characters Read Only Read Only
%SR136 Communication Download Timeout Read Only Read Only
%SR137 Communication Idle Timeout Read Only Read Only
%SR138-148 Reserved
%SR149-150 Free-running 10kHz count: 1 count = Read Only Read Only
0.1ms
(32-Bit DINT)
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XLE & XLT %SR Registers

%SR151 Reserved
%SR152 RS-485 Termination Read/Write Read/Write
%SR152.1 MJ2 Termination Enable Read/Write Read/Write
%SR152.2 Reserved
%SR152.3 MJ1 Termination Enable Read/Write Read/Write
%SR152.4 Reserved Read/Write Read/Write
%SR153 - 163 Reserved
%SR164 FailSafe / clone
%SR164.1 RS485 Port Biasing #1 (MJ1 or MJ2) Read/Write Read/Write
%SR164.2 RS485 Port Biasing #2 (MJ2 or MJ3) Read/Write Read/Write
%SR164.3 Indicates Automatic Restore Operation AUTO_ Read Only Read Only
has been performed RESTRD
%SR164.4 Indicates Backup of Registers has been| BCKUP_TAKN Read Only Read Only
taken
%SR164.5 Enable AUTORUN - Sets “Enable EN_AUTO_LD Read/Write Read/Write
AutoRun” to “Yes” or “No”
%SR164.6 Enable AUTOLOAD - Sets “Enable EN_AUTO_LD Read/Write Read/Write
AutolLoad” to “Yes” or “Not”
%SR164.7 Start Backup trigger bit — STRT_BCKUP Read/Write Read/Write
Setting TRUE starts backup of all
register data
%SR164.8 Clear Backup trigger bit — Setting TRUE | CLR_BACKUP Read/Write Read/Write
clears backup of all register data (if a
backup was done previously)
%SR164.9 MAKE_CLONE trigger bit = MAKE_ Read/Write Read/Write
Setting TRUE does a Load Clone CLONE
(if a media card is present)
%SR164.10 LOAD_CLONE trigger bit — LOAD_ Read/Write Read/Write
Setting TRUE does a LOAD CLONE CLONE
(if a media card is present that contains
clone files)
%SR164.11 Make Clone Fail MK_CLN_FL Read/Write Read/Write
(This bit goes high when Make/Create
Clone fails)
%SR164.12 Load Clone Fail LD_CLN_FL Read/Write Read/Write
(This big goes high when Load Clone
fails)
%SR164.14 Reserved Read/Write Read/Write
%SR164.15 Reserved Read/Write Read/Write
%SR165-166 Reserved
%SR167 Screen Update Time, Default=5 2to 50 Read/Write Read/Write
%SR168-170 Reserved
%SR171 X-Coordinate Touched Read Only Read Only
%SR172 Y-Coordinate Touched Read Only Read Only
%SR173 System-Function Disable Oto1 Read/Write Read/Write
%SR174 Removable Media Protect Read/Write Read/Write
%SR174.1 Request Media Card be Removed Read/Write Read/Write
%SR174.2 Indicates safe to remove Media Card Read/Write Read/Write
%SR175 Removable Media - Status Read Only Read Only
%SR176-177 Removable Media Free Space (32-Bit Read Only Read Only
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DINT)
%SR178-179 Removable Media Total Space (32-Bit Read Only Read Only
DINT)
%SR180 Reserved
%SR181 Bits 1-16 indicate Unacknowledged in ALM_UNACK Read Only Read Only
Alarm Groups 1-16
%SR182 Bits 1-16 indicate Active in Alarm ALM_ACT Read Only Read Only
Groups 1-16
%SR183 Beep on Keypress Enable SYS_BEEP Oto1 Read/Write Read/Write
0= Disabled
1=Enabled
%SR184 Internal Beeper USER BEEP| Oto1 Read/Write Read/Write
0=OFF
1=ON
%SR185 Screen Saver Enabled O0to1 | Read Only Read Only
0= Disabled
1=Enabled
NOTE: See %SR57.16
%SR186 Screen Saver Time in minutes (delay) 5to Read Only Read Only
1200
%SR187 Network Usage (Avg) NET_USE Oto Read Only Read Only
1000
%SR188 Network Usage (Min) Oto Read Only Read Only
1000
%SR189 Maximum Net Usage of all units on the Oto Read Only Read Only
CAN network 1000
%SR190 Network TX Usage % (/ 10) (Avg) NT_TX_AVG Oto Read Only Read Only
1000
%SR191 Network TX Usage % (/ 10) (Min) Oto Read Only Read Only
1000
%SR192 Network TX Usage % (/ 10) (Max) Oto Read Only Read Only
1000
EXTENDED SYSTEM REGISTERS
%SR193 Online Change ONLINE_CHG
%SR193.1 TRUE if 2 programs in target FLASH Read Only Read Only
%SR193.2 TRUE to switch programs, FALSE when Read Only Read Only
complete
%SR193.3 TRUE if executing program is tem- Read Only Read Only
porary test
%SR193.4 TRUE during last scan of switched-from Read Only Read Only
program
%SR193.5 TRUE during first scan of switched-to Read Only Read Only
program
%SR193.6 TRUE to revert to FLASH and Read Only Read Only
delete all RAM;
FALSE when complete
%SR193.9 TRUE if error in temporary program Read Only Read Only
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%SR194 Battery Charge Temp Low Read Only Read Only
%SR195 Battery Charge Temp High Read Only Read Only
%SR196 Charging State O0to 11 Read Only Read Only

NOTE: Refer to MAN1142 for more
details
on Rechargeable Batteries

0=Waiting

1=Normal Charging

2=Hot Charge

3=Hot Charge

4= Battery Hot

5= Cold Charge

6=Battery Cold

7=No Battery

8= Not Charging (after 8 hours of char-
ging)

9= CPU Hot, not charging

10 Battery voltage <2V, not charging
11= First 2 minutes Init Wait (Not Char-

ging)

%SR197 Charging Current Max mA Read Only Read Only

%SR198 Battery Voltage is mV Read Only Read Only

%SR199 Reserved

%SR200 InitRD Version (/100) Read Only Read Only

%SR201 - 205 Linux Kernel version: ASCII, 10 char- Read Only Read Only
acters

%SR206-208 Reserved

%SR209.3 WebMI Server Status. Bit 3 is ON if Read Only Read Only
server running.

%SR209.4 WebMI User Logged in Status. Read Only Read Only
Bit 4 is ON if 1 or more users logged in.

%SR209.8 - 209.14 Number of Users. Read Only Read Only
Shows in upper byte in decimal format.

%SR210 Time Zone: set in minutes +/-UTC (Ex: Read/Write Read/Write
EST is -4 hours = -240 minutes)

%SR211 Daylight Saving: YES =1 Read/Write Read/Write

Daylight Saving: NO = 0
(If daylight saving is enabled,
one hour will be added to the local time).

%SR212 UTC - Seconds Read Only Read Only
%SR213 UTC - Minutes Read Only Read Only
%SR214 UTC - Hours Read Only Read Only
%SR215 UTC - Date Read Only Read Only
%SR216 UTC - Month Read Only Read Only
%SR217 UTC - Year Read Only Read Only
%SR218 Reserved
%SR219 Reserved
%SR220-222 Reserved
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/0 Register Map for XLE/XLT

NOTE: These registers can be used as general purpose registers

Description
Registers XLE/XLT with| XLE/XLT with | XLE/XLT with | XLE/XLT with | XLE/XLT with | XLE/XLT with
no I/0 102 1/0 103 1/0 104 1/0 105 1/0 106 1/0
%11-%112 Unused Digital Inputs
%I113-%116 Unused Reserved Digital Inputs Reserved
%I117-%124 Unused Reserved Digital Inputs Reserved
%125-%131 Unused Reserved
%132 Unused Output Fault | Output Fault | Output Fault | Reserved
%Q1-%Q6 Unused Digital Outputs
%Q7-%Q12 Unused Reserved Digital Outputs
%Q13-%Q16 Unused Reserved | Digital Outputs| Reserved
%Q17 Unused Totalizer: Clear HSC1, Quadrature: Clear Quad1
%Q18 Unused Totalizer: Clear HSC2, Quadrature: Set Quad1
%Q19 Unused Totalizer: Clear HSC3, Quadrature: Clear Quad2
%Q20 Unused Totalizer: Clear HSC4, Quadrature: Set Quad2
%Q21-%Q24 Unused Reserved
%AI1-%Al4 Unused Analog Inputs Reserved
%AI5-%AI6 Unused HSC1 Accumulator
Y% AI7-%AI8 Unused HSC2 Accumulator
%AI9-%AI10 Unused HSC3 Accumulator
%AI11-%Al12 Unused HSC4 Accumulator
%AI33 - %AI38 Unused Analog Inputs
%AQ1-%AQ2 Unused PWM1 Duty Cycle
%AQ3-%AQ4 Unused PWM2 Duty Cycle
%AQ5-%AQ6 Unused PWM Prescale
%AQ7-%AQ8 Unused PWM Period
%AQ9-%AQ10 Unused Analog Outputs
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XLE/XLT Resource Limits

Resource Value
%S 13
%SR 192
%T 2048
%M 2048
%R 9999
%K 10
%D 1023
%l 2048
%Q 2048
%Al 512
%AQ 512
%IG 64
%QG 64
%AIG 32
%AQG 32
sCAN
NEEDS [FRrES (Optional de?)ecriding on model)
Controllers Per Network 253
Keypad 20 keys (10 fn keys and 4 soft keys)
Display 128x64 LCD Backlit', monochrome for XLE
160x128 LCD Backlit, monochrome for XLT
Screen Memory ™
User Screens 1023
Data Fields Per User Screen 50
Ladder Code 256k
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XLE & XLT BackgroUund . .. . 57
Cscape Status Bar .. ... . 58
Establishing Communications ... .. .. 59
Cscape Configuration .. .. 65

XLE & XLT Background

XLE/XLT hardware is programmed with a Windows based PC application called Cscape. This application can be
used to program, configure, monitor and debug all aspects of the XLE/XLT unit. Please see the on-line help
provided with Cscape for additional details.

Updating Programs from First Generation to Second Generation XLE/XLT

Generation 1 products did not feature integrated Ethernet, so if the part number contains an E like HE-XT1EOQ or
HE-XE1EG it is a second generation unit. Devices without integrated Ethernet can be checked using the hardware
revision after the part number. Hardware revision “T” and later are Generation 2 products. For example, XE-
XE103TB is hardware revision “T.”

Cscape programs created for the first generation XLE and XLT can be loaded into Generation 2 products without
any changes.

If you created PGM files to be loaded into XLE or XLT devices via the microSD card, then these can be used.
If your configuration contains no downloadable protocols, then you can use the PGM without any changes.

If your PGM contains downloadable protocols, then you can either recreate the PGM with Cscape 9.8 or later, or
you can use the PGM Update utility that distributes with Cscape 9.8 or later. The utility is located in the main Cscape
folder and is called PGMUpdateUtility.exe. Running this allows inputting the old PGM filename and it will update it
to a new file for download into Generation 2 (Rev T or later) products.
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Cscape Status Bar

When the XLE/XLT is connected to a PC using Cscape software a Status Bar appears at the bottom of the screen.
The Cscape Status Bar can be used to determine if communications have been established between the XLE/XLT
and the Cscape program. Components of the Cscape Status Bar are explained below.

Message Line -
The contents of Equal Indicator - indicates whether the current program in Cscape is equal to the program
these messages stored in the Target Controller.
are context * |f Equal, the program in Cscape is the same as the program stored in the Target Controller.
sensitive. The + |f Not Equal, the program in Cscape is not the same as the program stored in the Target
Message line can Controller.
be empty. ¢ |f Unknown, there may have been a change since the last time the program in Cscape was
compared to the Target Controller.
File Modified Indicator - indicates that the file in
Current User - the selected window has been modified but has
indicates who is logged not been saved.
(for ser_'rrit\,r purposes).
Ready User: HE-XExx1-CsCAN Equal | Local :1 Target :2(R) [no | MOD
NONE (Model=) forces]
Controller Model - Network (Model Confirmation) Communications Status - indicates the current status of the

“pass through” Connector.
. Controller Model indicates the controller model for

which the program in Cscape is configured. s Local xx - indicates the Network ID of the OCS to which
the Cscape program is physically connected through its

*  Networkindicates the type of network that the serial port. It can serve as a pass-through device to other
program in Cscape expects to use (e.q., CsCAN). nodes on the network.

¢ (Model Confirmation) provides the following ¢ Target:yy(R) - indicates the Network ID of the device with
indications: which the Cscape program is exchanging data.

NOTE: The Local unit and Target unit can be the
. (Model=) - The actual Target Controller matches the same unit, or they can be separate units.

configured Controller Model and Network.

The following are status indicators:
. (Model Not=) - The actual Target Controller does not

match the configured Controller Model and Metwork. (R) - Running
(D)-Do I/
. (Model ?) - There may have been a change since the - ldle
last time the Target Controller was compared to the (?) - Cscape is not communicating with the remote unit.
configured Controller Model and Network. [no forces] - indicates no I/O has been forced.

Page 58 of 178



I.I HORNER

AUTOMATION GROUP ) .
Cscape Configuration

Establishing Communications
The XLE/XLT can communicate with Cscape using USB to serial adapters, Ethernet, USB, or CAN (CsCAN).

Communicating via USB Port - To communicate with the XLE or XLT via USB you will need the Automated Driver
Installer located on the Horner Automation web site. The drivers may be loaded from the HE-XEC Ethernet Utility /
HTTP Web Server Demo / Communications Drivers section of the support files page on our website, found
here: https://hornerautomation.com/support-files .

Next, connect a PC’s (Personal Computer running a Windows Microsoft operating system) USB port via USB cable
to the USB mini B port on the XLE/XLT OCS.

The PC will detect a new device has been plugged into the USB port.

Open Cscape and the first screen to open will be the Connection Wizard > USB > Next>> > Finish.
Connection Wizard X |

Configure

USB list USB Serial Port (COMS) | | Dorit Know |

[V Show connection wizard on startup. << Back | Finish Cancel
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23| || 5 |22 ) Herdware Corfiguration...

Project Toolbox @ Set Target Network ID...

Bitwise Operations

®|®

Boolean Elements

®

Compare Operatia

®

Conversion Opera

Math Operations

Move Operations

|8 ®

Simple Elements

®

Timer/Counter Op| |

@

Special Operation:

@

Removable Media

Cscape Configuration

g=~

" Senal " Ethemet  Can  Modem f‘[}USB

Back | Mext > I

[ Show connection wizard on startup.

Configure

| Dont Know

UsBlkst Controller USB COM Port (COM32) N |

[~ Show connection wizard on startup.

If Controller USB COM Port is not present in the dropdown list, the Windows operating system has not yet recog-
nized the OCS as an installed device. Be sure the installation process is complete and that the correct drivers are
installed. The Connection Wizard must be completely closed and reopened to refresh the USB dropdown list.

An alternate way to select the COM setting is to go to Cscape > Tools > Application Settings > Communication
> Configure and choose connection method in Add Target.

& Cscape - [EGD Node1]

&
»
]
0
o

B |2[3|=[5]x |-[o~] B
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Application | Communication Settings
Communications  |MameDefaul]
L i —
Timeout: 1000 .
Add Target -} e
Target Mame: |De|a..l‘]
— Connection Medium
" ComPait: [i :II =
" Ethsinat 192 . 168 . 254 . 12 Post I185Eﬂ Mode: [Built-in/ETN Ethemet Mode -
Configure >3 Help v - MTU Size 1500
— Can Inter
[cams00 | |
" Installed Modem | ;l
Phone Number |
& USE [USE Serial Port (COM1) =]
-~ Connected Device
@ ConnectedDevice (" TargetNode ID |1 j
! ~ Connection Settings - il
b Apply M asimum Baud Fate IEI?EUD v
l I Timegut: {1000 s
MoY | Mov
i i oK Cancel il
AN AOTO05-JIN
12720 QF=R02721 BQFERDeres
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Communication Configuration Dialog

Target Name

Name for connection. This is not a mandatory column to be filled, by default Cscape will pop-
ulate ‘Default1’ in edit box.

Connection Medium

Com Port

Select this option to communicate over serial communication with the device. The port num-
ber can be configured here.

Ethernet

Select this option to communicate over Ethernet. Provide the IP address of the device and
select the mode: HE GSM GPRS mode, Built in/ ETN Ethernet mode, or HE XEC Ethernet
mode.

Select HE GSM GPRS mode if communication with XL series controller on GPRS is
required and the device has GSM modem installed in XL series controller.

Select Built in/ ETN Ethernet mode if the device has on-board Ethernet port.

Select HE XEC Ethernet mode if the device has Ethernet comm. option board installed in XL
series controller.

NOTE: For GPRS connectivity, GPRS configuration from Programs a Messaging 8 GPRS
needs to be done.

NOTE: The controller should support the type of connectivity selected and configured for
Ethernet communication.

CAN Interface

Select this option to communicate over CAN. This option requires additional hardware to be
installed with the PC to be able to do so. Select the type of hardware installed from the drop-
down.

Installed Modem

Select this option to communicate to the device through the internal modem of the computer.
Cscape will automatically detect the internal modem attached with PC and list in the
attached drop down. User can select modem and telephone number for target controller.
NOTE: Cscape will do necessary initialization for the selected internal modem.

usB

Select this option to communicate over USB. Now Horner devices and Horner USB to serial
converters are recognized and can be specifically selected.

Connected Device

NOTE: This configuration is required if the controller to which Cscape is communicating is connected to a CsCAN

network.

Connected Device

By default, this option is selected and networking feature of Cscape is disabled.

Target Node ID

On selecting this option, Networking feature of Cscape is enabled. CsCAN ID for the target
controller to be provide here.

Connection Settings (General Communication Settings)

Maximum Baud
Rate

Select the baud rate for serial communication.

Timeout

Select the communication timeout.

NOTE: Select a larger timeout for GPRS and installed modem communication configuration
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If communications are successful, the message line should show “USB (COM8)” for this example, and an (R)
should follow the Target number.

USB (COMBS) User: NONE XLde - CsCAN Model Equal Mot Equal |Locall Target1(R) [no forces]

When connected directly to the controller to which Cscape
communications are required, the Local ID and the Target

ID should match. Local ID and Target ID Match

If the controller is not communicating, you may need to set the target ID of the controller in Cscape or on the unit.
The Target ID allows directing communications to a particular unit when multiple units are connected via a CsCAN
network. Units without CsCAN network ports respond to any network ID and do not require the ID to be configured.

Communicating via MJ1 Serial Port

If a serial programming connection is to be used and the PC has a 9-pin serial COM port, which is increasingly rare,
there is nothing to install assuming the port already works. All that is needed is a programming cable to go from the
COM port to the OCS programming port.

If a serial programming connection is to be used and the PC does not have a COM port, a USB-to-Serial adapter
may be used. Horner offers the HE500USB600 USB-to-RS232 Serial Adapter, which comes as part of the HE-CPK
programming kit. Drivers for it are normally found automatically by the Windows operating system as long as an
internet connection is established. Otherwise, the drivers may be loaded from the Horner FTP site at
https://hornerautomation.com/support-files/ .

Connect the PC’s serial port or the USB-to-Serial adaptor to the port labeled MJ1 on the XLE/XLT.

The instructions are similar to using a USB port, as shown above. In the Connection Wizard, select the “Serial”
option.

If communications are successful, the target indicator should show the mode of the controller Target: yy(R) as
shown above in "Cscape Status Bar" on page 58

If the controller is not communicating, you may need to set the target ID of the controller in Cscape or on the unit.
The Target ID allows directing communications to a particular unit when multiple units are connected via a CsCAN
network. Units without CsCAN network ports respond to any network ID and do not require the ID to be configured.

To check or change the ID on the XLE/XLT OCS, press the UP and DOWN keys on the XLE/XLT simultaneously to
enter the System Menu. The first item in the menu is Set Network ID. Pressing Enter allows you to vie or modify the
ID of the unit.

To change the Target ID of Cscape use the Controller > Set Target Network ID dialog.
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Communicating via On Board Ethernet Port

From Cscape go to Controller > Hardware Configuration and do auto configuration for the connected controller,
Click on Config of Ethernet & go to Module Setup.

The IP address, Net Mask, and Gateway of the controller may be temporarily set from the system menu under the
Set Networks menu item. Once running or power cycled the configuration will come from the Cscape configuration
stored in the unit.

In Module configuration dialog, go to IP Address field enter unused IP Address and configure unused registers in
Register field & then click OK. Screen shot for the same as follows:

| LAN1 Configuration X |

Regster Usage
Default Settings Register Get settings from
IP Addess: [ B . 168 . 254 . 128 | Name: | _~| @ [Configuation ~| [ Use CAN ID for last Octet
NetMask: [2655 255 . 255. 0 | Name: | _v| # |Configuiation ~|
Gateway: [ 0 . 0 .0 .0 | Name: [ _v| & [Corfiguation ~|
[
|

Status

Name: | ] v |
Name: x| e

Version:

Protocol Support
Resident Protocols

[ ICMP (Ping)
[] EGD (Ethernet Global Data) Configure Selected Protocol
[] SRTP Slave (90-30 Service Request)
[[] Modbus Slave
[] Ethemet/1P
[[] FTP (File Server)
[] ASCll Over TCP/IP

Downloadable Protocols
ETN1/1 [ None - =l | | |
| Nane =l

ok | Cancel |

Download the configuration in to Controller. Connect LAN cable to the Controller in default LAN Port.
From Cscape go to Tools > Editor Options > Communication Port > Configure. Select Ethernet and enter IP
address which is configured in the file. Select mode as XL Series mode from drop down list.

The controller should get connected to Cscape. If communications are successful, the target indicator should show
the mode of the controller Target: yy(R) as shown in the as shown above in "Cscape Status Bar" on page 58.
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For more details refer to the Cscape Help File.

An overview of configuration:

Cscape Configuration

1. Start the configuration by selecting the Controller > Hardware Configure menu item.
2. Ifthe controller is connected to the PC press the Auto Config System button to automatically detect the Base

model, I/O and any communication options.
3. Ifthe controlleris NOT connected:
a. Select Series > XL Series

b. Select Device Type > XLE/XLEe or XLT/XLTe
c. Select Model # > (See part number building below)

GLOBAL MODEL NUMBERS

screen Ethernet I/o
E (no touchscreen) O (noEthermet) ©O (model 0)
T (touchscreen) E (Ethernet) 2 (model2)
3 (model 3)
4 (model 4)
5 (model5)
6 (model 6)
EUROPEAN MODEL NUMBERS
screen Ethernet CAN option 1/o overlay type
E22 0 (no Ethernet) 0 (noCAN*) 00 (model0) 00 (dark colour)
(no touchscreen) 1 (Ethernet) 1 (CsCAN) 12 (model 2) 01 (llight colour)
T24 2 (CANopen) 13 (model3) 02 (blank)
(touchscreen) 4 (DeviceNet) 14 (model 4) 03-99 (custom)
5 (J1939) 15 (model5)
16 (model 6)

*No CAN is only available on XLE
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General I/0 Configuration

Built-in Digital and Analog I/O Overview
Removing the Back Cover ... .. .
Digital / HSC Input Configuration ... ... .. . .
Digital / PWM Output Configuration
Analog INPULS
Analog Outputs

Built-in Digital and Analog I/O Overview

The Horner OCS is a compact unit that contains high density and very versatile I/O. Using the 1/0 properly requires

wiring to the proper terminals, configuring jumpers inside the Horner OCS unit and configuring Cscape properly.
This section will offer some tips and suggestions to configure the I/O properly. For the register mapping of the I/O,

refer to the "System Register Tables" on page 45 chapter for more details.

Built-in Digital & Analog I/O
Digital Analog
m
pcin| PCOUt|  Relayout | HSCIn*| Pulse Out™ | mANV In RTI?/I':'IC mAN
(+) . Out
(Universal)
Model 2 12 - 6 4 -- 4 - -
Model 3 12 12 4 2 2 - -
Model 4 24 16 - 4 2 2 - -
Model 5 12 12 - 4 2 2 2
Model 6 12 12 - 4 2 - 6 4

*Shared with total DC inputs
**Shared with total DC outputs

For more details, see the controller datasheets via Document Search.
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Removing the Back Cover

WARNING: Power, including I/0 power must be removed from the unit prior to removing the back cover.
Failure to do so could result in electrocution and/or damage to equipment.

Some I/O configurations require jumper settings to be changed inside the Horner OCS unit. Examples of these set-
tings are setting positive or negative logic on digital inputs or setting current or voltage on analog inputs.

Each Horner OCS I/O jumper is set to a factory default. Refer to the datasheet for a specific Horner OCS model to
find the default setting to determine if a jumper change is necessary. Refer to Horner's Documentation Search
page.

To remove the back cover of the Horner OCS, remove the four (4) Phillips screws from the back of the unit. It may
help to place the Horner OCS unit face down on a clean work surface. Once the four screws are removed the back
cover can be lifted straight off.

Once the back is removed the jumper selection can be changed. The jumper settings are documented on each data
sheet using a diagram such as the figure below and a description of the jumper settings.

To re-install the back cover, place the cover back on the unit. The DIN clip should be on the same side as the power
connector.

Place the screw back into the hole and turn the screw slowly counter clockwise until it clicks into the threads. This

prevents the screw from being cross-threaded. Now turn the screw clock-wise until the cover is firmly secured.
Repeat this process for all four (4) screws. Recommended torque is 3 - 4 in-lbs (0.34 — 0.45 Nm).
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Digital / HSC Input Configuration

Horner controllers vary greatly on series and model numbers. Refer to the datasheets on the Document Search
table on the Horner website.

The inputs are designed to support both positive and negative input modes. For many models, the mode is set by a
jumper setting and a configuration parameter in Cscape. The Model 6 does not require jumpers, and only requires a
configuration parameter in Cscape. All the inputs on the unit must be configured to the same mode.

Positive Logic vs. Negative Logic Wiring

The OCS can be wired for positive logic inputs or negative.

ool o

12-24VDC

Paositive Logic In Negative Logic In

In positive logic mode a positive voltage applied to the input will turn the input. The internal design of this mode is
basically a resistor from the input to I1/0 ground. This mode is sometimes called sourcing.

In negative logic mode, connecting the input to the I/O ground or zero volts will turn the input on. The internal design
of this mode is basically a resistor from the input to the positive 1/0 voltage (usually 12 or 24V). This mode is some-

times called sinking.

Some of the digital inputs may support high-speed input functional such as counting or frequency measurement.

Page 69 of 178


https://hornerautomation.com/documentation-search/

I.I HORNER

AUTOMATION GROUP

General I/O Configuration

Digital Input Configuration

Home > Hardware Configuration [select Device Type/Model#] > Local I/O Tab > I/O / Config Button > Mod-
ule Setup > Digital IN/HSC

Select Hardware Configuration from the Home menu and ensure that the correct Device Type and Model# are selec-
ted. Then select the Local I/O tab.

‘| Hardware Configuration X |

1 Controller | Local /0| CANT (CsCAN) 110 | LAN1 10|

Series ‘XL OCS Series ﬂ Description:
Operator Control Station with fixed 11O
Device Type -
Model # [HEXE1E2 ~] Properties
F Display T 64 by 128 LCD
Network Ports piay Type: |
1 K d Type: 20 ke
1 CANT [CsCAN ~| config eypadType: 20 key numeric
Program Memory: |512 K Bytes
ca[ =] og ry: |
Network Type: |CSCAN
LANT [ETN300 Gonfig

\Advanced Ladder Functions

LAN2 Supports Analog Data

Real Time Clock Support
Serial Ports Config

Supports Retentive Data
OCS Wi-Fi Module

Auto Config
0K Cancel ‘ | Help

After selecting Local I/O, select the Config button next to the I/O connector.

Controller Local /0 | CANT (CSCAN) 11O | CANZ (CsCAN) /0 | LANT /0 | LANZ 10 |

XLPlus - CsCAN ,
000

XL IO type 2

Config
Empty n EMPTY M Config

OK ‘ Cancel |

The Module Configuration screen will appear, select the Module Setup tab. See below.
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Module
Model: XLI/Otype 6

/0 Mag | Module Setup |

Description: Please Refer User Manual for register values
[
|
1]

OK | Cancel | Applhy |

The Module Setup allows a user to configure four types of /0. NOTE: Not all controllers offer all four types. Refer to
the controller's datasheet on the using Horner's Documentation Search page.

Module Configuration X
110 Map Module Setup
Digital In/ HSC Digital Qut / PWM
Analog In Analog Out
OK Cancel Apply Help
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Select Digital In/HSC to open the Digital / HSC Input configuration dialog for a specific controller.

Digital / H5C Input Cenfiguration X P
Digital inputs active mode Counter Modes
® ? Counter mode Note: 2 Channel Supports:
@ Positive Logic Note: This setting must - 1) 2-H5C
- . = 4 Counter mode
match that of the jumpers 2)2-Quadrature
" Megative Logic on the product - 3) 2-5tepper Outputs |
C
HSC IO Mapping
Starting Digital In: 210017] Name: | - xp
Starting Analog In: [<Al1005 Name: | =] W wp
Starting Digital Out  [%@Q0017 Name: | - - .y
Starting Analog Out:  [%AGO01 Name: -] " x12
HSC WO Filtering
r I r -
Filter Frequency I 1 3 KHz
TKHz 10MHz
. -~ W
Mumber of Samples | 1 -
1 10
Counter1 | Counter2|
Type: |[)Isabled ﬂ
Inputi Input2
Mode | il =
Disable Function: —— > Polarity:
Latch Function: > Polarity:
Preload Function: » Polarity:
1
Clear Function: > Polarity:
Marker: > Polarity:
Match:
0K | Cancel |

The Active mode group box allows the user to select if inputs are active high (Positive logic) or active low (Negative
logic). It is important that this setting matches the jumper settings on the hardware.

The High-Speed Counters group box contains all the windows that are used to configure the four available high-
speed counters on the Horner OCS. To configure a counter, the user needs to set the type, mode, and counts per

rev.

The type drop down includes the following options:

Disabled

Frequency

Totalize

Pulse

Quadrature

Marker (Only available in counter #3 if counter #1 is set to quadrature.)

The mode drop-down items are set according to the type selection. The Counts Per Rev. window is enabled/dis-
abled according to the type selection as well.
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Digital / PWM Output Configuration
Solid State Digital Outputs

Solid-state digital outputs are generally used to activate lamps, low voltage solenoids, relays, and other low voltage
and low current devices.

NOTE: The digital outputs used on some controllers are sourcing outputs. This means the output applies a positive
voltage to the output pin when turned ON. When turned off, the output applies approximately zero volts with respect
to the 1/0 ground. Use the Documentation Page to view the datasheet for a specific controller for specifics on a mod-
ule's I/0.

10 -30VDC
-~ +
¢

The digital outputs used in the OCS have electronic short circuit protection and current limiting. While these elec-
tronic protections work in most applications, some application may require external fusing on these outputs.

The digital outputs in the OCS are typically controlled via %Q bits in the register mapping. Some of the outputs are
designed for high-speed applications and can be used for PWM or frequency output applications.

When the controller is stopped, the operation of each output is configurable. The outputs can hold the state they
were in before the controller stopped or they can go to a predetermined state. By default, digital outputs turn off.

NOTE: The digital outputs feature an output fault bit. %132 will turn on if any of the outputs experience a short circuit,
over-current or the output driver overheats.

Page 73 0of 178



I.I HORNER

AUTOMATION GROUP ) .
General I/O Configuration

Relay Outputs

Relay outputs are designed to switch loads that typically have high voltage or current requirements or require the
isolation that relays provide. Relay outputs are not available on all controllers, see the datasheet. NOTE: The
design of the OCS does not require external coil power for the relays to function. The relays will activate anytime the
OCS is powered. There are several factors that should be considered when using relays:
¢ Relay Life — Relays are mechanical devices that have a long but limited life. Typically, switching more cur-
rent limits the life of relays. Please check the data sheets at the end of this manual for expected relay life.
¢ Current / Temperature De-Rating — Products containing relays often have total current limits based on the
ambient temperature of the application. Please see the product data sheet for current / temperature de-rating
information for relays.
¢ Fusing — External fusing is generally required to protect the relays, devices and wiring from shorts or over-
loads.

WARNING: To protect the module and associated wiring from load faults, use external (5A) fuse(s) as shown.
Fuses of lower current or fusing for the entire system need to be in place to assure the maximum current rating of
the unit is not exceeded.

WARNING: Connecting high voltage to any I/O pin can cause high voltage to appear at other I/O pins.

Below is an example of Relay Fusing:
230VAC —

230VAC -
OR
25vDCc  +
230VAC  —
OR
25vDCc  +

230VAC —

230VAC  —
OR
25vDC  +
230VAC  —
OR
25vDCc  +

12-24VDC
-+
OV ON J1 — )

Protection for Inductive Loads - Inductive loads can cause reverse currents when they shut off that can shorten
the life of relay contacts. Some protective measures need to be determined by an engineer. Below you will find
recommendations that will work for many applications. If you have additional questions on protection from inductive
load, consult an application engineer or Horner Technical Support. Details on devices that may protect outputs can
be found in the Spark Quencher Datasheet, MAN0962, which is located on the website.

Output State on Controller Stop - When the controller is stopped, the operation of each output is configurable.
The outputs can hold the state they were in before the controller stopped or they can go to a predetermined state.
By default, relay outputs turn off.
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Digital Output Configuration

Home > Hardware Configuration [select Device Type/Model#] > Local I/O Tab > I/O / Config Button > Mod-
ule Setup > Digital Out/PWM

Select Hardware Configuration from the Home menu and ensure that the correct Device Type and Model# are selec-
ted. Then select the Local /0 tab.

| Hardware Configuration i

1 Controller | Local IO | CANT (CSCAN) /0| LAN1 110 |

S [xL ocs series ~] Description:
(Operator Control Station with fixed I/O
Dovce Typo [ ~ |
Model#  |HEXETE2 =l e
Display Type: 64 by 128 LCD
Network Ports - |
Keypad Type: 20 key numeric
CAN1 |CsCAN - Config AT | J
Program Memory: |512 K Bytes
CAN2 = v |
Network Type: |CSCAN
LAN1 [ETN300 Config

Advanced Ladder Functions
LAN2 Supports Analog Data

Real Time Clock Support
Supports Retentive Data
Serial Ports Config

OCS Wi-Fi Module

Auto Config
OK Cancel ‘ ‘ Help

After selecting Local I/O, select the Config button next to the I/O connector.

Controller Locall/0 ICAN1 (CSCAN) /0 | CAN2 (CsCAN) /0 | LANT /0 | LaNZ /0 |

XLPlus - CsCAN ,
O

XL /O type 2

Config
Empty m EMPTY ﬂl Config

oK | Cancel ‘

The Module Configuration screen will appear, select the Module Setup tab. See below.
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Maodule Configuration X
110 Map | Module Setup'
Module
Model: XL I/O type 2
Description: 12DC in, 6 Rly, 4 10-bit Al, 4 HSC
i
Type Starting Ending  Number of I
Register Register Registers i
%l | 1 [[32 [ a2
%Q | 1 [ 24 | 24
%Al | 1 [[12 [ 12
%AQ |[NONE [NONE | 0
b OK | Cancel | Apoly | Help |

v T warust T

The Module Setup allows a user to configure four types of /0. NOTE: Not all controllers offer all four types. Refer to
the controller's datasheet the using Horner's Documentation Search page.

Module Configuration X
110 Map Module Setup
Digital In / HSC Digital Out / PWM
Analog In Analog Out
OK Cancel Apply Help

Select Digital Out/PWM to open the Digital / PWM Output Configuration dialogue.
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al Qz

@ Normal @® Mormnal I
 PAWM#1 P &2

7 HSCT Output (" HSC2 Output

Output O J ‘Oulpu(ON J

(" Stepper (" Stepper

Starting Analog Out: |°/DAQ42] ‘ J <<<<<< %20
Starting Digital In |%HEW7 ‘ J -
Py State on Controller Stop

Py #1 Duty Cycle default ’ui —
P #2 Duty Cycle default ,07 —
P #1 Frequency ,07 —
Pk #2 Frequency. ,07 B
QOutput State on Controller Stop
1 2 3 4 5 [ 7 &
djajajajajajala]

1 i 12

a(3(3]3]

Legend

ﬂ =0FF E = 0N ! =Hold Last State

oK ‘ Cancel ‘

The Q1 and Q2 group boxes allow the user to specify the operation of the multifunction outputs.

PWM State On Controller Stop - Contains items that allow the user to specify how the PWM outputs behave when
the controller is stopped. These items can either hold their value or default to some value when the controller is
stopped.

NOTE: The PWM outputs are set to the OFF state at power-up and during program download and remain in that
state until the unit is placed in RUN.

Output State On Controller Stop - Contains items to allow the user to specify how the remaining digital outputs
behave when the controller is stopped. These items can either hold their value or default to some value when the
controller is stopped. NOTE: The number of Output States on Controller Stop vary by product.

Stop State - When a controller stops running ladder logic, the state of most output I/O modules can be configured.
By default digital outputs turn OFF and analog outputs go to a zero output level. Outputs can be configures to hold
the last state the outputs was in when the controller stopped, or it can be configured to go to a predefined state.
NOTE: When a controller is in DO 1/O mode the outputs are still controlled by the values in the controller's registers.

NOTE: The number of Output State on Controller Stop varies by controller. See the datasheet on the Docu-
mentation Page for more details.
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Analog Inputs

The analog inputs on the OCS allow voltage or current measurement from a variety of devices. The voltage or cur-
rent mode is set though jumpers on the unit and settings in Cscape. Each channel can be separately configured for
voltage or current mode.

The analog inputs have a digital filter that can be used to filter electrical noise that may be unavoidable in some
installations. The downside to digital filtering is the inputs will respond more slowly to sudden changes in the actual
input.

Home > Hardware Configuration [select Device Type/Model#] > Local I/O Tab > I/O / Config Button > Mod-
ule Setup > Analog In

Select Hardware Configuration from the Home menu and ensure that the correct Device Type and Model# are selec-
ted. Then select the Local /0 tab.

| Hardware Configuration bl |
< Controller | Local 0| CANT (CSCAN) 10| LANT 110 |
Series [XL ocs series | Description:
Operator Control Station with fixed 1/0
Device Type (IS ~ |
Model#  [HEXEIE2 [o]] [FErEEE
Display Type: 64 by 128 LCD
Network Ports PR ‘
Keypad Type: 20 key numeric
CANT |CsCAN - Config LI ‘ v
Program Memory: |512 K Bytes
CAN2 = Y ‘
Network Type: ‘CSCAN
LAN1T [ETN300 Config
/Advanced Ladder Functions
LAN2 Supports Analog Data
Real Time Clock Support
Supports Retentive Data
Serial Ports Config
OCS Wi-Fi Module
Auto Config

OK Cancel ‘ ‘ Help

After selecting Local I/O, select the Config button next to the I/O connector.

Page 78 of 178



I.I HORNER

AUTOMATION GROUP ) .
General I/O Configuration

Controller Local /O | CANT (CSCAN) /0 | CAN2 (CSCAN) /0 | LANT O | LAN2 1/0 |

XLPlus - CsCAN )
0 0

XLI/O type 2

Config
Empty m EMPTY ﬂl Config

OK | Cancel

The Module Configuration screen will appear, select the Module Setup tab. See below.

(

I/0 Map Module Setup
|
Digital In/HSC Digital Out / PWM
Analog In Analog Out
OK Cancel Help

The Module Setup allows a user to configure four types of /0. NOTE: Not all controllers offer all four types. Refer to
the controller's datasheet on the Horner website's Documentation Page for more information regarding specific
models.
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Select Analog In to open the Analog Input Configuration dialogue:

Analog Input Configuration ped
Channel 1: Filter Constant:
|Disable R =
Channel 2:
|Disable R
Channel 3:
|Disable |0 =
Channel 4:
|Disable |0 =
Channel 5:
|Disable RA=
Channel b:
|Disabls ~||o =

@ C C°F

(0] I Cancel

The Channel x drop down windows allow the user to specify the mode for each analog input to operate. The Chan-
nel x drop down windows are enabled/disabled according to which model is being configured. All of the models
have the following modes available:

e 0..10V

¢ 0..20mA

e 4.20mA

On the XL series, the Model 5 and Model 6 modules have more channel options.
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Universal Analog Inputs Model 5

The universal analog inputs provide a high resolution, very flexible interface for a variety of analog inputs. These
inputs include voltage, current, theremocouple, RTD, and millivolt. Each channel can be configured separately
using jumpers and configuration settings in Cscape.

Like the standard analog inputs, these inputs have a digital filter that can be used to filter electrical noise that may
be unavoidable in some installations. The downside to digital filtering is the inputs will respond more slowly to sud-
den changes in the actual input.

Analog In for Model 5
Channels 1 & 2

0..10V

0..20mA

4.20mA

100mV

PT100 DIN RTD, 1/20°C

Type J Thermocouple, 1/20°C
Type K Thermocouple, 1/20°C
Type N Thermocouple, 1/20°C
Type T Thermocouple, 1/20°C
Type E Thermocouple, 1/20°C
Type R Thermocouple, 1/20°C
Type S Thermocouple, 1/20°C
Type B Thermocouple, 1/20°C
* The Filter Constant provides filtering to all channels.
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Model 5 Universal Analog Input Configuration

1. Select Analog In to access the Analog Input Configuration menu.
2. Select any of the Analog input types from the drop-downs by clicking the down arrow beneath each cor-

responding Channel, as seen below:

Analog Input Configuration X

Channel 1:

0,10 ~]
0
0.20mA
4.20mA
100mY
FT100 DIN KTD. 1/20 Deg. C

Type J Thermocouple, 1720 Deg. C
Type K Thermocouple, 1/20 Deg. C
Type N Thermocouple, 1/20 Deg. C

Type T Thermocouple. 1/20 Deg. C
Type E Thermocouple, 1720 Deg. C
Type R Thermocouple. 1/20 Deg. ©
Type S Thermocouple, 1/20 Deg. C
Type B Thermocouple, 1/20 Deg C

| =
Channel 6:
l =
Filter Constant
[ o ]| canca |

3. Ensure the proper wiring is used for each of the pins on the Universal Analog Inputs as seen in the image
and table below:

0-10V Analog In mV In Thermocouple In 4 - 20 mA Analog Out
NC 100mV+ H 20mA
' IR - =
+ T i
0-10VDC 100m¥ ] o i ——— |
- i i l
[ | )

20mA Analog In - Not Self Powered  20mA Analog In - Self Powered RTD In 0-10V Analog Out

20mA +_ = 20ma = 4 T T\ 1ovDeC
i R = +
+ i
Loop PWR T HH
(] ()
v—-od]
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Table for Model 5 Universal Wiring

J3 Connector for Universal Wiring

T1+ TC (1+) or RTD (1+) or 100mV (1+)
T1- TC (1-) or RTD (1-) or 100mV (1-)
T2+ TC (2+) or RTD (2+) or 100mV (2+)
T2- TC (2-) or RTD (2-) or 100mV (2-)
AQ1 10V or 20mA OUT (1)
AQ2 10V or 20mA OUT (2)

ov Common
MA1 0-20mA IN (1)

V1 0-10VIN (1)

ov Common
MA2 0-20mA IN (2)

V2 0-10V IN (2)

ov Common
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Universal Analog Inputs Model 6

The Universal Analog Inputs on the Model 6 IO board are unique from other Horner XL-series input/output cards in
that they are configurable through the module configuration instead of having to change jumper settings in order to
setup the input type.

Analog In for Model 6
Channels 1-6

0..10V
0..20mA
4..20mA
Disable
0-60mV
PT100 DIN RTD, 1/10°C
PT1000 DIN RTD, 1/10°C
Type J Thermocouple, 1/10°C
Type K Thermocouple, 1/10°C
Type N Thermocouple, 1/10°C
Type T Thermocouple, 1/10°C
Type E Thermocouple, 1/10°C
Type R Thermocouple, 1/10°C
Type S Thermocouple, 1/10°C
Type B Thermocouple, 1/10°C

Model 6 Universal Analog Input Type Configuration

1. Select Analog In to access the Analog Input Configuration menu.
2. Select any of the Analog input types from the drop-downs by clicking the down arrow beneath each cor-
responding Channel, as seen below:

Analog Input Configuration x|

Channel 1 Filter Constant
10 =l =
0.20mA

4 20mA 0 3
Disable

10-60mY

FT100 DINRTD

PT1000 DINRTD 0 j
Type J Thermocouple

Type K Theimocouple

Type N Thermocouple 0 =1
Type T Thermocouple =2
Type E Themocouple
IType R Thermocoupls

Type S Thermocouple 0 =]
Type B Thermocouple =1
Channel &

Disable ~Ip =

@ c
OK Cancsl |
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3. Ensure the proper wiring is used for each of the 3 pins A, B, and C on the Universal Analog Inputs as seenin
the reference image below:

EX: Universal Input Wiring Schematic
0- 10V Analog In
NC

+
0-10vDC

20mA Analog IN - Not Self-Powered 20mA Analog IN - Self-Powered
0- 10 V Analog Out

20mA o4 - 20mA o -
LOOF'F‘NR"
24vDC ~ —
[ [
[ Ayp———

10vDC
NOTE: Depending on the transmitter, isolated loop power may be required.
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Scaling Analog Inputs & Examples

To access the Advanced Math Scaling function, select Home > View > Project Toolbox. This will open a side bar,
and then select Advanced Math > Scale.

Example 1

The Cscape Scale function, found in the Advanced Math functions, allows for very easy conversion of the raw input

value into a meaningful reading. For example, a pressure transducer may be specified as a 4-20mA signal to signify
a 0-2000 psi pressure reading. With the analog channel set to the 4..20mA range, the raw analog input value, which
is in INT format ranges from 0 to 4mA to 32000 for 20mA. Use the Scale function to obtain an Integer pressure read-
ing using the 0-32000 raw input range and the sensor’s 0-2000psi output range.

ALW_ON peake

% 1| Analog_[nput] o .

: 55007 0~ min
2 %1001 4IN1

320004 max

\ 0min | ps|_Reading
Qr%R00001
20004 maz

Example 2:

If readings with fractions are required, the raw Integer input value must first be translated in REAL, or Floating Point
Format, see note below. . The Cscape INT-to-REAL Conversion function may be used to convert the raw input
value from INT to REAL format in an intermediate memory location. The SCALE function, specified as REAL type,
may be used to scale the converted raw value into a reading that supports digits beyond the decimal place, i.e.

475.25psi.

4
Alw_ON
@~

Int

Real

2 #5007
5

Analog_lnputi
%A1001HIN1

Scale

-%R00003

Analog_lnputl

Analogy.! ﬁﬁlﬁtﬁl %E

"BhaL

03-IN1

32000

2000+

7 ™0 bl Beading. REAL

-%R00005
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Analog Outputs
NOTE: Refer to the datasheet for details on jumper settings.

The analog outputs on Horner OCS devices provide high resolution voltage or current outputs. The voltage or cur-
rent selection is controlled with jumpers and configuration settings in Cscape.

NOTE: Each channel can be separately configured for voltage or current mode.
When the controller is stopped, the operation of each output is configurable. The outputs can hold the
state they were in before the controller stopped or they can go to a predetermined value. By default,

analog outputs are set to a value of zero (0).

The following figure illustrates the Analog Output Configuration dialog. To open the I/O configuration dialogs, select
Controller > Hardware Configuration > Local I/O > Config > Module Setup.

Analog Output Configuration X

Output value on STOP Qutput Mode
AQ9- Goto: |0 [+ Hold Last Value 0..10V -]
AQ10- Goto: |0 Cal /alu 0..20mA

4.20mA
AQ11- Goto: |0 Mt /alu Disable
AQ12- Goto: [0 2 ! Disable -

oK | Cancel |

The Output value on Stop group box contains items that allow the user to specify how the analog output channels

behave when the controller is stopped. The outputs can either hold their value or default to a value when the con-
troller is stopped.

The Output Mode group box allows the user to select the operating modes for each of the analog outputs. The
modes include the following:

e 0..10V

¢ 0.20mA

e 4.20mA

For more information on Stop State, refer to the "Cscape Configuration" on page 57.
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High Speed I/O

High Speed Counter (HSC) Functions ... ... .. . . 89
FreOUENCY 89
Totalize ... 90
PUISE 91
Period Measurement ... ... 91
QUAIAtUIE .. 92
HSC Register Map for XLE & XL .. 94
Pulse Width Modulation (PWM) Functions ... ... . 95
HS C OU UL . 99

Overview XLE & XLT

In addition to the compliment of simple analog and digital I/0, several of the XLE/XLT I/0O modules support High
Speed Counting (HSC) I/O functions and may also support Pulse Width Modulation (PWM) Output functions.

The HSC functions include frequency, totalizing, pulse width, and quadrature measurement. The PWM functions
include traditional PWM (with variable rate and duty) and a stepper (limited functionality) with variable acceleration
and deceleration rates.

High Speed Counter (HSC) Functions

On units that support the HSC, four dedicated inputs are available than can be configured for one of four modes of
operation. Those modes are Frequency, Count (totalize), Pulse width and Quadrature measurement. For some
modes, more than one HSC input may be consumed. The measurement value is provided to ladder in a %Al
register. Refer to the "HSC Register Map for XLE & XLT " on page 94.

NOTE: While the high-speed input circuitry has a resolution of 1 ys, measured edge transitions must not occur
faster than 100 ps for accurate measurements. Keep in mind that pulse width measurements utilize both the rising
and falling edges of the waveform, thus the pulse width must exist longer than 100 ps.

NOTE: The edge polarity selection in the mode parameter for the totalize and pulse width functions (Digital/HSC
Input Configuration) assume Positive Logic regardless of the associated I/O board’s jumper setting for the Digital
DC inputs polarity. If Negative logic is configured when using these functions, the opposite edge polarity must be
selected in the mode parameter.

Frequency

In frequency mode, the frequency of the input signal is written to the accumulator in terms of Hertz (cycles/second).
When using frequency mode, four update selections are provided which specify the width of the sample window.
NOTE: Selecting a shorter sample window provides a quicker measurement (faster response) but lowers the fre-
quency accuracy (resolution) and increases the minimum frequency measurement limit.
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Totalize

In totalize mode, the accumulator is simply incremented each time the input transitions in a specific direction. Total-
ize mode is configurable to specify the edge (rising or falling) on which the accumulator is incremented.

Y

Rising Edge Signal Falling Edge Signal

Three different options are available to reset the current count:

¢ Configured reset value - When configuring the Totalize function, a value may be specified under the
Counts per Rev column. When the totalizer accumulator reaches this value - 1, the accumulator will reset to
zero on the next count. Specifying zero for this value allows the totalizer to count through the full 32-bit range
before resetting.

¢ Ladder control - Setting registers %Q17-20 reset HSC1-4 (respectively) with no additional configuration.
When these registers are asserted, the associated totalizer accumulator is reset and held at zero (level sens-
itive).

* Direct digital input control (HSC1 and HSC2 only) - HSC3 (%I11) and HSC4 (%112) may be configured
as hardware digital reset signals for HSC1 and HSC2 (respectively). To enable these inputs as reset signals,
specify the type as Totalize Reset (NOTE: The corresponding Totalize HSC must be previously configured
before this option is available). The direct digital reset controls are edge sensitive with the edge polarity con-
figurable.

Maximum direct digital reset latency is 100pus.

The totalize function also supports an option which compares the current accumulator value with a supplied Preset
Value (PV), which is provided through a %AQ, and drives a physical digital output based on the that comparison.

¢ This option (available for HSC1 and HSC2 only) drives Q1 or Q2 output point (respectively) once the asso-
ciated totalizer accumulator reaches (or exceeds) the PV value. To enable this function, the corresponding
PWM function output (Q1 or Q2) must be configured for HSCx Output.

NOTE: Q1 and Q2 are PWM function outputs that may be configured independently as one of the following: stand-
ard digital output, PWM, HSCx or stepper output.

Preset values may be modified during run-time. A preset value of zero disables (resets) the totalizer compares func-
tion output causing the output to remain low.
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Pulse

In pulse mode, the high-speed input can measure the width or period of a pulse stream in one of four modes and
provides a continuous indication of the last sampled value.

Width High 1us Counts — In this sub-mode the accumulator value will contain the number of 1us counts the pulse is
high.

—— width High

Width Low 1us Counts - In this sub-mode the accumulator value will contain the number of 1us counts the pulse is
low.

———1 width Low

Period Measurement

In period measurement mode, the high-speed input can measure the period of a pulse stream in one of two modes
and provides a continuous indication of the last sampled value. In this mode the Disable and Latch special functions
are allowed.

Period Rising Edges 1us Counts — In this sub-mode the period of the input signal is reported in one (1) ps units. The
period measurement will start on the rising edge of the input.

‘ Period from Rising Edge

Period Falling Edges 1us Counts — In this sub-mode the period of the input signal is reported in one (1) us units. The
period measurement will start on the falling edge of the input.

e

! Period from Falling Edge
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Quadrature

Two HSC inputs are consumed for each of the two possible Quadrature counters. For example, selecting quad-
rature mode for HSC 1 will use HSC inputs 1 and 2, which correspond to A and B quadrature signals. Therefore,
HSC 1 and 3 may be configured for quadrature input. Alternately, HSC 3 may be configured to reset HSC1 (quad-
rature) count on a marker input

Quadrature mode works much like the totalizer except the accumulator will automatically increment or decrement
based on the rotation phase of the two inputs. See the following example for more details. Quadrature inputs are typ-
ically used for reporting the value of an encoder.

Two modes are available for quadrature that select whether the accumulator counts up or down when the phase of
input 1 leads input 2. Check your encoder’s documentation to determine the output form it uses or try both modes to
determine if the encoder counts up when expected.

PP

J 1 (leading)
‘ L 2 (lagging)

0=
phase
shift

Using the above waveforms and a HSC input configuration of “Quadrature” - “1 leads 2, count up,” the accumulator
will count up when 1 is rising and 2 is low, 1 is high and 2 is rising, 1 is falling and 2 is high, and when 1 is low and 2
is falling. This results in 4 counts per revolution. So in order to determine the number of cycles, the accumulator
would have to be divided by 4.

Three different options are available to reset (or set) the current count:

¢ Configured Counts per Rev Value - When configuring the quadrature function, a value may be specified
under the Counts per Rev column. When rotation produces an increasing count, the quadrature accumulator
resets to zero on reaching the Counts per Rev count. Alternately, when rotation produces a decreasing
count, the quadrature accumulator is set to Counts per Rev — 1 on the count following zero. Specifying zero
for this value allows the totalizer to count through the full 32-bit range before resetting. For example, if your
encoder outputs 1024 counts per revolution, the value of 1024 can be entered into the configuration for
Counts per rev. This will result in a counter that produces counts in the range of 0 to 1023.

¢ Ladder Control - Setting registers %Q17 or Q19 resets quadrature (HSC) 1 or quadrature (HSC) 3 (respect-
ively) with no additional configuration. Setting registers %Q18 or Q20 sets quadrature (HSC) 1 or quadrature
(HSC) 3 (respectively) to Counts per Rev — 1.

¢ Direct Digital Input Control (HSC3) [Marker] - When HSC input 1 and 2 are used for quadrature inputs, an
additional choice of marker input becomes available for HSC input 3. The marker input is typically part of an
encoder or motion system that signals when a cycle of motion is complete. When the marker input is
triggered, the accumulator is reset to zero or to Counts per rev - 1 based on rotation direction. Marker reset
operation is enabled when HSC3 is configured for Marker type. Once selected, one of several modes is avail-
able for marker operation. These modes can be sub-divided into two groups of marker operation.
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Asynchronous modes ignore the quadrature inputs and reset the quadrature accumulator to zero on the con-
figured edge (rising, falling or both). These are the most common settings used. When configuring, asynchronous
mode selections are prefixed with the word Async.

Synchronous modes synchronize the reset (or set) to the selected quadrature input and the selected marker
polarity. Figure 11.1 below indicates which mode to select based on the markers timing diagram. Consult the doc-
umentation provided with your encoder to determine the marker pulse timing.

NOTE: The Marker input is sampled within 50us of the associated quadrature edge. ltis left to the user to determine
if this meets the time constraints of the measured drive.

NOTE: If the Marker input pulse consecutively spans more than one of the specified edges, quadrature-decoding
operation is unpredictable.

Sync mode selection Waveforms (Clockwise Rotation —)

(1]

(2]

High, Reset on 2 rising [SYNC]

High, Reset on 1falling [SYNC]

High, Reset on 2 falling [SYNC]

High, Reset on 1rising [SYNC]\

*While not displayed in this figure, modes for low level (inverse logic) are also supported for each state.

The accumulator is reset to zero on the specified edge if rotation is clockwise (as shown in figure above). However,
if rotation is reversed, the accumulator is alternately set to Counts per rev — 1 on that same physical edge. When dir-

ection is reversed, that same physical edge is seen (by the internal decoder) as having the opposite edge polarity
as shown below.

Page 93 of 178



I.I HORNER

AUTOMATION GROUP High Speed I/O

Sync Pulse Mode Table

Definition: CPR most commonly stands for Counts per Revolution, and refers to the number of quadrature
decoded states that exist between the two outputs A and B. With both outputs A and B switching between high and
low, there exists 2 bits of information represented as 4 distinct states.

Sync Pulse Mode Table

Mode Direction A (HSC1) | B (HSC2) | Marker (HSC3) Reset Value
Async, Reset on rising edge Rising 0
Async, Reset on falling edge Falling 0
Async, Reset on both edge Both 0
High, Reset on 1 rising Clockwise Rising High 0
“ Counter Falling High CPR-1
Low, Reset on 1 rising Clockwise Rising Low 0
“ Counter Falling Low CPR-1
High, Reset on 1 falling Clockwise Rising High CPR-1
“ Counter Falling High 0
Low, Reset on 1 falling Clockwise Rising Low CPR-1
“ Counter Falling Low 0
High, Reset on 2 rising Clockwise Rising High 0
“ Counter Falling High CPR-1
Low, Reset on 2 rising Clockwise Rising Low 0
“ Counter Falling Low CPR-1
High, Reset on 2 falling Clockwise Rising High CPR-1
“ Counter Falling High 0
Low, Reset on 2 falling Clockwise Rising Low CPR-1
“ Counter Falling Low 0
HSC Register Map for XLE & XLT
HSC Register Map
Register Frequency | Totalize Pulse Quad
%AIl5-6 HSC1 (function) Accumulator Quad 1 Acc
%AIT7-8 HSC2 (function) Accumulator
%AI9-10 HSC3 (function) Accumulator Quad 2 Acc
%AI11-12 HSC4 (function) Accumulator
%AQ1-2 HSC1 Preset
%AQ3-4 HSC2 Preset
%Q17 Clear HSC1 Clear Quad 1
%Q18 Clear HSC2 Set Quad 1
%Q19 Clear HSC3 Clear Quad 2
%Q20 Clear HSC4 Set Quad 2
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Pulse Width Modulation (PWM) Functions

On units that support the PWM, two dedicated outputs are available that can be configured for one of four modes of
operation. Those modes are Normal, PWM, HSC (count = PV) and Stepper.

Normal - When either Q1 or Q2 is configured for Normal operation, the digital output registers %Q1 and %Q2
drives that respective output.

Pulse Width Modulation (PWM) Functions - When either Q1 or Q2 is configured for PWM, the PWM function
drives that respective output. Both PWM channels may be individually enabled; however, when both PWM outputs
are enabled, both share the same output frequency (with the low going pulses synchronized). Otherwise, each
PWM'’s pulse width can be independently adjusted.

The PWMs require three parameters (%AQs) to be set for operation. These parameters may be set at run-time. The
register set and prescale calculation differ depending upon the XLE/XLT hardware being used, hardware revs A-R
use the following resisters and scaling:

Prescale Count (Revision A-R) for Gen 1 - The prescale (%AQ5-6) count sets the resolution of the internal
counter used for generating the PWM output. The (prescale count + 1) is a divisor applied to a 16MHz clock that
drives the internal PWM counter. For the highest resolution PWM output, this value should be set as low as possible
(0 provides a 1/16 micro second resolution). Both the Period and Duty cycle (pulse width) are based on counts of
the internal PWM counter.

The frequency of the PWM output is calculated using the following formula:

16,000,000
Frequency = (Pr escaleCount+1 J<PeriodCount

Pre-scale Count Revision T and onwards for Gen 2 - The pre-scale %AQ5 (PWM1) or %AQ6 (PWM2) count
sets the resolution of the internal counter used for generating the PWM output. The (pre-scale count + 1) is a divisor
applied to a 32MHz clock that drives the internal PWM counter. For the highest resolution PWM output, this value
should be set as low as possible (0 provides a 1/32 micro second resolution). Both the Period and Duty cycle (pulse
width) are based on counts of the internal PWM counter.

The frequency of the PWM output is calculated using the following formula:

32,000,000
Frequency = (Prescale+1)x PeriodCount

On units that support the PWM, two dedicated outputs are available that can be configured for one of four modes of
operation. Those modes are Normal, PWM, HSC (count = PV) and Stepper.
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PWM Functions Register Map

PWM Functions Register Map

Register PWM HSC Stepper
%AQ1 . HSC1 Start Frequency
%AQ2 PWM1 Duty Cycle (32-bit) Preset Value Run Frequency
%AQ3 . HSC2 Accel Count
%AQA PWM2 Duty Cycle (32-bit) Preset Value (32-bit)
%AQ5 PWM Prescale Run Count
%AQ6 (32-bit) (32-bit)
%AQ7 PWM Period Decel Count
%AQ8 (32-bit) (32-bit)
%Q1 Run
%130 Ready/Done
%131 Error

When either Q1 or Q2 is configured for HSC operation, HSC1 or HSC2 totalize functions are extended to allow
respective direct output control based on a comparison of the current count and a preset value (PV). See totalize in

the HSC section above for more information.

PWM Examples - All of the PWM examples use the following formula.

32,000,000
Frequency = (Prescale+1 )x PeriodCount

Example 1

To geta 50% Duty Cycle @ 10 kHz waveform on PWM1:
Set %AQ1 =50 (duty cycle count)

Set %AQS5 = 30 (prescale count)

Set %AQ7 =100 (period count)

Example 2

To geta 50% Duty Cycle on PW1 and 90 % Duty Cycle on PWM2 @ 1 kHz waveform:

Set %AQ1 =500 (duty cycle count)
Set %AQ3 =900 (duty cycle count)
Set %AQ5-6 = 30 (prescale count)
Set %AQ7-8 = 1000 (period count)

Example 3

To turn PWM 1 output ON all the time

Set %AQ1-2 = Same value as AQ7-8 (duty cycle count)
Set %AQ5-6 = Any value (prescale count)

Set %AQ7-8 = Non-Zero value (period count)

Example 4

To turn PWM 1 output OFF all the time

Set %AQ1-2 = 0 (duty cycle count)

Set %AQ5-6 = Any value (prescale count)

Set %AQ7-8 = Any value <or> 0 (period count)
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Period Count

This value (%AQ7-8) sets the period of the output signal by specifying the number of internal PWM counter counts
before the cycle is reset (larger count results in a smaller frequency). The duration of each count is determined by
the pre-scaler value. This parameter affects the Period of both PWM outputs.

See the previous formula to see how the pre-scale and period counts create an output frequency. For example, set-
ting the PWM for 1us resolution (pre-scale=15), and a period count of 20,000 would result in a 50Hz output.

Period

Duty Cycle Count

This value (PWM1: %AQ1-2, PWM2: %AQ3-4) sets the width of the output signal by specifying the number of
internal PWM counter counts that the output is maintained high. The duration of each count is determined by the
pre-scaler value. Each PWM channel has its own duty cycle count parameter.

Setting the period count to 1000 and the duty cycle count to 500 results in a duty cycle of 50 percent. Changing just
the duty cycle count to a value of 250 results in a duty cycle of 25%.

—

Duty Cycle

At controller power-up or during a download, the PWM output is maintained at zero until both the Period (count) and
the Duty cycle (count) are loaded with non-zero values. When the controller is placed in stop mode, the state of the
PWM outputs is dependent on the PWM State on Controller Stop configuration. This configuration allows for either
hold-last-state or specific prescale, period and duty cycle counts. Specifying zero for either the period or duty
causes the PWM output to remain low during stop mode.

NOTE: The nominal output driver turn-on-time delay (to reach 50% output) is 25us on Models 3-5. Therefore, this

limitation should be considered when determining both the minimum pulse width and the duty cycle accuracy of the
application.
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The following table shows the PWM registers used for the old and new revisions:

PWM Old and New Registers

PWM Old Registers

PWM New Registers

AQ1—-PWM1 Duty Cycle(DWord)

AQ1-PWM1 Duty Cycle

AQ2 — Reserved

AQ3 - PWM2 Duty Cycle(DWord)

AQ3 - PWM2 Duty Cycle

AQ4 — Reserved

AQ5 — Pre-Scale(DWord)

AQ5 - PWM1 Pre-Scale

AQ6 — PWM2 Pre-Scale

AQ7 — Period(DWord)

AQ7 — PWM1 Period

AQ8 — PWM2 Period

1. When an old XLE/XLT file is auto configured to a new XLE/XLEe or XLT/XLTe file, then the old formula and
registers are taken and firmware will do the required adjustments for the PWM to function normally.
2. When a new XLE/XLT file is created, then the new formula will be applied and the configuration must be as

per the new register set.

PWM Wave Output Form

24 Volts

/Cmmru

%

800\
—_—

/

PWM OFF :

: 20%
Rise : Fall
Time Time
5 ST PWM PEHOT <+ veerremrmemninnnnnianens -

PWM Output Waveform Table

Rise Time

150ns Max

Fall Time

150ns Max

PWM Period

Frequency =1/ Period
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When using I/0 models equipped with solid-state outputs, the first two outputs may be used in conjunction with the
first two High-Speed Counter inputs when those inputs are set to ‘Totalize’. When the HSC accumulator matches or
exceeds the preset value, these configuration options allow the output to turn ON, turn OFF, toggle, or pulse for a

configurable amount of time.

The HSC Outputs function by comparing an HSC Input accumulator to its configured Preset value. With the Output
Pulse option, a Pulse Time value is configured to determine the ON time. The location of these values may be found

in the HSC function register map.

" Mormal
" PwM 1

High Speed I/O

,Qz

I Extended PWM Mode
¢ Normal

" PwM #2

* HSC1 Output

" HSC2 Output

[Dutout ON

R

Output OFF
Output Toggle
Output Pulse

N

v

IDulput 0N ;I

¢ Output ON: Starts with LOW. When the HSC accumulator becomes greater than or equal to the Preset

— FWwM State on Controller Stop-
Eudhd #1 Db Cuela Aafaolk - M uaad

value, the output will turn ON. Otherwise, it is turned OFF.

¢ Output OFF: Starts with HIGH. When the HSC accumulator becomes greater than or equal to the Preset

value, the output will turn OFF. Otherwise, it is turned ON.

¢ Output Toggle: When the HSC accumulator becomes equal to the Preset value, the output will toggle,

either from OFF to ON, or from ON to OFF.

¢ Output Pulse: When the HSC accumulator becomes equal to the Preset value, the output will turn ON and
remain ON until the configured pulse time expires, then turn OFF. If another match occurs during the count-
down to turn the output off, the pulse countdown restarts and the output remains ON until the countdown is

complete.

NOTE: The output pulse time resolution is 50.

NOTE: The state of outputs %Q1 and %Q2 are not reflected in their respective registers when selected for oper-

ation other than ‘Normal’.
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The Accumulator

When the counter accumulator matches the match value stored in %AQ registers, the HSC output will be enabled.
The firmware will then wait based on the configurable microsecond pulse width. After the elapsed time, the output
will be turned off.

If another match happens while the countdown to turn off the output, then the pulse countdown will restart but the
output will not change state until the countdown happens.

When HSC1 accumulator value is equal to AQ1-2 UDINT value, then the Output Q1 becomes high for AQ27-28
UDINT value microseconds.

NOTE: Resolution for the pulse width will be limited to 50 microseconds on the XLE/XLT hardware.

NOTE:
a. Match value is stored in register AQ3-4 UDINT for HSC2.
b. AQ29-30 UDINT is Pulse width value for HSC2

Example 1:
Turn HSC1 Output ON if HSC accumulator 1 exceeds a count of 100,000.

Assuming HSC #1 is already configured to ‘Totalize’:
¢ Select ‘HSC1 Output’ and the ‘Output ON’ option
Load UDIINT value of 100,000 into %AQ1-2 HSC1 Preset value
Download the program and input pulses to HSC #1
Observe UDINT %Al5-6 HSC1 Accumulator value for the accumulated count.
When %AIl5-6 HSC1 Accumulator reaches and exceeds the Preset value, the output Q1 will turn ON.
The output Q1 will remain on until HSC1 is cleared with the %Q17 bit.

Example 2:
Pulse the Q2 Output for 100 milliseconds when HSC accumulator 2 matches the value of 50,000.

Assuming HSC #2 is already configured to ‘Totalize’:

Select ‘HSC2 Output’ and the ‘Output Pulse’ option

Load UDINT value of 50,000 into %AQ3-4 HSC2 Preset value

Load UDINT value of 100,000 into %AQ27-28 Pulse Time

Download the program and input pulses to HSC #2

When %AIl7-8 HSC2 Accumulator becomes equal to 50,000, the output Q2 will turn ON for 100 milliseconds
and then turn OFF.
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Most controllers support two stepper functions, one on each high-speed output when in two counter mode. In four
counter mode, the controllers support one stepper function.

Step Function - A signal that has a zero (0) value before a certain instant of time and a constant nonzero value
immediate after that instant.

_

The Stepper requires five parameters (%AQ) to be set for operation. These parameters may be set at run-time but
are ‘latched’ when the stepper is commanded to start:

Stepper Parameters

Start Frequency
(cycles per second)

This value (%AQ1) sets the frequency for the first cycle during the acceleration phase
and the frequency of the last cycle during the deceleration phase. When an acceleration
or deceleration count is specified, the Start Frequency must be greater than zero (0) and
must not exceed the run frequency or an error is generated.

NOTE: For XLE/XLEe and XLT/XLTe controllers, the Start Frequency should be a min-
imum of 20Hz or more.

Run Frequency
(cycles per second)

This value (%AQ2) sets the frequency for the last cycle during the acceleration phase,
the consistent frequency during the run phase, and the frequency of the first cycle during
the deceleration mode. The Run Frequency must be greater than zero (0) and must not
exceed 5000 cycles/sec. or an error is generated.

Acceleration Count

This value (%AQ3-4) sets the number of cycles to occur within the acceleration phase.
The frequency of the cycles within this mode will vary linearly between the specified

Start and Run frequency. The Accel count must not equal 1 or an error is generated. Set-
ting this value to zero (0) disables this phase.

NOTE: For XLE/XLEe and XLT/XLTe controllers, Acceleration Count should be more
than 300.

Run Count

This value (%AQ5-6) sets the number of cycles to occur within the run phase. The fre-
quency of the cycles within this mode is constant at the specified Run frequency. The
Run count may be any value. Setting this value to zero disables this phase.

Deceleration Count

This value (%AQ7-8) sets the number of cycles to occur within the deceleration phase.
The frequency of the cycles within this phase will vary linearly between the specified

Run and Stop frequency. The Decel count must not equal 1 or an error is generated. Set
ting this value to zero disables this phase.

NOTE: For XLE/XLEe and XLT/XLTe controllers, Deceleration Count should be more
than 300.
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The stepper provides two Boolean registers to provide stepper status:

Boolean Registers

Ready/Done

A high indication on this register indicates the stepper sequence can be started (i.e. not
currently busy) and also when the move is completed.

Error

A high indication on this register indicates that one of the analog parameters specified
above is invalid or the stepper action was aborted before the operation was complete.
This register is cleared on the next start command if the error was corrected.

The stepper requires one discrete register to control the stepper action. Setting this register starts the stepper cycle.
This register must remain set to complete the entire cycle. Clearing this register before the cycle is complete aborts
the step sequence and sets the error bit.

NOTE: Setting the PLC mode to stop while the stepper is in operation causes the stepper output to immediately
drop to zero and the current stepper count to be lost.

NOTE: The stepper output level may cause damage or be incompatible with some motor drive inputs. Consult drive
documentation to determine if output level and type is compatible.
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STP Examples
Example 1
Start S Accel Count Run Count Decel Count
Frequency Frequency
[ AR = 0, -8 = 0, - =
10,000,000 steps| Set %AQ421-2 = | Set %AQ422-4 = Set%AQI23-6 =) Set 1%AQ425-8 =) Set %AQ127-30
control sequence| 2500 (Hz) 5000 (Hz) 1290900 o Stops)
q (Steps) (Steps) (Steps)

When the start bit is energized, the example starts at 2.5kHz and ramps up to 5kHz during the first 1,000,000
steps. Then, it runs at 5kHz for the next 8,000,000 steps. Finally, during the last 1,000,000 steps it slows to a stop.

Example 2
Start R Accel Count Run Count Decel Count
Frequency Frequency
o R = [ -8 = 0, - =
5,000,000 steps | Set %AQ421-2 = | Set %AQ422-4 = Set %AQ423-6= | Set %AQ425-8= | Set %AQ427-30
control sequence | 500 (Hz) 1000 (Hz) 2,000,000 o Ston)
q (Steps) (Steps) (Steps)

When the start bit is energized, the example starts at 0.5 kHz and ramps up to 1 kHz during the first 2,000,000
steps. Then, it runs at 1 kHz for the next 2,000,000 steps. Finally, during the last 1,000,000 steps it slows to a stop.

Example 3
Start . Accel Count Run Count Decel Count
Frequency Frequency
o, -8 = 0, -
6,000,000 steps | Set %AQ421-2 = | Set %AQ422-4 = | Set %AQ423-6 = Set %AQ425-8 ?et 16AQ427-30
control sequence | 50 (Hz) 250 (Hz) 150,000 (Steps) o500000 Sreom
q ’ PS) | (Steps) (Steps)

stop.

When the start bit is energized, the following example starts at 50Hz and ramps up to 250Hz during the first
150,000 steps. Then, it runs at 250Hz for the next 5,500,000 steps. During the last 350,000 steps it slows to a

NOTE: Prior to the start of a move, the Ready/Done bit for that channel must be ON (%11617 or %11619 for channel
1 and 2 respectfully). The Ready/Done bit will turn OFF during the move, and then back ON once the move is com-

pleted.

NOTE: The pulse generation hardware on the OCS can generate any frequency that can be evenly divided into
10MHz (10,000,000Hz) under the maximum recommended frequencies for each model. This results in a very
smooth operation at lower frequencies, with a progressively choppier operation at higher frequencies, as the units
reach their maximum recommended frequency.

NOTE: The highest usable frequency is 65kHz for the PWM output. This is only achievable on a Model 6 unit,

Models 2-5 max output frequency is approximately 10kHz.
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Serial Communications

POt DS I Pt ONS 105
Serial Port WiriNg .o 106
DI SWI OIS . 107
RS-485 TerminatioN ... 108
RS-48S BlasSing ... .o 108
Cscape Programming via Serial Port ... ... 108
Ladder-Controlled Serial Communication ... .. 108

All XLE/XLT models provide two serial ports, which are implemented with 8-pin modular RJ45 connectors and are
labeled MJ1 and MJ2. The MJ1 serial port is normally used for XLE/XLT programming by connecting it to the COM
port of a PC running Cscape. In addition, both MJ1 and MJ2 can be used for application-specific communication,
using a variety of standard data exchange protocols.

Port Descriptions

The MJ1 serial port contains both a half-duplex RS-485 interface and an RS-232 interface with RTS/CTS hand-
shaking.

NOTE: MJ1 shares its serial port with the optional COM module, so when an optional Modem COM or other module
is installed and active, the MJ1 connector is inactive.

The MJ2 serial port contains both a full-duplex RS-485 interface and an RS-232 interface with no handshaking.

Both the MJ1 and MJ2 RS-485 interfaces provide switchable termination and bias resistors internally. Also, both
MJ1 and MJ2 can be set as the serial programming port.
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RS-232 with full handshaking or RS-485 half-duplex
RS-485 termination via switches; biasing via software

MJ1 Wiring

-

[+

MJ1 Pins
PIN SIGNAL DIRECTION
8 TXD ouT
7 RXD IN
6 ov GROUND
5 | +5V @ 60mA ouT
4 RTS ouT
3 CTS IN
2 RX-/TX- IN/OUT
1 RX+/TX+ IN/OUT
MJ2 Wiring

Serial Communications

RS-232 or RS-485 half or full-duplex, software selectable

RS-485 termination via switches; biasing via software

MJ2 Pins
PIN SIGNAL DIRECTION
8 232 TXD ouT
7 232 RXD IN
6 ov GROUND
5 +5V @ 60mA ouT
4 485 TX- ouT
3 485 TX+ IN
2 | 485RX-o0r RX/TX-| INorIN/OUT
1 | 485 RX+or RX/TX+| INor IN/OUT

NOTE: Attach optional ferrite core with a minimum of two turns of serial cable.
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Dip Switches

BEE

B

DIP Switches
PIN NAME FUNCTION DEFAULT
MJ1 RS-485 Termination| ON = Terminated OFF
MJ2 RS-485 Termination| ON = Terminated OFF
Bootload Always Off OFF

WIN|—~

The DIP switches are used to provide a built-in termination to both the MJ1 port and MJ2 port if needed. The ter-
mination for these ports should only be used if this device is located at either end of the multidrop/daisy- chained
RS-485 network.

Page 107 of 178



I.I HORNER

AUTOMATION GROUP . N
Serial Communications

RS-485 Termination

Proper RS-485 termination minimizes reflections and improves reliability.

Both serial ports allow an internal 121Q RS-485 termination resistor to be placed across pins 1 and 2. This can be
done by installing a jumper / switching the dip switch.

NOTE: Only the two devices physically located at the endpoints of the RS-485 network should be terminated.

RS-485 Biasing

RS-485 biasing passively asserts a line-idle state when no device is actively transmitting, which is useful for multi-
drop RS-485 networking.

Both serial ports allow internal 390 Q RS-485 bias resistors to be switched in, pulling pin 1 up to 3.3V and pin 2
down to ground. The Set Serial Ports item in the System Menu chapter can be used to enable RS-485 biasing. Also,
an application graphics screen that writes to %SR164 can do the same thing. Setting %SR164.1 enables MJ1 bias-
ing and setting %SR164.2 enables MJ2 biasing.

If biasing is used, it should be enabled in only one of the devices attached to the RS-485 network.

Cscape Programming via Serial Port

If a PC COM port is connected to the XLE/XLT MJ1 serial port, Cscape can access the XLE/XLT for programming
and monitoring.

Ladder-Controlled Serial Communication

Using Serial Communication function blocks, both MJ1 and MJ2 support Generic, Modbus Master and Modbus
Slave Protocols. In addition, external modems can be connected and accessed using Init, Dial, and Answer Modem
function blocks.

Itis possible to load the program and monitor data via the USB 2.0 slave port on XLE/XLT Rev T and later. To load
via USB, configure the communications port in Cscape as follows, the unit must be connected via the USB mini-
USB port to the PC or laptop:

1. Select Tools from the Toolbar

2. Select Applications Settings > Communications.

3. Select the USB button.

Itis possible to download/upload and use the data monitoring functions once connected.

NOTE: It is advisable to use an isolated USB cable between the PC/laptop and the XLE/XLT when third party
devices are connected to the XLE/XLT to avoid damaging ground loops to the PC/laptop and/or the XLE/XLT.

Page 108 of 178



II HORNER

AUTOMATION GROUP

CAN
Communications




I.I HORNER

AUTOMATION GROUP C
CAN Communications

CAN Communications

Some XLE/XLT models provide a CAN networking port, which is implemented with a 5-pin connector, labeled
CAN1.

The CAN1 port allows the XLE/XLT OCS to exchange global data with other OCS/RCS controllers and to access
remote Network I/0 devices (SmartStix, SmartBlocks and SmartRail Modules). The CAN1 port also supports pass-
through communications for programming multiple OCS controllers over the CsCAN network. The port also allows
the XLE/XLT to exchange global data with other OCS controllers and to access remote Network |/O devices.

The XLE/XLT CAN 1 port implements the ISO 11898-2 physical layer and the CAN 2.0A data link layer standards.
Also, since the CAN 1 port is powered by an internal isolated power supply, external CAN power is not required.

CAN Connector

Use the CAN Connector when using CsCAN network.

¢ Solid/Stranded Wire: 12-24 awg (2.5-0.2mm).
Strip Length: 0.28” (7mm).
Locking spring-clamp, two-terminators per conductor.
Torque, Terminal Hold-Down Screws: 4.5 -7 in-lbs (0.50 — 0.78 N-m).
V+ pin is not internally connected, the SHLD pin is connected to Earth
ground via a 1MQ resistor and 10 nF capacitor

@‘%‘@@x

CAN Pin Assignments
PIN | SIGNAL DESCRIPTION
V- CAN Ground — Black
CN_L CAN Data Low — Blue

SHLD Shield Ground — None
CN_H | CAN Data High — White

(]| W|IN|l-

V+ (NC) No Connect — Red

Solid/Stranded Wire: 12-24 awg (2.5-0.2mm).

Strip Length: 0.28” (7mm).

Locking spring-clamp, two-terminators per conductor.

Torque, Terminal Hold-Down Screws: 4.5 —7 in-Ibs (0.50 — 0.78 N-m).

V+ pin is not internally connected, the SHLD pin is connected to Earth ground via a 1MQ resistor and 10 nF capa-
citor.
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CAN Termination

Termination: 121Q, 1%, 1/4watt or greater wattage is recommended. 120 ohm, 5%, 1/4 Watt or greater wattage
may be used in most cases. Two termination resistors total should be used between CN_H and CN_L, one at each
physical end of the network.

Cscape Programming via CAN

The CAN 1 port supports CsCAN Programming Protocol. If a PC has a CAN interface installed (via USB), and the
PC CAN port is connected to the XLE/XLT CAN 1 port, Cscape can access the XLE/XLT for programming and mon-
itoring.

In addition, the XLE/XLT supports single-point-programming of all XLE/XLT and other OCS devices that are con-
nected to a CAN network. If the PC COM port is connected to the XLE/XLT programming port the XLE/XLT can act
as a pass-through gateway allowing Cscape to access all XLE/XLT and OCS devices that are attached to the CAN
network. Refer to " Serial Communications" on page 105 for more details.

Ladder-Controlled CAN Communication - Using Put and Get Network Words function blocks, the CAN 1 port
can exchange digital and analog global data with other XLE/XLT or OCS/RCS devices (nodes) attached to the CAN
network.

In addition, Put and Get Network Heartbeat function blocks allow nodes on the CAN network to regularly announce
their presence and to detect the presence (or absence) of other nodes on the network.

Using CAN for I/O Expansion (Network 1/0)
Connecting Network I/O devices (SmartStix Modules) to the XLE/XLT CAN 1 port, allows the XLE/XLT 1/O to be eco-
nomically expanded and distributed. A variety of XLE/XLT remote I/O modules are available for this purpose.

Page 111 0f 178



II HORNER

AUTOMATION GROUP

Ethernet
Communication




I.I HORNER

AUTOMATION GROUP .
Ethernet Communication

Ethernet Communication

Ethernet Module Protocols and Features ... 113
Ethernet System RequUiremMents ... 113
Ethernet Module Configuration ... ... 114
Ethernet Configuration - IP Parameters ... 117
Ethernet Module Protocol Configuration ... 117

For more details refer to the Ethernet Supplement, SUP0740, via the Documentation Search page on the Horner
website.

NOTE: Supported by the XLEe and the XLTe only.

Ethernet Module Protocols and Features

The following table describes the Ethernet Module protocols and features supported by the Ethernet port on the
XLEe/XLTe:

Ethernet Module Protocols / Features

Protocol / Feature Protocol / Feature Description
ICMP (Ping) Internet Control Message Protocol
EGD Ethernet Global Data
SRS Service Request Transfer Protocol
Request)
CsCAN TCP Server Horner APG CsCAN over Ethernet (for Cscape to OCS programming)
Modbus Slave Modbus over Ethernet
Ethernet/IP ODVA CIP over Ethernet
FTP (File Server) File Transfer Protocol
ASCII Over TCP/IP ASCII Data over Ethernet

Ethernet System Requirements

Full Ethernet functionality requires:
¢ PC running Cscape Programming Software Version 9.8 or later (for configuration).
e XLE/XLT controller with onboard Ethernet port.

Ethernet Module Specifications
Speeds 10 BaseT Ethernet (10Mbps) 100 BaseTx Fast Ethernet (100Mbps)
Modes Half or Full Duplex
Auto-Negotiation Both 10/100Mbps and Half/Full Duplex
Connector Type Shielded RJ-45
Cable Type (Recommended) CATS (or better) UTP
Port Auto MDI/MDI-X (Auto Crossover)
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Ethernet Module Configuration

NOTE: The following configuration is required for all applications regardless of the protocols used. Additional con-
figuration procedures must be performed for each protocol used.

To configure the Ethernet Module, use Cscape Programming Software to perform the following steps:
On the main Cscape screen, select the Controller menu and its Hardware Configuration sub-menu to open the Hard-
ware Configuration dialog.

=

| Hardware Configuration X

1 Controller | Local 10| CANT (CSCAN) /0| LAN1 10|

i Series [XL OCS Series -] Desgcription:
1 Operator Control Station with fixed 1/O
Device Type [ ~ |
Model#  |HEXE1E2 =] PReEE=
Display Type: 64 by 128 LCD
Network Ports s ‘
] Keypad Type: 20 key numeric
] CANT [CSCAN ~| config ywadType.  [20key
] Program Memory: |512 K Bytes
CANZ | ]| 9 |
| Network Type: ‘CSCAN
| LANT [ETN300 ~|  config
Advanced Ladder Functions
7 LAN2 | J Supports Analog Data

Real Time Clock Support
Supports Retentive Data

Serial Ports Config
OCS Wi-Fi Module

Auto Config
OK | Cancel ‘ ‘ Help
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Click the Config button to the right of LAN1, revealing the Ethernet Module Configuration dialog:

1 LANT Configuration 4

Register Usage

-
Default Register Get settings
IP Address: | [EF] . 168 . 254 . 128 ‘ Name:l j SEED ‘Conﬁguration j [ Use CAN ID for last Octet
MetMask: [ 255 , 255 . 255 . 0 | Name: | =] ®¥ [Configuration -]
Gateway: | 0 .0 .0 .0 ‘ Name:l j “ExY ‘Configuration J
DNS Server: | 0 .0 .0 .0 ‘ | J SGED ‘Cunfiguraliun J
Status: ‘ Name:l j JE0 ‘
Version: ‘ Name:l j BED ‘
Protocol Support
Resident Protocols
[11CMP (Ping) i
7] EGD (Ethernet Global Data) Configure Selected Protocol
[[] SRTP Slave (30-30 Service Request)
] Modbus Slave
[ Ethernet/IP
[] FTP (File Server)

[] ASCIl Qver TCP/IP

Downloadable Protocols
ETN1/1 |- None — = | | |

‘7 MNone — J | | |

0K Cancel |

¢ |P Address: Enter the static IP Address for the Ethernet Module being configured. NOTE: IP Addresses are
entered as four numbers, each ranging from 0 to 255. These four numbers are called octets and they are
always separated by decimal points.

¢ Net Mask: Enter the Net Mask (sometimes called Subnet Mask) being used by all nodes on the local net-
work. Typical local networks use Class C IP Addresses, in which case the low octet (rightmost number) is
used to uniquely identify each node on the local network. In this case, the default Net Mask value of
255.255.255.0 should be used.

¢ Gateway: Enter the IP Address of a Gateway Server on the local network that allows for communication out-
side of the local network. To prevent the Ethernet Module from communicating outside the local network, set
the Default Gateway IP Address to 0.0.0.0 (the default setting).

¢ Status Register: Enter an OCS Register reference (such as %R100) to indicate which 16-bit OCS register
will have the Ethernet Status word written to it. Table 12.3 shows how this register value is formatted and
explains the meaning of each bit in the Status Word.
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Ethernet Status Word Register Format
High Byte Low Byte
Bit 16| Bit 15| Bit 14| Bit 13| Bit 12| Bit 11| Bit 10| Bit9| Bit 8| Bit 7| Bit 6 Bit5| Bit4 | Bit3 | Bit2 | Bit1
0 0 Dup | Spd 0 Rx Tx | Link TCP Connections
Status Bit Status Indication — Status Values.
Minimum | Maximum
0 Reserved Always 0
Dup Link Duplex (Auto-Negotiated) 0 = Half Duplex| 1 = Full Duplex
Spd Link Speed (Auto-Negotiated) 0=10Mbps | 1=100 Mbps
Rx Receive State 0 = Inactive 1 =Active
Tx Transmit State 0 = Inactive 1 = Active
Link Link State 0=Down 1=Up
: Total Number of Active TCP Connections
TCP Connections (CsCAN, SRTP, Modbus, EIP, FTP) 0 40

¢ Version Register: Enter an OCS Register reference (such as %R101) to indicate which 16-bit OCS register
will have the Ethernet Firmware Version written to it. The value stored in the Version Register is (Ethernet
Firmware Version * 100). For example, for Ethernet Firmware Version 4.77, the version register will contain
477.

¢ Get Settings From: “Get settings from” allows the programmer to either configure the IP Address, Net
Mask, or Gateway for two functions: Configuration or Register

1. Configuration — The configuration for the IP Address, Net Mask, or the Gateway will be assigned
using the value in the Default Settings in this window.

Register — The configuration for the IP Address, Net Mask, or the Gateway will be assigned using the
values in the registers assigned.

2.

NOTE: The low octet of the IP Address can be replaced with the unit's CAN Network ID, by checking the Use CAN
ID for last Octet checkbox.
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Ethernet Configuration - IP Parameters

For primary operation, the IP address, Net Mask, and Gateway should be set in the LAN Config of the Cscape Hard-
ware Configuration. There are options to get IP parameters from the LAN Config or to get parameters from
registers. It is possible to set the Ethernet IP parameters from the OCS System Menu, but only as a temporary
measure. The following points on IP parameter configuration should be considered.

¢ |P Parameters in Non-Volatile RAM: The IP parameters of the Cscape LAN Config are written to non-volatile
RAM on power down. IP parameter settings made in the System Menu are not written to non-volatile RAM.
Any IP parameters settings made in the system menu will be lost after cycling power to the unit. It will revert
back to the last downloaded Cscape LAN Config that was loaded into non-volatile RAM at power down.

e “Cscape LAN Config”/ “Get Settings from” Configuration: When ‘Get settings from’ is set to Configuration, the
IP parameters specified under ‘Default Settings’ is used after downloading to the controller. The IP para-
meters are represented in System Menu / Set Networks and can be edited. However, any edits made from
System Menu / Set Networks is not retained through a power cycle. After power cycle, the unit reverts to the
last downloaded Cscape LAN Config that was loaded into non-volatile RAM at power down.

* “Cscape LAN Config” / “Get Settings from” Register: When ‘Get settings from’ is set to Register, the IP para-
meters are retrieved from the OCS registers assigned in LAN Config. Configured registers must be pop-
ulated with the desired IP parameters.

° The IP parameters are represented in System Menu > Set Networks. The IP parameters cannot be
edited from System Menu > Set Networks while the unitis in run mode. The IP parameters always fol-
low the values in the registers unless the OCS unit is placed in idle mode.

° Then the IP parameters can be edited in System Menu > Set Networks.

° When the OCS is placed back into run mode, it reverts to the registers for IP parameters.

Ethernet Module Protocol Configuration

The Protocol Support area contains a list of all the protocols supported by the platform being configured. To activate
a protocol, check its checkbox.

For protocols that require additional configuration, click on a listed protocol to select it and then click the Configure
Selected Protocol button. This will open a new dialog with configuration options for the selected protocol.

For detailed information on individual protocol configuration refer to Ethernet topic in the Help File.
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Protocol Configuration

OV IV W 119

Protocol Device Driver Selection ... ... .. ... 120

Network Configuration ... .. 121

Device List and Device Configuration ... 123

S AN LSt 125
Overview

Through loadable protocol device drivers, certain models of the OCS family can provide the ability to exchange data
with remote devices such as variable-frequency drives, PLCs and remote I/O devices. This feature greatly expands
the OCS ’s control capability with negligible effect on the OCS ’s ladder scan time.

Remote devices that communicate serially must do so under certain rules of data transfer known as a protocol.
Many device manufactures have created their own protocol for communications with their device. For a OCS to com-
municate with a specific device, it must be loaded with the corresponding serial communications protocol device
driver that supports that protocol.

A limited number of protocol device drivers are packaged with the Cscape distribution; however, as more are
developed, they will be made available as add-on packages. A device driver is typically distributed as a Windows
module, which contains the configuration menus, help files and the target executable driver code. When updating
device drivers, an install routine loads the device driver to the Cscape directory structure and makes that driver avail-
able to Cscape applications.

Once installed, the protocol device driver can be included as part of a Cscape application by selecting it from a list of
installed protocol device drivers and attaching it to the desired serial port (Home > Protocols). Only one protocol
device driver can be associated with a serial port, though some OCS models support multiple protocols on a single
Ethernet port.

Once the protocol is selected for a specific port, that port must be configured to match the bit transfer size and rate
of the target device(s). This is configured under the Network Config menu, which contains port specific information
such as the basic serial port parameters (i.e. baud rate, stop bits parity, retries, etc.). In addition to the serial port
parameters, this menu also contains the transaction scan update control configuration and any network level pro-
tocol specific configuration.

Once the network is configured, each device on the serial communications network must be configured. For some
communications (i.e. RS232), the network can be limited to one device. The devices are configured under the
Device Config menu, which contains an arbitrary device name, the device ID and optionally a OCS status register
that contains any device fault information.

Once each device(s) is configured, a Scan List of entries must be created which defines the transfer of data
between a local (OCS ) register(s) and a remote device register(s). These entries are created under the Data Map-
ping menu, which contains a OCS register, a target device ID, a target device register address, the number of
registers to transfer, and update type.

Each entry can be configured for one of two types of initiating a transaction: Polled and Triggered. Polled type
entries initiate a transaction with the remote device on every transaction scan. Triggered type entries only initiate a
transaction when a corresponding local (OCS ) binary trigger register is set. Once a triggered type transaction com-
pletes, the protocol device driver resets the local (OCS ) binary register to indicate completion.
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These basic types are also subdivided into read or write operations. For polled operations, a Read operation only
reads from a remote device. Likewise a Read/Write operation continuously reads from the remote device unless the
target OCS register value changes from one ladder scan to another. In this case, the new OCS value is written to
the target device. For triggered operations, only a read or write action is available.

When downloaded to the OCS , the Scan List is scanned sequentially to generate data transactions with the remote
device. This transaction scanning can be on a continual basis (automatic) or controlled from ladder logic (manual)
once a complex connection is created via a program. The specific transaction-scanning mode is selected from the
Network Config menu.

Protocol Device Driver Selection

Protocol Config *

Serial Protocols

MJ1 |

-- Mone -

(VIPR CT R Modbus CMP v 4,02 |
GE 5MP [Series 30 Protocol] « 3.07

Ciw |GPS Protocol v 317 ‘

Mitzubishi Fx Seres PLC « 3.07
Modbus Master w 4.05

MJ3 [~Tione - A |
|

Ethemet
ETN1/1 |- None - | | | |
ETN1/2 [~ None - =l | | |
ETN2/1 [~ None - =l | | |
ETN2/2 |- None - =l | | |

From the Cscape Home > Protocols menu, select the port drop-down box to select a protocol device driver. All pro-
tocol device drivers currently loaded in Cscape are displayed in the drop down selection along with their version
numbers. A selected protocol can be removed by selecting None from the drop-down selection. Some OCS models
can be limited in the number of ports or number of protocol device drivers that can be selected. Once a protocol is
selected, the Network, Devices and Data (Scan List) must be configured through corresponding dialogues access-
ible through the respective buttons (Network, Devices and Scan List).

Page 120 of 178



AUTOMATION GROUP

II HORNER

Protocol Configuration

Network Configuration

Metwork Config (Modbus Master) >

— Port Configuration

Baud Rate: |EEAL Pratocol |Modbus ATU = |

Parity: | None v Mode: fRc.o32 |
Data Bits: |8 | Reties: [~ (0-255]
Stop Bits: [ E Timeout [Toppn  mSec

Handshake:  [None ~]  SlaveSpeed [Faq E

—pdate Scan
= Automatic

Update Interval: ||:| mSec ReacquireTime: |-||:||:||:||:||:| mSec

i Manual
Trigger: I M arne: I ;I o>
D Select: I M arme; I LI 16-EIT

—kaster 1D # Address

Address: IEI

— Dizable Metwaork

Register: I M arne: I LI BT
— Status

Reqister: I Name:l ;I 4 » [zz-EIT

Frotocaol Help | (] I Cancel

Network Configuration provides the required parameters to configure the network. Each protocol is different and
may not require the entire Network Config field. Please refer to the table below for the options in the Network Config
field.
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Network Protocols

Baud Rate, Data
Bits, Stop Bits,
Parity

These field define the bit level transfer over the serial port.

None — No handshake lines are used
Multidrop Full — Rx remains active while Tx is occurring.
Multidrop Half — Rx is shut off while Tx is occurring.

FEMESIELD Radio Modem — Wait for CTS acknowledgment before transmitting (legacy radio modem
support).
Protocol If a driver supports multiple protocols, it is selected here, (i.e. Modbus supports RTU or ANSI).
Mode Specifies if port operates in RS232 or RS485 mode.
Retries Specifies number of times a transaction is retried on a failed response.
Timeout Specifies the amount of time for a device to wait for a valid response.
Update Interval — Specifies the update interval at
which all the mapped entries are executed.
Automatic Reacquire Time — Specifies the amount of time to
wait before attempting communications with an offline
Update Scan device.
Trigger — Specifies the binary register that a single
Manual transaction scan of the Scan List.
ID Select — If an analog is specified in the field, the ID
Select filter is enabled.
Sisiie Regii Spegifies the s.tart'ing OCS register of eight (8) consecutive registers (4-32bit counters), which
provide an indication of the network health.
Scanner Address| Specifies the OCS’s device (network) ID if a master ID is required by the protocol.

Protocol Help

Provides protocol specific help.
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Device List and Device Configuration

Device List

B | Device List (Modbus Master) x

Name | D I Status I On Error

Add

Delete

Config

i

Cancel

This configuration list is reached from the Device button on the Protocol Config screen and provides a list of the con-
figured devices on the Network. Devices must be created and exist in this list before corresponding Scan List
entries can be created for this device. Typically, the number of entries is limited to 128 devices.

¢ Add - Opens the Device Config dialog to add a new device to the list.

¢ Delete - Remove selected device from list (all corresponding Scan List entries are also removed).

¢ Config - Invoke the Device Config dialog for the currently selected device. This can also be accomplished by
double-clicking a device entry.

¢ Mapping - Invoke the Scan List limiting the entries displayed for the selected device.
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Device Configuration

Dialog X

Device

M ame: |

ID: 1 [Slave Address)

Device Options

™ Swap words on 32-bit data

™ Target returns 32-bit on single register request

Device Type: |M0dicon PLC 5-Digit Addressing j
Mode: |Device Supportz all modbus write function codes j
Dizable Device
Fegister: | Mame: j BT
Status
[” Enable
Address: |0 J 16-BIT
i i+
Ok | Cancel |

This configuration is reached from the device list when adding or modifying an existing device. While each protocol
is somewhat different and can contain protocol specific field, all protocols typically support at least:

L]

Device Name - Specifies a tag name for this device. This tag name is used in the Data Mapping con-
figuration to identify this device. This allows device addresses to be modified without the need to update all
associated Data Mapping entries.
Device ID - Specifies the target device communications ID or station address.
Swap Words on 32-bit Data - If a Scan List entry is configured to transfer 32-bits and this option is checked,
the high and low 16-bit values are swapped when transferred between the target and OCS.
Disable Device - From Cscape 9.90 SP3 and firmware 15.40 onwards, disable device feature has been
added in protocol device configuration. This option is used to disable a particular slave configured in the net-
work. Single bit register has to be configured to use this function. Setting the bit high disables the slave and
OCS will not send any serial (TCP for ethernet protocols) packets only to this slave until the bit is high. Set-
ting the bit low enables the communication with the slave again.
Status Enable - This checkbox enables device status to be displayed and controlled from two consecutive
16-bit registers.
Status Address - Enter the starting 16-bit OCS register of two consecutive registers used for device status.
The first register contains the protocol device driver specific error code while the second register contains the
index of the offending Scan List entry.
Status Modes:

a. Stop on Error - Specifies that communications be only reattempted after offline status when the cor-

responding device status register is cleared.
b. Retry on Error - Specifies that communications be reattempted either during the reacquire interval or
when the corresponding device status register is cleared.
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Scan List

B ' Scan List (Modbus Master)

Edit View Sort

Index | Local Name | Register | Type | Dev Name | ID | Target ‘ Length |

Delete

Config

i Jd

Edit Names

Cancel
Fiker By Device: [.._ oy ... | oK

it

This configuration list is reached from the Scan List button on the Protocol Config screen or the Mapping button on
the Device List screen and provides a Scan List of the Data Mapping entries. To transfer data between the OCS and
remote target, a Scan List must be created that defines each transaction. Each mapping entry (transaction) con-
tains the source and destination registers, the number of consecutive registers transferred, the direction of the trans-
fer and what triggers the transfer. Typically, the number of entries is limited to 512.

NOTE: The order of the Scan List is the order in which the transactions occur. Sort functions are provided to

change the order of the list. Each entry also has an identifying index. If the device status register is enabled and a
transaction failure occurs, the status register indicates the index number of the transaction that failed.
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Menu

« Edit > Copy All - Copies Scan List to clipboard in a tab delimited format suitable for pasting into an applic-
ation like Microsoft Excel.

¢ Edit > Paste - Loads Scan List from clipboard. Pasted items are added to the scan list even if they are duplic-
ates.

¢ View > Toggle All Name View - Expands Scan List such that each point and corresponding local name is
displayed.

¢ Sort Scan List by different criteria. The firmware will scan the devices based on the order they are displayed
or sorted. There are four ways to sort the scan list:

a. By Local Address — Sorts the list by local register address in increasing order.

b. By Target Address — Sorts the list by target register address in increasing order.

c. By Device Name — Sorts by device name, then target address.

d. Interleave Devices — This sort evenly distributes request among the different devices. Instead of
requesting 100 blocks from device A, then 100 blocks from device B, one requests is sent to device A,
then one request is sent to device B until all the data has been requested. This is useful for devices
that may have a timeout timer because the time between each scan for a particular device is min-
imized. This sorting options usually doesn’t affect performance.

Buttons

¢ Add - Opens the Data Mapping dialog to add a new entry to the Scan List.

¢ Delete - Removes selected entry from Scan List

¢ Config - Opens the Data Mapping dialog for the currently selected entry. This can also be accomplished by
double-clicking an entry.

« Edit Names - Invokes the Edit Names dialog for the currently selected entry. The Edit Names dialog
provides the ability to create OCS program names for each point in the transaction.

Display Control

Filter by Device - Limits displayed entries to only those assigned to the indicated device. To show all entries select
—All--.
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Data Mapping Configuration (Scan List Entry)

Dialeg >

Target

Device Mane |test 1] ﬂ

Diewice Register | j [ 32 bit access

Length 1

Local

Register | Marie: | j

UpdateType

{* Palled Fead " Triggered Fead
™ Polled Read/white (" Triggered \rite

" Polled Read/write Init

Trigger Regizter J

Cancel |

Target

* Device Name - Selects the target device (by tag name) to use for this transaction. Only those device entries
previously created from the Device Config menu are available.

« Device Register - Specifies the target device’s register to use for this transaction. This designation is target-
specific. The configuration menu displays an error if a specified address is unacceptable. Generally, the
data type of the local (OCS ) register must match the data type of the device register.

¢ The Right Arrow button - Displays protocol device driver specific help for the target addressing. Note that
some devices can require register addresses that exist on 8-bit, 16-bit or 32-bit boundaries.

¢ Local Register - Specifies the local (OCS ) register that is the source or destination for the transaction.

¢ Local Name [Optional] - Optionally allows selection of a OCS register by name <or> creation of a name for
aregister already selected by direct reference. Created names can be used thereafter to specify the local
(OCS ) register in ladder or graphics address fields.

¢ 32-Bit Access - Allows two local (OCS ) 16-bit registers to be treated as a single 32-bit value. For example,
if the value in either 16-bit register is modified, both registers are written to the device. Device-specific, 32-bit
word swapping options also apply to this designation. Since the transaction is treated as a 32-bit access, the
length is generally limited to 16. Note that some protocols can disable this feature.

¢ Length

a. Specifies the number of consecutive device registers that are transferred in this transaction. Note that
some protocols can limit the length that can be transferred. However, typically the length is limited
to 32. The configuration menu displays an error if a specified length is unacceptable.

b. If allowed, specifying a length greater than one (multiple consecutive register transfers per
transaction) is more efficient than creating a single transaction for each register. This group-
ing of registers per transaction can significantly reduce the transaction scan time; however, update
types that include writing on a polled basis require additional consideration.

c. On Read/Write and Read/Write/lnit update types, the write transaction only occurs when the local
(OCS ) register value changes. If the length is greater than 1 for Read/Write and Read/Write/Init
types, only the local register(s) that change in value are written. More specifically, only one write
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transaction occurs per scan per mapping entry for the register or consecutive sub-group of local
registers that changed in value. Depending on the protocol, the number of points written with that
write transaction are limited either to one or the number of consecutive points that changed value.

d. Therefore, if several local registers (specified in a single mapping entry) change in value
prior to a transaction scan, it takes SEVERAL transaction scans to complete all the write
operations. Furthermore, all write operations are completed before a read operation is sched-
uled.

e. For Manual Update (transaction) scans (i.e. dialup modem), it is recommended that all
Read/Write Scan List entry lengths be limited to 1.

Update Type

This field specifies the direction and what triggers the transfer of data between the OCS and target device for a map-

ping entry.

¢ Polled Read - On every transaction scan, a read-only target device register(s) transaction occurs.
¢ Polled Read/Write

a. Onevery transaction scan, a read target device register transaction occurs unless a local register

value has changed. The write transaction only updates those local registers that have changed in
value. If several non-consecutive local registers (contained in a single mapping entry) change value
between transaction scans, it takes several consecutive transaction scans to write each changed
register.

When the OCS is placed in RUN mode, the initial action for this mapping type is a read target
register transaction. This transaction initializes the local (OCS ) register(s) to match that of the
remote device register(s). Thereafter, any change to the corresponding OCS register(s) triggers a
write operation to the remote device.

* Polled Read/Write/Init

a.

C.

On every transaction scan, a read target device register transaction occurs unless a local register
value has changed. The write transaction only updates those local registers that have changed in
value. If several non-consecutive local registers (contained in a single mapping entry) change value
between transaction scans, it takes several consecutive scans to write each changed register.

When the OCS is placed in RUN mode, the initial action for this mapping type is a write target
register transaction. This transaction initializes the target device register(s) to match that of the local
(OCS) register(s). Thereafter, any change to the corresponding OCS register(s) triggers a write oper-
ation to the remote device.

The initial write transaction does not occur until after the first logic scan of the OCS . This allows
registers to be initialized locally before Writing to the target device register(s).

¢ Triggered Read - A read transaction is triggered by a high level on a separately designated OCS (binary)
trigger register. Once the read transaction is complete (or the device is offline), the OCS trigger register is
cleared by the OCS . This update type can be used for occasion data accesses such as retrieving trend data.
Note that this operation increases the associated transaction scan time and can cause the Update Interval
Exceeded Counter to increment on a tightly adjusted update interval.

¢ Triggered Write - A write transaction is triggered by a high level on a separately designated OCS (binary)
trigger register. Once the write transaction is complete (or the device is offline) the OCS trigger register is
cleared by OCS . This function can be used for occasion data accesses such as sending recipe data. Note
that this operation increases the associated transaction scan time and can cause the Update Interval Time
Exceeded Counter to increment on a tightly adjusted update interval.
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User Interface

Screen Navigation ... 130
Using Editable Screen Objects ... ... 131
Ladder Based Screen Navigation ... 131
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SCreen Brightness ... 134

This chapter presents the user interface (or operator view) of the XLE/XLT and some of the model specific char-
acteristics of the XLE/XLT as compared to the rest of the OCS line. This chapter does NOT cover building screens
or using the CSCAPE Graphics Editor. For instructions on creating screens and using the graphics editor, refer to
the Graphics Editor Help file in CSCAPE.

Screen Navigation

The screen navigation on the XLE/XLT is quite flexible. Basic methods will be described here. Control programming
can be used to create complex screen navigation techniques.

One form of screen navigation is the Jump Screen graphics object. This object is typically tied to a soft key (One of
the four keys to the sides of the display for the XLE and at the bottom of the screen for the XLT). Pressing the soft
key will switch to the screen that is programmed.

XLE Typical Screen Jump Object XLT Typical Screen Jump Object

Jump

Jump
GR| =

Screen jumps can also be triggered on other keys or based on control logic for more advanced applications. To
allow the operator to change screens, a screen jump object is generally used. This object may be visually rep-
resented as a button (responding to touch) or remain invisible and logically tied to an OCS register. An optional sys-
tem ICON may be configured for display along with the legend, which aids in identifying the object as one that
causes a screen change.

Page 130 0f 178



I.I HORNER

AUTOMATION GROUP
User Interface

Using Editable Screen Objects

When a screen contains editable objects, one of the objects will be selected by default. Selected objects will be out-
lined with a dotted line. The arrow keys can be used to navigate the editable objects and allow selection of an object
to edit. When the object to be edited is selected press the Enter button. This enters the objects editing mode.

The most common editable object is the numeric object.

The value chosen by the operator cannot exceed the minimum or maximum set by the user program. If the user
tries to exceed the maximum point or enter a value below the minimum point, the value will not change.

NOTE: If the XLE/XLT displays >>>>>> in a numeric field, the value is too big to display in the field or is above the
maximum for an editable field. If the XLE/XLT displays <<<<<<in a numeric field, the value is too small to display or
is below the minimum for an editable field.

XLE Specific - When in edit mode, a cursor appears on one digit of the editable field. Use the direction keys <« and
— to move the cursor to the desired position. Use the 1 and | keys to increment or decrement the digit or enter the
number/data with the alphanumeric keys.

XLT Specific - The most common editable object is the numeric object. To edit, touch the object and the pop-up
keypad will appear to allow editing of the value.

Ladder Based Screen Navigation

Ladder logic can use several techniques to control screen navigation. Coils can be tied to %D registers to make
them screen coils. These coils have two modes: switch and alarm. If the ladder program energizes an alarm display
coil, the screen associated with this coil is displayed and overrides the normal user screens. This is designed to
show alarm conditions or to display other ladder-detected events. When the text coil is de-energized, the previous
screen that was being viewed before the alarm is returned.

The switch display coil switches to the associated screen when it is energized. Once it is de-energized the screen
remains until it is switched by the user or ladder.

Force and Switch Coils in Ladder Programming in Cscape

Input_1 [ ) Foice Screen: 1
— | B
“Tooot Screen 1
Input_2 [ ] Sentch Screen: 2
—| .
%T0002
Screen 2

There is also a system register that can be used to for control-based screen navigation. %SR1 can be read to
determine the current screen or written to change the current screen.

Refer to the Online Help in Cscape for more information on control-based screen navigation.
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Alarms

Alarm presentation to the operator is highly configurable and beyond the scope of this document to describe fully.
The alarm object is generally used to enunciate alarms to the operator.

For more information, refer to the Graphics Editor Help File in Cscape. This section presents a typical con-
figuration thereby providing an introductory description on what the operator should expect.

To open the Alarm Configuration dialog, click on the Graphics Editor icon in the menu tool bar.

Cecape - [untiled!]
| B O] %] !I]|!‘

Then select Config > Alarm from the tool menu bar to open the Alarm Configuration dialog.

2| & eer| B|R]8] OfF

I main

T View / Edit Graphic Pages
Edit Grouping Screens Config Language View Tools Help

s S I R - T
ll 123 ® i % R Video €
Ololo \l Screen Capture
i"Unasmgned Filename Counters
File Select

Display Settings

User Security Configuration
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1 Alarm C |
Alam Trigger Block Summary
Mumber of Alams: [0 3: [~ RTNimplies ACK
i History
Address: | Name: | ¥ Log ACK
1 ¥ LogCLR
Remote Acknowledgement and Clear ¥ Log RTN
Ack Address: | Name: |
Cir Address: | Name: |

Alam Point Configuration

Number I Group I Identifier String
Copy |
Paste |
< > Edit |
Summary List Text Summary Button History Button

Alam: |Rash = UNACK: [Rey + Flash = Ful: [Rey + Aash e
ACK/CLR: [Nomal v ACT: |Reverse v Not Empty: | Reverse v
RTN: |Fash v Empty: [Nomal v Empty: [Nomal v

oK | Cancel |

To view, acknowledge, and/or clear alarms, the operator must access the alarm viewer. This is accomplished by
selecting an alarm object. When accessed, the alarm object is displayed as pop-up alarm viewer dialog similar to
that shown in Figure 14.5. If more entries exist than can fit on the page, a scroll bar is displayed on the right side that
also indicates the current relative position.

I Alarms I

Once view operations are complete, simply touch the Esc button to remove the pop-up alarm viewer.

NOTE: OCS registers %SR181 and %SR182 are available for ladder use, which indicate presence of unac-
knowledged or acknowledged alarm (respectively). The screen designer may implement these registers to switch
screens or activate the beeper to attract the operator’s attention.
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Screen Saver

The XLE/XLT screen backlight life remains sufficiently bright for five (5) years. It will dim to 70% brightness if it is left
on continuously for five (5) years. If the application does not require interaction with the OCS for long periods of
time, the backlight life can be extended by using the screen saver function. When enabled through the System
Menu, the backlight is shut off (screen goes black) after a specified time of no activity on the screen. When the
screen saver shuts off the backlight, any key or button reactivates the backlight.

Itis possible for the application to temporarily disable the screen saver by generating a positive transition to
%SR57.16 (coil only) at a rate faster than the screen saver timeout value. This may be desired while waiting for
alarm acknowledgment.

NOTE: The backlight life can be extended by dimming or powering off the backlight.

Screen Brightness

The XLT provides a feature that allows screen dimming for night operation. To enable this feature, the application
must access and control system register %SR57 (Display Backlight Brightness). Screen brightness is continuously
variable by driving %SR57 through the range of 100 (full bright) to 0 (full off). It is left to the screen designer on if and
how to present a Screen Brightness control to the user.

NOTE: Only the XLT offers a screen dimming function.
NOTE: The backlight life can be extended by dimming or powering off the backlight.

Page 134 of 178



II HORNER

AUTOMATION GROUP

Removable Media




I.I HORNER

AUTOMATION GROUP .
Removable Media

Removable Media
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Filenames and Function Blocks ... . 141
System Registers used with RM . . . 141

microSD Cards

All XLE/XLT models provide a Removable Media slot, labeled Memory, which supports standard microSD memory
cards. microSD cards can be used to save and load applications, to capture graphics screens and to log data for
later retrieval.

swissbit

microSD card op

ms3

Flash memory (aka a thumb drive)

-

N

Format a microSD Card

1. Select Removable Media in the System Menu of the controller.
2. Place card in the “Memory” slot.
3. Final Step:
a. For XLE, press the bottom right soft key to get the submenu that includes “format”, select format.
b. For XLT, press the bottom left and right keys to get the sub menu that includes “format”, select format.
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Install & Remove a microSD card

The XLE/XLT Memory slot is equipped with a “push-in, push-out” connector and a microSD card can be safely inser-
ted into the Memory slot when the XLE/XLT is powered On or Off.

To install a microSD card: Align its 8-pin gold edge connector down, facing the front of the XLE/XLT unit as
shown in Figure 15.1; then carefully push it all the way into the Memory slot. Ensure that it clicks into place.

To remove the microSD card: Push down on the top of the card gently to release the spring. The card pops up for
removal.

microSD File System

XLE/XLT prior to Rev TA supported the FAT16 file system which allows up to 2.0 GB of memory, while XLE/XLT
with REV TA and higher support the FAT32 file system which allows up to 2TB of memory. FAT microSD cards are
compatible in REV TA units and higher. The XLEe and XLTe also support the FAT32 file system.

This means that a PC, with a microSD-compatible card reader, can read files that have been written by the
XLE/XLT and can write files that can be read by the XLE/XLT.

The XLE/XLT supports the 8.3 filename format. This means that all file and directory names must consist of up to
eight (8) characters, followed by an optional dot, and an optional extension with up to three (3) characters.

Directories and sub-directories may be nested up to 16 levels deep as long as each pathname string does not
exceed 147 characters.

The Removable Media Manager can be accessed via the System Menu or by using Cscape to place a Removable
Media Manager object on an application graphics screen.
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Using the Removable Media Manager

The Removable Media Manager is an interactive XLE/XLT screen that performs the following functions:
¢ Display number of total and free bytes
¢ Browse file and directory lists
¢ Delete files and directories
¢ Format a microSD card
¢ Load and save application programs
¢ View screen capture bitmaps

The Removable Media Manager can be accessed via the System Menu or by using Cscape to place a Removable
Media Manager object on an application graphics screen.

Log Data

Using Read and Write Removable Media function blocks, an application ladder program can read and write
XLE/XLT register data in the form of comma-delimited files, with a .csv extension. These files are compatible with
standard database and spreadsheet PC programs. In addition, an application ladder program can use Rename and
Delete Removable Media function blocks to rename and delete files.

Load and Save Applications

A special file type, with a .PGM extension, is used to store XLE/XLT application programs on microSD.

To load an application from microSD to the XLE/XLT, use the Removable Media Manager to find and highlight the
desired .PGM file, and then press Enter.

To save an application from the XLE to microSD, open the Removable Media Manager in the System Menu and
press the F4 function key. The application will be saved in a file called DEFAULT.PGM in the microSD root dir-
ectory.

To save an application from the XLT to microSD, open the Removable Media Manager in System Menu and press
the Save Pgm soft key displayed at the bottom of the XLT’s touch screen. The application will be saved in a file
called DEFAULT.PGM in the microSD root directory.

NOTE: Saving an application to microSD can only be done from the System Menu and is not available on a Remov-
able Media Manager object that was placed on an application graphics screen by Cscape.

NOTE: Saving an application to microSD does not also save register data.

Cscape can also save an application directly to a microSD card, which is plugged into the PC’s microSD compatible
card reader by selecting the Export to Removable Media item on the File menu.
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View and Capture Screens

The XLE/XLT File System uses bitmap files with the .BMP (.bmp) extension to store XLE/XLT graphic screen cap-
tures.

To view a captured XLE/XLT screen, use the Removable Media Manager to find and highlight the desired .BMP file,
and then press Enter.

To capture an XLE/XLT screen, turning on the assigned Screen Capture Control Register will capture the current
XLE/XLT graphics screen and write it to the microSD card using the assigned Screen Capture Filename.

Before capturing an XLE/XLT screen, Cscape must first be used to assign a Screen Capture Control Register and
Filename in the application. To do this, first open the Graphics Editor by selecting the View / Edit Screens item on
the Cscape Screens menu. Next, select the Screen Capture item of the Graphics Editor Config menu and then
enter a Control Register and Filename.

Removable Media (RM) Function Blocks in Cscape

NOTE: For detailed information regarding RM function blocks and parameters, refer to the Help File in Cscape.
The following RM functional blocks are available in Cscape Software.

These function blocks will reference:

a. microSD when filename is prefixed with ‘A:’ or nothing
b. USB A Flash Drive when filename is prefixed with ‘B:’

RM Function Blocks

Allows reading of a comma-separated value file from the microSD interface into the con-
Read RM csv .
troller register space.
: Allows writing of a comma-separated value file to the microSD interface from the con-
Write RM csv .
troller register space.
Rename RM csv Allows renaming a file on the RM card. The data in the file is not changed.
Delete RM csv Allows deleting a file on the RM card
Copy RM csv Allows copying a file on the RM card. The data in the file is not changed.
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Program Features

Datalog Configuration—This feature allows the controller to periodically log register values to Removable Media.
The register data is stored in .csv (comma separated value) format, which is compatible with 3rd party PC applic-
ations, such as Microsoft Excel.

Report Editor—This feature allows the OCS to be configured to generate text printouts which incorporate data
from the registers embedded in the text. The reports can be printed using a serial interface printer through any of
the serial ports of the OCS or can be saved on the removable media of the device.

Graphic/Screen Editor

Trends—The historic support feature in the trend object utilizes Removable Media.
Removable Media—This is a graphic object used to access files and functions pertaining to Removable Media.
Recipes—This is a graphic object that is used in conjunction with the recipe editor which is mentioned above.

Additional Configuration

Alarms - Alarm data can be logged to a .csv file stored on Removable Media.

Screen Capture - The screen capture function allows a bitmap or jpeg image of the displayed OCS screen to be
written to the Removable Media card.

Filename Counters - The filename counters can be accessed wherever Removable Media functions require a path
name. A typical application is the auto-incrementing of a file name when doing screen captures.

File Select - File Select is used to specify the register block that is used with the Removable Media Manager object
‘Write Selected Filename’ option.
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Filenames and Function Blocks

The RM function blocks support the flash with a Windows standard FAT-16 file system. All names must be limited to
the “8.3” format where the filename contains eight characters a period then a three-character extension.

The entire filename including any path must be less than or equal to 147 characters.

When creating filenames and directories, it is sometimes desirable to include parts of the current date or time.
There are six special symbols that can be entered into a filename that are replaced by the OCS with current time
and date information.

Filename Special Symbols

Symbol Description Example
$Y Substitutes the current 2-digit year 2022 =22
$M Substitutes the current month with a 2-digit code| March = 03
$D Substitutes the current day 22nd =22
$h Substitutes the current hour in 24-hour format | 5pm =17
$m Substitutes the current minute 45=45

$s Substitutes the current second 34=34

NOTE: All the symbols start with the dollar sign ($) character. Date symbols are in upper case, time symbols are in
lower case.

The following are examples of the substituted time/date filenames:

Current date and time: March 1, 2022 5:45:34 PM

Filename: Data$M$D.csv = Data0301.csv

Filename: Year$Y\Month$M\aa$D_$h.csv = Year22\Month03\aa01_17.csv
Filename: Month_$M\Day_$D\$h_$m_$s.csv = Month_03\Day_01\17_45_34.csv

System Registers used with RM

%SR174 — Removable Media Protect. Write a one (1) to %SR174 to prohibit read/write access to the removable
media card. Write a zero (0) to allow access.

%SR175 Status — This shows the current status of the RM interface.

%SR176 Free Space — This 32-bit register shows the free space on the RM card in bytes.

%SR178 Card Capacity — This 32-bit register shows the total card capacity in kilobytes.

Possible status values are shown in the table:

RM Status Values
RM interface OK
Card present but unknown format
No card in slot
Card present, but not supported
Card swapped before operation was complete
Unknown error

AQ|h|[WIN|=|O
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The ‘Clone Unit’ feature allows the user to “clone” the OCS of the exact same model. This feature “clones” applic-
ation program and unit settings stored in Battery backed RAM of an OCS into the RM. Refer to"Removable Media"
on page 136 for more details on using RM. It can then be used to clone a different OCS (same model).

This feature can be used for:
¢ Replacing an OCS by another unit of the same model.
¢ Duplicating or “clone” units without a PC.

Clone

User must perform the following sequence of action to Clone a unit:

Step 1: The ‘Clone Unit’ can be accessed by going to the ‘System Menu’ of the OCS. A new menu “Clone Unit” has
been added at the end of the main system menu as shown below:

XLT: XLE:
View Status "\@ Set Screen
View Diags Removable Media
UView I/0 Slots Fail-Safe System
Uiew Protocols @ Clone Uni
Set Fkeys Mode

Set Time/Date
Set Beeper
Set Screen
Removable Media

Fail-Safe System

Clone Uni W

Set Serial Ports [%] (ESC to exit)
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Step 2: Selecting “Clone Unit” menu will open the following menu screen:

XLT: XLE:

Clone Unit - Clone @ICreate
Dir Empty il Dir Empty

[FEECancel

NOTE:
a. Inthe above figure, F3 and F4 are inactive in the Clone Unit.
b. DSK - when selected shows the number of total and free bytes in Removable Media.

Step 3 - Make/Create Clone option enables the user to duplicate / Clone an application file, all unit settings and all

register values from Battery Backed RAM. Selecting Make Clone brings up the screen below:

XLT: XLE:

Clone Unit

‘

Make Clone Files

-
e

—
=
o

Make Clone Files

Are You Sure?

(=8 Cancel Ok

Are You Sure?

>

(<

Cancel Ok

—
1
.

E-& | (Load |

| Clone |

After confirmation, the OCS will create two new files in the root directory of the Removable Media Drive as shown

below:
AUTOLOAD.PGM - Application file
CLONE.DAT - File having all unit settings and register values from Battery Backed RAM
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XLT: XLE:

AUTOLOAD. PGM =" | IAUTOLOAD. PGM
CLONE .DAT N CLONE .DAT

NOTE: Make/Create clone operation automatically includes the security in AUTOLOAD.PGM file for security
enabled files.

Step 4: Once the cloning is successful, the OCS gives a message as below:

XLT: XLE:

Clone Unit

Cloning Status

Cloning Status
SUCCESS: MAKE CLONE

SUCCESS: MAKE CLONE | Enter Qi

Ok

Load |
. Clone |

Make/Create clone can also be triggered by setting %SR164.9 bit to “1” from Ladder program or graphics. Once the
operation is completed, this bit is made zero by the firmware. When Make clone operation is triggered by this SR bit,
it does not ask the user for confirmation to make the clone. The success / failure of the operation is also not notified
on screen to the user.

In case of failure of “Make Clone” operation, %SR164.11 bit is set to “1” by the firmware and never reset.

NOTE: Backup of registers in flash memory is not performed by the Clone Feature. If user desires, Backup should
be done as explained in the Fail-Safe System chapter.
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Load Clone

This option loads the application, all unit settings and register values from Removable media to the Battery backed
RAM (Regardless of AutoLoad settings) and then resets the OCS for the settings to take effect.

User must perform the following to Load the Clone:

Step 1: Select “Clone Unit” from main system menu of OCS as shown below:

XLT: XLE:
Uiew Status A@ Set Screen
View Diags Removable Media
UView I/0 Slots Fail-Safe System
View Protocols @
Set Fkeys Mode
Set Serial Ports ESC + it
Set Time/Date E] . B i)
Set Beeper
Set Screen
Removable Media
Fail-Safe System
Clone Uni e

Selecting “Clone Unit” menu will open the following menu screen. Select “Load Clone”.

XLT: XLE:

l:{]_lTI:I[_I:II:lD: F'I:;T"I _‘ ) AUTOLOARD . PGM
CLONE — .DAT | 05-21 Peemd [CLONE  .DAT
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Step 2: User must confirm Load Clone as shown below:

XLT: XLE:

Clone Unit

Ll:r.alj |: 1 one F 1 1'5'3

Load Clone Files Are You Sure?

Are You Sure? — Esc R |Enter IR

Cancel

[ Make | |

. Clone |

Step 3: After confirmation, all unit settings and register values will be loaded from the Removable media to the Bat-
tery backed RAM (Regardless of AutoLoad settings) and then the OCS resets at which stage the settings take
effect.

NOTE: For security enabled files, Load clone asks for password validation before loading the application.

Load clone can also be triggered by setting %SR164.10 bit to “1” from Ladder program or graphics. Once the oper-
ation is completed, this bit is made zero by the firmware. When the Load clone operation is triggered by this SR bit,

it does not ask the user for confirmation to load the clone. The success / failure of the operation is not notified on the
screen to the user.

In case of failure of the “Load Clone” operation, %SR164.12 bit is set to “1” by the firmware and never reset.
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Fail-Safe System

Fail-Safe Features
Settings
Backup / Restore Data
Flow Chart for Automatic Restore
AutoLoad
AutoRun

Fail-Safe Features

The Fail-Safe System is a set of features that allows an application to continue running in the event of certain types
of "soft" failures. These "soft" failures include:
e Battery power loss
« Battery-Backed Register RAM or Application Flash corruption due to, for example, an excessive EMI, Elec-
tromagnetic Interference, event.

The Fail-Safe System has the following capabilities:

¢ Manually backup the current Battery-Backed RAM Register Settings into Flash memory.

¢ Manually restore Register Settings from the values previously backed up in Flash to Battery-Backed RAM.

¢ Detect corrupted Register Settings at power-up and then automatically restore them from Flash.

¢ Detect corrupted or empty application in Flash memory at power-up and then automatically load the
AUTOLOAD.PGM application file from Removable Media (Compact Flash or microSD).

¢ If an automatic Register Restore or Application Load occurs, the OCS can automatically be placed in RUN
mode

The fail-safe system can be accessed through the system menu of the controller. A new menu “Fail-Safe System”

has been added at the end of the main system menu for this. Selecting “Fail-Safe System” menu will open the fol-
lowing menu screen:

XLT: XLE:

Backup/Restore Data

Backup /Restore Datsz

Enable AutoRun
Enable RutolLoad

Enable AutoRun
Enable AutolLoad

(ESC to exit) (ESC to exit)

LEP]
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Settings

To use the Fail — Safe feature, the user must do the following:

1. From Cscape, create AUTOLOAD.PGM for the application program using ‘Export to Removable Media’.

2. Place the Removable Media with AUTOLOAD.PGM in the device.

3. Setthe ‘Enable AutoLoad’ option in the device to YES.

4. Setthe ‘Enable AutoRun’ option to YES if the controller needs to be placed in RUN mode automatically after
automatic restore of data or AutoLoad operation.

5. Backup the current Battery-Backed RAM Register contents in On-Board Flash memory using System Menu
options.

Backup / Restore Data

Selecting this option brings up a screen having four operations:
¢ Backup OCS Data.
¢ Restore OCS Data.
¢ Clear Backup Data.
e Exit

XLT: XLE:

Back |||:|.wa+4 wwe Dat: Bac lup 'Restore Data

Backup | @ Restor e

Backup Restore [@Clear Backup

Clear Backup

Exit

Backup OCS Data

When initiated, this will allow the user to manually copy Battery-Backed RAM contents on to the onboard FLASH
memory of the OCS. This will have the effect of backing up all the registers and controller settings (Network ID, etc.)
that would otherwise be lost due to a battery failure. %SR164.4 is set to 1 when backup operation is performed.

XLT: XLE:

Backup /Restore Data

Backup Regist

E:a.:l,::up F_:E.gi-_:_'ter--_: Overwrite Backup""

358 Cance ] | (ST Ok

Overwrite Backup?

Cancel Ok

S —
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Restore OCS Data

When initiated, this will allow the user to manually copy the backed-up data from the onboard FLASH to the Battery-
Backed RAM.

A restore operation will be automatically initiated if a backup has been previously created and on power-up the Bat-
tery-Backed RAM registers fail their check.

The following process is implemented to restore data:
1. The controller will be placed in IDLE mode.
2. Data will be copied from onboard FLASH to OCS Battery-Backed RAM
3. The controller will reset.
4. The controller will be putin RUN mode if the AutoRun setting is ‘Yes’ else it will remain in IDLE mode.

XLT: XLE:

Backup/Restore Data

Restore Registers
Are You Sure?
Restore Registers This will cause
L Are You gure? J System Reset!
This will cause m Enter+Ju3
System Reset!
Cancel Ok

S —

%SR164.3 is set to 1 only when an automatic restore operation is performed - not on a manual one. This bit is reset
to the value of 0 when a new backup is created.

Restoring of data can be manually performed by selecting RESTORE option from the Backup / Restore Data menu.
This will cause the controller to reset.

Clear Backup Data

When initiated, the backup data will be erased from the onboard Flash and no backup will exist.
%SR164.4 and %SR164.3 is reset to the value of 0 when backed up data is erased.

XLT: XLE:
Backup/Restore Dat: Backup
- Backup Are You Sure?
Are You Sure? [FEE Cance | [T Ok
Cancel Ok
| S—

Exit: Goes back to the previous screen.
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Flow Chart for Automatic Restore

The OCS follows the following sequence in execution of Automatic Restore:

( OCS Power Cycle )

Battery Backed FAM
Registers check failed

NO

Controller placed in Application
IDLE mode Program erazed

L 3

Data copied from Onboard FLASH to OCS Battery backed
BAM

w

Controller Eesets

NO :

|OCS putin IDLE
Mode

AutoFun
Enabled?

YES

OCS put in EUN Mode
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AutolLoad

This system menu option allows the user to specify whether the OCS automatically loads the application
AUTOLOAD.PGM located in Removable Media.
When the AutoLoad setting is enabled (set to YES), it can be manually or automatically initiated at power-up.

The automatic initiation will happen only in the following two cases:
¢ When there is no application program in the OCS and a valid AUTOLOAD.PGM is available in the removable
media of the device.
¢ When the program residing in onboard memory is corrupted and a valid AUTOLOAD.PGM is available in the
removable media of the device.

AutoLoad can be manually initiated when the SYS-F3 key is pressed (OCS can be in any of the following mode —
Idle / Run/DOIO). This also requires a valid AUTOLOAD.PGM to be present in the removable media of the device.

When the AutolLoad setting is not enabled (set to NO), OCS will be in IDLE mode and the application is not loaded.

If the AUTOLOAD.PGM is security enabled, the user will be prompted to enter the password before loading the
application. The application will be loaded from the Removable media only after getting the correct password.

%SR164.6 can be set to enable AutolLoad feature.

XLT: XLE:

Enable Autoload No

Enable RAutoloac Ho

( AutolLoad from b}
({ Removable Media’s )
¢ AUTOLOAD.PGM file )
( when triggered )

( AutolLoad from )
( Removable Media’s )
{ AUTOLORD.PGM file )
( when triggered ]

Es

(7<)
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The OCS implements the following sequence to execute the AutoLoad function:

( Power up OCS )

Application Program absent
or
Application Program corrupted

NO
AutoLoad
Enabled? # OCS put m IDLE mode
NO
UTOLOAD.PGM present ii ':':l:lfﬂ"i-?aﬂ ﬂrlun sﬂquf:;ce
the RM of the device ? atled (with reasons Tor
failure)

AutoLoad imtiated.

k4

NO

AutoRun

Enabled? » OCS put n IDLE Mode

OCS put in RUN Mode
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AutoRun

This system menu option, when enabled (YES), allows the user to automatically place the OCS into RUN mode
after the AutoLoad operation or automatic Restore Data operation.

When the AutoRun setting is disabled (NO), the OCS remains in the IDLE mode after a Restore Data or AutoLoad
operation.

%SR164.5 can be set by putting the system into RUN mode automatically, once an AutoLoad has been performed
or an Automatic Restore has occurred.

If for any reason the AutoLoad-Run (Loading the AUTOLOAD.PGM automatically and OCS put in RUN mode)
sequence does not succeed, a pop-up message box saying "AUTO-LOAD-RUN SEQUENCE FAILED" will be dis-
played. It will also show the reason for its failure. On acknowledging this message box the AutoLoad-Run sequence
will be terminated, controller will return to the first user-screen and will be placed in IDLE mode.

XLT: XLE:
Enable AutoRurn Mo A Enable AutoRun Ho
CEEFEEKCAUT TONFHRRRR) CEEREEXCAUT IOMEXXXERR)
{ Auto Enters RUN )] { Auto Enters RUN )
( after AutolLoad )] { after AutolLoad 3
( ( or Battery Fail )

or Battery Fail )
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Modbus Communications

Modbus Slave ... . 157
Modbus Master . . 158
Modbus Addressing Tables for XLE/XLT UnNits ... 159

Modbus Overview
For complete Modbus instructions, please refer to the Help file in Cscape.

Modbus (serial) is a popular, de-facto standard protocol that allows industrial devices from multiple manufacturers
to easily share data in real-time. For Modbus serial communications, the XLE/XLT can act as either a Master or a
Slave.

Modbus protocol (serial) allows for one master and multiple slaves. The master always initiates the conversation by
sending a request to a particular slave. Only the addressed slave will send a response when the request is com-
pleted. Should the slave be unable to complete the request, it returns the appropriate error response. Should the
slave be unable to respond, the master’s timeout timer expires to provide an indication of No Response.

Modbus Slave

For complete Modbus Slave instructions, please refer to the Help file in Cscape.

The Modbus slave function block, when used with the appropriate Modem and/or Open function blocks, allows the
primary serial port on the controller to act as a Modbus slave. The Modbus function supports both ASCIl and RTU
modes of operation across a range of baud rates and protocol frames. Also supported is port activity status, an
inactivity timer, support for call-on exception, and support for store and forward (repeater) operation for radio
modems.

The Modbus Addressing section describes the supported Modbus Commands as well as the Modbus Map for
XLE/XLT References (%R, %M, etc.).
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Modbus Master

For complete Modbus Master instructions, please refer to the Help file in Cscape.

When acting as a Modbus master, there are two primary mechanisms used by the XLE/XLT to allow the user to spe-
cify the data to be read/written from/to the slaves.

Modbus Master Function Block—This is for serial only. This is an advanced feature that should only be used in
rare occasions.

Protocol Config—The Protocol Config is configured in the Hardware Configuration dialog box in Cscape (serial)

This is the preferred method in most applications.
After the protocol has been selected from the dropdown menu, the Network, Devices, and Scan List become avail-

able. The Protocol Config is configured on three different levels:
¢ Network—Parameters, such as the polling rate of the data scan, are specified along with timeout values,
retry, and re-acquisition settings. Serial configuration, baud rate, parity, etc. are also set here.
« Devices—For every slave to be polled, configuration details are added in the Devices dialog box. This
includes Slave ID (serial). Under Device Type, the Modbus addressing style matching that specified in the
slave’s user documentation may be selected. For instance, some slaves specify Modbus addresses (i.e.

40,001), and others specify offsets (i.e. 0000).
o Hex or Decimal—Some specify addresses in hex, and others in decimal. By allowing the user to

select the Modbus addressing style for each slave on the network, minimal address conversion is
required. Also, if the slave is another Horner product (i.e. another OCS), the “Native Addressing”
option can be selected (i.e. %R1, %M17, etc.), and this skips the conversion to Modbus style alto-

gether.
¢ Scan List—This is where the specific Modbus addresses to be read/written from/to each slave are specified.

Up to 32 words of data can be read at the same time.

NOTE: Once configuration has been completed on the Network and Devices level, Modbus data can be directly
read/written from graphics objects in the Cscape screen editor. This is available even if the Modbus register is not
listed on the scan list.

The above information is just an introduction to the topic. For more detailed information, please consult the Cscape
Help file.
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To access XLE/XLT registers, a Modbus Master must be configured with the appropriate register type and offset.
This is usually accomplished with one of two methods:

Modbus Communications

Method 1: The first method uses Traditional Modbus References, in which the high digit represents the register
type and the lower digits represent the register offset (starting with Register 1 for each type). Since only four register
types can be represented in this manner, XLE/XLT Modbus Function Blocks pack several XLE/XLT register types
into each Modbus register type. Starting addresses of each XLE/XLT register type are shown in the Traditional Mod-
bus Reference column of the tables below.

Method 2: The second method requires the Modbus Master to be configured with a specific Modbus Command
and Modbus Offset. The supported Modbus commands and the associated offsets are also illustrated in the tables

below.
XLE/ XLEe Modbus Master Mapping
. Trad. Modbus Expanded
é:fel :S;Ez M:):nmuem Reference Modbus Ref. Modbus Command(s) Mg;::f
9 (5 Digits) (6 Digits)

%11 2048 10001 010001 0

%IG1 64 13001 013001 3000
Read Input Status (2

%S1 13 14001 014001 ead Input Status (2) 4000
%K1 10 15001 015001 5000

%Q1 2048 00001 000001 . 0
%M1 2048 03001 003001 ngci%cc’)'l'l ?;‘;‘tus (1) 3000
%T1 2048 06001 006001 Force Multiple Coils (15) 6000
%QG1 64 09001 009001 9000

%Al1 512 30001 030001 0
%AIG1 32 33001 033001 Read Input Register (4) 3000
%SR1 192 34001 034001 4000

%AQ1 512 40001 040001 0
%R1 2048 43001 043001 Load Register (6) 3000
%AQG1 32 46001 046001 Load Multiple Registers (16) 6000
%R1 9999 - 410001 10000
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XLT/ XLTe Modbus Master Mapping

XLT/XLTe . Expanded
Reference Maximum Trad. Mo.dlr.)us Mogbus Ref. Modbus Command(s) LI
Range Ref. (5 Digits) . . Offset
(6 Digits)
%I1 2048 10001 10001 0
%IG1 64 13001 13001 3000
%S1 13 14001 14001 Read Input Status (2) 4000
%K1 4 15001 15001 5000
%Q1 2048 00001 000001 _ 0
%M1 2048 03001 003001 ngc‘l%‘ziﬁ;";‘tus (1) 3000
%T1 2048 06001 006001 Force Multiple Coils (15) 6000
%QG1 64 09001 009001 9000
%Al1 512 30001 030001 0
%AIG1 32 33001 033001 Read Input Register (4) 3000
%SR1 192 34001 034001 4000
%AQ1 512 40001 040001 0
%R1 2488 40513 040513 Read Holding Register (3) 512
%R1 2048 43001 043001 Load Register (6) 3000
%AQG1 32 46001 046001 Load Multiple Registers (16) 6000
%R1 9999 - 410001 10000
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Precautions & Safety

The XLE/XLT contains an internal lithium battery that is used while power is disconnected for the following func-
tions:

¢ Run the real-time clock

¢ Maintain retentive registers

¢ Maintain the application program

Under normal conditions the battery in the XLE/XLT should last seven (7) to ten (10) years. Higher operating tem-
peratures or variations in batteries may reduce this time.

Preventing Program Loss: An available option to prevent the loss of program should the battery be drained is to
use the Backup/Restore function which is part of the Fail-Safe System.

This feature is highly recommended and is accessible from the System Menu and from program logic.
Backup/Restore DOES NOT require the installation of a microSD card in order to prevent program loss. Refer to
"Fail-Safe System" on page 149 for complete details.

The battery will generally last seven (7) to ten (10) years. Environmental conditions, including extreme tem-
peratures and humidity, can affect battery life. If the battery is older than seven (7) to ten (10) years old, it is recom-
mended that it be replaced as preventative maintenance.

WARNING: DO NOT USE IF BATTERY IS LEAKING OR HAS BEEN DAMAGED.

WARNING: LITHIUM BATTERIES MAY EXPLODE OR CATCH FIRE IF MISTREATED. DO NOT RECHARGE,
DISASSEMBLE, HEAT ABOVE 100° C (212° F) INCINERATE, OR PUNCTURE.

WARNING: EXPLOSION HAZARD - BATTERIES MUST BE ONLY BE CHANGED IN A AREA KNOWN TO
BE NON-HAZARDOUS.

WARNING: Disposal of lithium batteries must be done in accordance with federal, state, and local reg-
ulations. Be sure to consult with the appropriate regulatory agencies before disposing batteries. In addi-
tion, do not recharge, disassemble, heat or incinerate lithium batteries.

WARNING: Do not make substitutions for the battery. Be sure to only use the authorized part number to
replace the battery.

NOTE: The XLE/XLT uses a 3V coin lithium battery, part no. HE-BAT009 available from Horner Automation.
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Steps for Battery Replacement

Below are the steps to replace the battery:

. Make sure the user program and any data stored in retentive memory is backed up.

Disconnect all power from the XLE/XLT unit including I/O power.

Using a Phillips screwdriver, remove the four (4) screws on the back of the XLE/XLT unit by turning the four
(4) corner screws counterclockwise. Remove the back cover.

Carefully remove the I/O board (if present) by lifting it straight up.

Remove the old battery. It may require a small flat blade screwdriver to lift it from the holder.

Dispose of the battery properly; see the above warning on disposal regulations.

Slide the new battery into the holder. Make sure the battery is inserted with the proper polarity. The top tab of
the battery holder should contact the positive (+) terminal of the battery.

Replace the 1/O circuit board by aligning the edges with the guideposts. Align the I/0 board bus connector to
bus pins, and then gently press on the 1/O circuit board until it is seated.

Place the back cover back on the unit.

. Place the screw back into the hole and turn the screw slowly counterclockwise until “clicks” into the threads.

This will prevent the screw from being cross threaded. Now turn the screw clockwise until the cover is firmly
secured. Repeat this process for all four (4) screws. Recommended torque is 3 - 4 in-lbs (0.34 — 0.45 Nm).
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Firmware Update

Firmware Update Details ... 165
Download Firmware .. . . 166
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Firmware Update via microSD card ... 167
Manual Firmware Update via oS RS ... ... 168
Auto firmware update Via YoS R S ... .. 168

The XLE/XLT products contain field updatable firmware to allow new features to be added to the product at a later
time. Firmware updates should only be performed when a new feature or correction is required. This applies to Gen-
eration 2 modules. For legacy modules please refer to the Firmware Update Manual using Horner's Documentation
Search page.

WARNING: Firmware updates are only performed when the equipment being controlled by the XLE/XLT isin a
safe, non-operation state. Communication or hardware failures during the firmware update process can cause the
controller to behave erratically resulting in injury or equipment damage. Ensure the functions of the equipment work
properly after a firmware update before returning the device to an operational mode.

Firmware Update Details

Check for Current Firmware Revision - To check the firmware revision on a controller, open System Menu >
View Status.

NOTE: Updating firmware will clear the application program, screens, configurations, and register data. If required,
make sure to backup program and register data before updating firmware. The controller's User Manual has instruc-
tions for doing backups.

There are various methods for updating firmware. The method used depends on the type of controller being
updated.

Method A: Removable Media Method
The controller firmware is updated by a bootloader, using a microSD card or USB Flash drive (not through the
Cscape Firmware Update Wizard). To update or change firmware:
1. Download desired Firmware set from the Horner APG website. (Verify CsCAN or CANopen com-
munications.)
2. Save Firmware files to microSD card or USB, these are the removable media devices.
3. Update the firmware through the controller’'s Firmware Update function

NOTE: Files from the Horner website come as a .ZIP file which need to be unzipped and placed in the root of the
drive for them to function properly.

Method B: RS232 Serial Connection

Serial firmware updates are done from Cscape software to the controller’s primary serial port, MJ1 in most cases.
Method C: Mini USB Port — The mini USB port can be used to update firmware in the XLE and XLT series. This is
quicker than doing so via MJ1.
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Download Firmware

a.

b.

In North America, visit https://hornerautomation.com Then click Support > Downloads >Controller Firm-
ware and download the most recent firmware set with the correct communication protocol.

In Europe, visit http://www.hornerautomation.eu and click Support > Firmware tab and download the
desired firmware (an account is required to access firmware updates, create one if necessary).

Update Firmware Steps

©CeNOO A

10.

Establish communication between Cscape and the controller using a direct serial connection to MJ1.

Make sure your application is available on your PC or upload the application.

Make sure the machinery connected to the XLE/XLT is in a safe state for firmware update (see warning
above).

Start the firmware update by selecting File > Firmware Update Wizard.

The correct product type should be selected, if it is not select the type of controller from the drop-down list.
Press the Start button.

Wait for the firmware update to complete.

If there is a communication failure check the cable, connections and comm. port setting and try again.
Firmware updates typically delete the user applications to ensure compatibility. You will need to reload your
application.

Test the operation of the equipment with the new firmware before returning the XLE/XLT system to an oper-
ation mode.
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Firmware Update via microSD card
NOTE: Applies to XLEe and XLTe (ethernet models) only.

Method 1

Placing “.s19” file in the root of microSD card and loading firmware manually and automatically.

Manual firmware update by selecting “.s19” file - Place “.s19” file in the root of microSD card and insert the
card. Go to System menu | Removable media and select “.s19” file that needs to be loaded. Device displays the fol-
lowing message “Do not power Cycle Until FW is updated”, select OK. Firmware update will be started, and a busy
symbol will be displayed on the device until firmware will be loaded.

When firmware update will start %SR154.16 bit will be set to high. Once firmware update is completed %SR154.16
bits will be set to low.

Set %SR154.12 bit to high before selecting “.s19” file / before loading firmware if user program and register data
should be cleared after the update.

Set %SR154.12 bit to low before selecting “.s19” file / before loading firmware if user program should be present,
register values should be retained and status of the device needs to be retained after the update.

Auto firmware update via %SR’s - Place “.s19" file in the root of microSD card and insert the card. When
%SR154.9 is set to high, %SR154.16 bit goes high and controller will update the firmware which is placed in the
root directory of SD Card. Once firmware update process is successful, %6SR154.9 and %SR154.16 bits are reset
(goes low).

NOTE: There will be no busy symbol indication for this method. User should monitor %SR’s for the updates.
Set %SR154.12 bit to high if user program and register data should be cleared after the firmware update.
Set %SR154.12 bit to low if user program should be present, register values should be retained and status of the

device needs to be retained after the firmware update.

Method 2
Placing “.s19” file in “Update” folder and loading firmware manually and automatically. For this test, user should cre-
ate a folder “/Update/Vxxyyzzz” folder in microSD card and then place the “.s19” files inside respective folders.

For example - “update/Vxxyyzzz/ xlee.s19” (Where, V is for version and xxyyzzz is the version number, Vxxyyzzz =
V1549206). Screenshot of the directory structure that should be in microSD card:

> This PC » USB Drive (G:) » Update

~ Name

V1549206
V1549207
NOTES:
a. IfFW version on the device and firmware version inside Update folders are same, then nothing should hap-
pen.

b. If multiple firmware version folders are available in the update directory, then the version that is greatest /
latest should get updated to device.
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Manual Firmware Update via %SR’s

With proper folder structure placed in microSD card, insert the card to device.

Set %SR154.10 high. If firmware version folder inside update directory is greater than the firmware version on the
device, then %SR154.16 will go high indicating firmware update process have started. Once firmware update pro-
cess will be completed, %SR154.10 and %SR154.16 bits goes low.

NOTE: There will be no busy symbol indication for this method. User should monitor %SR’s for the updates.

Set %SR154.12 bit to high if user program and register data should be cleared after the update.

Set %SR154.12 bit to low if user program should be present, register values should be retained and status of the
device needs to be retained after the update.

Auto firmware update via %SR’s

Setting %SR154.10 and %SR154.11 high, whenever new firmware folder is placed in the microSD card, firmware
update will happen automatically setting %SR154.16 bit high. Once firmware update process will be completed,
%SR154.16 bit will be reset but %SR154.10 and %SR154.11 will remain high (for auto update of firmware).
NOTE: There will be no busy symbol indication for this method. User should monitor %SR’s for the updates.

Set %SR154.12 bit to high if user program and register data should be cleared after the update.

Set %SR154.12 bit to low if user program should be present, register values should be retained and status of the
device needs to be retained after the update.

In all the methods, device will reset automatically after firmware update process is completed.
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Troubleshooting
Connecting t0 the XLE XL T .. 170
Local Controller and Local 1O .. ... 171
CSC AN NetWOTK 172
Removable Media Troubleshooting ... 173
Technical SUPPOIt CoNtactS .. .. ... 173

Connecting to the XLE/XLT

Cscape connects to the local controller automatically when the serial connection is made. The status bar below
shows an example of a successful connection. This status bar is located in the bottom right hand corner of the
Cscape window.

Local 253 Target:253(R) [no forces]

In general, the Target number should match the Local number. The exception to this is when the controller is being
used as a "pass through" unit where other controllers on a CsCAN network could be accessed through the local con-
troller.

Determine connection status by examining feedback next to Local & Target in the status bar of Cscape.

Connecting to the XLE/XLT
Local: ### If a number shows next to Local then communication is established to the local controller.
Cscape is unable to access the COM port of the PC. This could mean that Cscape is con-
figured for a COM port that is not present or that another program has control of the COM port.
Only one Cscape window can access a port at a time. Subsequent instances of Cscape
opened will indicate No Port.
Cscape has accessed a PC COM port, but is not communicating with the controller. This typ-
ically occurs when the controller is not physically connected.
Unknown communication error. Close Cscape, power cycle the controller and reopen Cscape
with a blank project. Check Local.
If 1 (idle), R (run), or D (do I/O) shows next to Target number, then communication is estab-
lished to the target controller.
Communication is not established to the target controller. Check node ID of controller and set
Target to match. Make sure local connection is established.

Local: No Port

Local: No Com

Local: ??7?

Target: #(,R,D)

Target: #(?)
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Connecting Troubleshooting Checklist

Programming and debugging can use MJ2 if it is set as the default programming port.
Controller must be powered up.

Assure that the correct COM port is selected in Cscape.

Tools > Application Settings > Communications .

ahwn =

from the System Menu on the controller will make MJ1/MJ2 available to Cscape.

o

Check that a Loaded Protocol or ladder is not actively using MJ1/MJ2. Taking the controller out of run mode

Make sure the COM port of the PC is functioning. An RS-232 serial loopback and Microsoft HyperTerminal

can determine positively if the COM port is working. Or connect to an alternate device to determine if the port

is working.

7. Successful communications with USB-to-serial adapters vary. If in doubt, Horner Automation offers a USB to

serial adapter. Part number: HE-XCK.

8. XLE/XLT units with built-in Ethernet or installed HE-XEC module can be programmed and debugged via the
Ethernet port. If the HE-XEC is installed, it can be selected as the programming port. The selection is made
in the controller's System Menu under the Serial Port settings. If there are difficulties connecting, make sure

that the default programming port is set correctly with the connection method being attempted.

Local Controller and Local I/O

The System Menu provides the following status indications that are useful for troubleshooting and system main-
tenance.

¢ Self-test results, diagnostics.

¢ RUN and OK status

¢ Network status and usage

¢ Average logic scan rate

¢ Application memory usage

¢ Loaded firmware versions

¢ Loaded protocols

¢ Removable media access

To view the system menu, press the UP and DOWN arrow keys simultaneously. Refer to the "System Settings" on

page 24 for full details on the System Menu diagnostic capabilities.

Local I/O Troubleshooting Checklist

Verify the controller is in RUN mode.

Check diagnostics to ensure controller passed self-tests.

View Diags in System Menu or in Cscape, click: Controller > Diagnostics
Check data sheets to ensure proper wiring.

Ensure that hardware jumpers and software configuration for /0O match.
Check data sheets for voltage and current limits.

Noakowb=

Take ladder out of the picture. From Cscape set controller to “Do I/O” mode. In this mode inputs can be mon-

itored, and outputs set from a data watch window in Cscape without interference from the ladder program.

Some I/O problems are only a result of a mistake in the ladder program.

WARNING: Setting outputs ON in Do I/O mode can result in injury or cause machinery to engage in an
unsafe manner depending on the application and the environment.
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CsCAN Network

For complete information on setting up a CsCAN network, refer to CAN Networks manual (MANQ799) by visiting our
website.

Network status, node ID, errors, and baud rate in the controller system menu are all in reference to the CsCAN net-
work. These indications can provide performance feedback on the CsCAN network and can also be used to aid in
troubleshooting. Refer to the "System Settings" on page 24 chapter for full details.

CsCAN Network Troubleshooting Checklist
1. Use the proper Belden wire type or equivalent for the network as specified in MAN0799.
2. The XLE/XLT does not provide 24VDC to the network. An external voltage source must be used for other
devices such as SmartStix I/0.
3. Check voltage at both ends of the network to ensure that voltage meets specifications of attached devices.
4. Proper termination is required. Use 121Q (or 120Q) resistors at each end of the network. The resistors
should be placed across the CAN_HI and CAN_LO terminals.
5. Measure the resistance between CAN_HI and CAN_LO. If the network is properly wired and terminated
there should be around 60Q.
Check for duplicate node ID’s.
Keep proper wires together. One twisted pair is for V+ and V- and the other twisted pair is used for CAN_HI
and CAN_LO.
8. Make sure the baud rate is the same for all controllers on the network.
9. Assure shields are connected at one end of each segment -- they are not continuous through the network.
10. Do not exceed the maximum length determined by the baud rate and cable type.
11. Total drop length for each drop should not exceed 6m (20’). A drop may include more than one node. The
drop length adds to the overall network length.
12. Network should be wired in "straight line" fashion, not in a "star" pattern.
13. In applications requiring multiple power supplies, make sure the V- of all supplies is connected and to earth
ground at one place only.
14. In some electrically noisy environments it may be necessary to add repeaters to the network. Repeaters can
be used to add additional nodes and/or distance to the network and protect the signal against noisy envir-
onments.

No

Page 172 0f 178


https://hornerautomation.com/wp-content/uploads/2017/08/MAN0799-01.pdf
https://hornerautomation.com/wp-content/uploads/2017/08/MAN0799-01.pdf

I.I HORNER

AUTOMATION GROUP :
Troubleshooting

Removable Media Troubleshooting

RM Troubleshooting

Description Action
i(;'ri/XLT does not read media The media card should be formatted with the XLE/XLT.
j);tff/i)l(eLT illierdaineatlibioy Make sure the project file is saved as a .pgm file and not a .csp file.

Technical Support Contacts

For manual updates and assistance, contact Technical Support at the following locations:

North America:

Tel: (317)916-4274

Fax: (317) 639-4279

Website: https://hornerautomation.com
Email: techsppt@heapg.com

Europe:

Tel: (+) 353-21-4321-266

Fax: (+353)-21-4321826

Website: https://www.hornerautomation.eu
Email: technical.support@horner-apg.com
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